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1 Welcome to COPA-DATA help

ZENON VIDEO-TUTORIALS

You can find practical examples for project configuration with zenon in our YouTube channel
(https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an
initial insight into working with different zenon modules. All tutorials are available in English.

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com.

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can
contact via email at support@copadata.com.

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com.

2 User Administration

zenon supports user administration for the Editor and for the online operation (Runtime). The user
administration fulfills the guidelines of the FDA (Food and Drug Administration, 21 CFR Part 11). It is also
possible to administer Active Directory users (on page 197) in the Runtime.

BASICS

The COPA-DATA user administration makes a distinction between three user types:

»  User: Can carry out actions according to the authorization levels they have been assigned.
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P  Power user: Can also create and edit users.

»  Administrator: Can also carry out all other administration tasks such as canceling blocks,
resetting passwords, etc.

The concept of the user administration assumes that different users have different operating rights
(authorization levels (on page 18) and function authorizations (on page 28)). These rights are issued
regardless of user type. Users can be administered via zenon and the Windows Active Directory.

Each user can be assigned several different authorizations. A maximum of 128 (0 to 127) authorizations
can be configured. Users can be assigned to the individual authorization levels and the attendant
project-specific password design in relation to this can be created completely freely. Each user can have
any level allocated. Thus e.g. user 1 can have levels 0, 1, 5 and 6 assigned and user 2 can have levels 0, 1,
6, 8 and 10 assigned. Authorizations can only be issued if the administrator has those rights himself.

The user is logged into the Runtime using the login (on page 87) function and a login screen. If the user
is to be logged in automatically based on an event (e.g. position of a key known to the system), the
Login without password (on page 88) function is used. This function is projected with a limit value or a
Rema of the variable in the variable management, respectively. With multi-project administration, users
can automatically (on page 76) be logged into subprojects when they log in.

If during a defined period of time there is no operation, an automatic time-triggered logout can be
engineered. Users can log off from the system at any time using the logout (on page 93) function. The
user SYSTEM is thus logged in.

CREATING USERS AND ISSUING RIGHTS

In zenon, you can create and administer users in two ways:

1. zenon Editor and Runtime:
Users are created in the Editor and given rights. You can log on in the Runtime. Administrators
and power users can also create users and issue rights in the Runtime.

2. AD and AD LDS (on page 118):

Active Directory Lightweight Directory Services (on page 132)  (AD LDS) is a simplified version
of the Active Directory and is suitable for use on normal desktop operating systems; it is not
necessary to use a server operating system. Active Directory (on page 119) (AD) and AD LDS
can be used in zenon for the user administration in zenon Runtime. AD and AD LDS are not
available for the zenon Editor.

User groups that are created in AD or AD LDS receive authorizations in zenon (on page 188), if
user groups with the same name are created in zenon. A separate screen can be used to to
read AD and AD LDS from zenon Runtime and edit them. Users who are created here have
user rights for all zenon projects, regardless of the project from which they were created.
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DISPLAY OF DELETED USERS

AD users who are deleted during ongoing operation can no longer be displayed in lists with their
complete user names. If a user is not found in either the zenon user list or in the AD, the following

applies:
» From now on, Runtime no longer attempts to read the complete user name of the domain

controller. Another read only takes place if the cache is deleted. This happens is a user log on
or Runtime is restarted.

» The user identification is shown in the AML, CEL and report viewer lists for these entries in the
Complete User Name column.

Recommendation: Do not delete any AD user in the Runtime, simply deactivate the user.

3 Engineering in the zenon Editor

Users and user groups, passwords and authorizations are defined in the Editor. User settings can be
amended in Runtime (on page 69).

Not all changes to the user-related parameter settings in the Editor are applied with a simple reload (on
page 117) in the Runtime. Note the Runtime changeable data property when transferring Runtime files.
Here, it is specified whether the configuration of the user administration is transferred to Runtime and
overwrites the configuration in the Runtime. The contents of the user administration are not replaced by
default when transferred to Runtime.

3.1 Project manager context menu

CONTEXT MENU USER ADMINISTRATION

Editor profiles Opens the drop-down list with predefined editor profiles.

Help Opens online-help

CONTEXT MENU USER

New user Opens the dialog for creating a new user and adds the new
user to the list of the detail view.

Export all as XML Exports all entries as an XML file.
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Import XML Imports entries from an XML file.
Editor profile Opens the drop-down list with predefined editor profiles.
Help Opens online help.

CONTEXT MENU USER GROUP

New user group Opens the dialog for creating a new user group and adds the
new user group to the list of the detail view.

Export all as XML Exports all entries as an XML file.

Import XML Imports entries from an XML file.

Editor profiles Opens the drop-down list with predefined editor profiles.
Help Opens online help.

Context menu detail view: see also User administration detail view toolbar and context menu (on page
9)

3.2 Toolbar and context menu detail view

Bz aaxan syl

New user Opens the dialog for creating a new user and adds the
new user to the list of the detail view.

Jump back to starting element Jumps back to the initial position in the zenon Editor.
Note: This context menu entry is only available if a jump
to the current position has been made from another
position with the Linked elements context menu entry.

Copy Copies the selected entries to the clipboard.

Paste Pastes the content from the clipboard. If an entry with the
same name already exists, the content is pasted as "Copy
of...".

Delete Deletes selected entries after a confirmation from list.

Export selected as XML... Exports all selected entries as an XML file.
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Menu item/symbol

Import XML

Edit selected cell

Replace text in selected column
Remove all filters
Properties

Help

CONTEXT MENU USER GROUP

Imports entries from an XML file.

Opens the selected cell for editing. The binocular symbol
in the header shows which cell has been selected in a
highlighted line. Only cells that can be edited can be
selected.

Opens the dialog for searching and replacing texts.
Removes all filter settings.
Opens the Properties window.

Opens online help.

New user group

Copy

Paste

Delete
Export selected as XML...
Import XML

Edit selected cell

Remove all filters
Replace text in selected column
Properties

Help

Opens the dialog for creating a new user group and adds
the new user group to the list of the detail view.

Copies the selected entries to the clipboard.

Pastes the content from the clipboard. If an entry with the
same name already exists, the content is pasted as "Copy

of..".
Deletes selected entries after a confirmation from list.
Exports all selected entries as an XML file.

Imports entries from an XML file.

Opens the selected cell for editing. The binocular symbol in
the header shows which cell has been selected in a
highlighted line. Only cells that can be edited can be
selected.

Removes all filter settings.
Opens the dialog for searching and replacing texts.
Opens the Properties window.

Opens online help.
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3.3 Creating a user
To create a new user:
1. Navigate to node User administration/User.
2. select New user... in the context menu of the project manager, the detail view or in the toolbar .
The dialog for configuration is opened.
3. Inthe individual tabs define the settings for:
» User (on page 12)

Note: A user name can only be issued once. If an attempt is made to create a pre-existing
user once again, an error message is issued.

Password  (on page 15)
Message Control (on page 16)

Authorization levels (on page 18)

v v v WV

User Groups (on page 19)
* Information

Recommendation: As first user define an administrator. Only they can access all
functions and therefore reactivate users who were locked because they have
been blocked by the system.
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3.3.1 Users

Configuration of the user:

Create new user

Users  Change password Message Control  Authorization levels  User Groups
Users
User name Cancel
|| | Help
Complete name
| |
Login code
| |
User type
Users ~
Description
|
Power user can create/edit other power users
Acﬁve
[Locked
Options
Login profile
MNone ~
USER
User name Enter the username. The user logs in to the system with
his username.
Maximum length: 20 characters.
Note: This name must be unique and can only be issued
once. If an attempt is made to create a pre-existing user
again, an error message is issued.
Complete name Enter the full name of the user. With this you can allocate
a username to a real person.
Login code Entry of the login code for login without password.

The following is applicable for the login code:

»  Must be unique within the project.
Note: If the same login code is used for a user
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v v v Vv

in the local project and the global project, the
user from the global project is not transferred
when creating the Runtime files in the Editor.
Note the corresponding error message in the
output window. When the login code is changed
in the Runtime, it must not be the same as the
code of a user from the global project.

Can be empty.
It is thus deactivated for this user.

Maximum length: 7000 characters
Must not consist of spaces only.
Leading or closing spaces are not permitted.

All other characters are permitted.

Default: (empty)

If an invalid login code is entered, a corresponding error
message is shown when the dialog is closed.

For details, see the Login via login code (on page 90)

chapter.

User type Selection of the user type from a drop-down list:

4

User:
Can carry out actions according to the
authorization levels they have been assigned.

» Power user:
Can also create and edit users. Whether this is also
applicable for other power users is configured
using the Power user can create/edit other
power users option.

» Administrator:
Can create and edit all other users.

» Default: User

Description Text field to enter additional information

Power user can create/edit other Settings for the power users' detail rights:

power users >

4

Active: Can also create and edit other power users.

Inactive: Can only create and edit users.
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Default: inactive
Active Active: The user is active and can login in the Runtime.

Note: According to FDA 21 PART 11 regulations, a user
can never be deleted, so it is possible to trace who
carried out which action at any time. Therefore for
projects which adhere to these regulations, a user must
not be deleted but only deactivated.

To prevent the deletion of users, deactivate the User
Administration property in the Deleting users group in
the project properties.

Locked Active: The user is locked in the Runtime and cannot
login.

This option is set automatically if a user enters an
incorrect password more than is permitted.

OPTIONS
opon—————————Jowsrpton
Lock code Four-digit PIN code.
This code is used by the user in the command processing
to block areas or to unlock them.
Only available if zenon Energy Edition has been licensed.
Login profile Selection of the Runtime profile that is used for login

from a drop-down list:

» None
» Default
» Last

CLOSE DIALOG

opion———————Jowatpion

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.
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3.3.2 Change password

Defining or changing the password.

Passwords may have a maximum of 20 characters. The minimum length is defined in the project settings
in property Minimum password length in group User Administration (Default:

Create new user @
User | Change password | Message Control | Authorization levels | User groups

Cancel
New password ]
| Help

Confirm password

Old password Current password.
New password Enter new password. Input is automatically hidden.

For projects with multiple languages, note that it must be possible
to enter the characters with the respective keyboard in the
Runtime.

Confirm password Repeat the password. Input is automatically hidden.

Note: The function Copy and Paste is not available for entering information in the password field.

CLOSE DIALOG

o N = TR

oK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.
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3.3.3 Message Control

Options for using the users in module Message Control.

Create new user @

User | Change password | Message Control | Authorization levels | User groups

Cancel
Help

Telephone

Cell phone

E-mail

Substitute person

PIN code

NA code

Message Control User Active: The user is used by the module Message Control.

Telephone Number of the voice-compatible telephone device of the user.
Used for text to speech.

Enter numbers. In addition, the following are permitted:

» The prefix + as an abbreviation for 00 of the international
area code is permitted.

» The following separators are also permitted in AD user
administration: Minus (-), slash (/) and space
Note: When communicating between AD and Message
Control, separators are ignored as soon as the data from
the AD is mapped to a zenon object.

Cell phone Cellphone number of the user. Used for messages via GSM and
SMS (text messages).

Enter numbers. In addition, the following are permitted:

» The prefix + as an abbreviation for 00 of the international
area code is permitted.

» The following separators are also permitted in AD user
administration: Minus (-), slash (/) and space
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Parameter

Email

Substitute person

PIN code

NA code

CLOSE DIALOG

Note: When communicating between AD and Message
Control, separators are ignored as soon as the data from
the AD is mapped to a zenon object.

E-mail address of the user

If a user has not been reached or they do not accept the
message, a substitute person can be given. Click the ... button and
the dialog (on page 25) opens to select an user. Only users who
have been activated as Message Control users are offered for
selection.

PIN code with which the user confirms the receipt of the message.
The code consists of a four-digit number between 0000 and 9999.

PIN code with which the user rejects the receipt of the message
(not available). The message is then sent to the next user in the
list.

If there is no other user entered in the list, the message is entered
as "not successfully acknowledged". The function assigned to this is
executed. In addition, a "rejected by" CEL entry is created in each
case.

The code consists of a four-digit number between 0000 and 9999.

Note: You can find further information on the assignment of
functions in the Confirmation of receipt - confirmation of receipt
settings chapter.

I

OK
Cancel

Help

Applies all changes in all tabs and closes the dialog.
Discards all changes in all tabs and closes the dialog.

Opens online help.

17| 224



A Attention

The acknowledgment codes for PIN (confirmation) and NA (rejection) must differ

and should not be too similar.

If both codes are identical the code is interpreted as PIN and therefore as

confirmation of the message.

If an unknown code is received, a SMS and e--mail is sent to the substitute
person. The error message is played back for voice messages.

3.3.4 Authorization levels

Assignment of authorization levels to a user. 128 authorization levels (from 0 127) are available.

You assign authorization levels using the dialog to create a user or by using the Authorization levels

property.

DIALOG AUTHORIZATION LEVEL

Create new user

| User I Change password | Message Control | Authorization levels | User groups

Available authorization levels

Mumber

1
2
3
4
5
3
7
8

9

10
11
12
13
14
15
16

4

MName

1
2
3
4
5
3
7
8

9

10
11
12
13
14
15
16

M

m

Selected authorization levels
Mumber MName Cancel
a a -
Help

e ™

Parameter

Available authorization levels
Selected authorization levels

Button double arrow to the right

List of all available authorizations.
List of assigned authorizations.

Entries selected in the list Available authorization levels
are added to list Selected authorization levels.
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Button double arrow to the left Selected entries in list Selected authorization levels are
removed from the list.

Note: Each desired level must be assigned and dedicated to that. A selected level closes neither the
one above nor following levels.

CLOSE DIALOG

N

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.

3.3.5 User groups

Assignment of the user to user groups.

Create new user @
User | Change password | Message Control | Authorization levels | User groups
Available user groups Selected user groups
MName MName W
user group -
Help

Available user groups List of all available user groups.
Selected user groups List of assigned user groups.
Button double arrow to the right Entries selected in the list Available user groups are

added to list Selected user groups.
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Button double arrow to the left Selected entries in list Selected user groups are removed
from the list.

CLOSE DIALOG

N

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.

3.4 Create a user group

To create a user group:

1. Highlight the User Groups entry in the tree view of the Project Manager under the User
Administration entry.

2. Right-click on the detailed view area (Project Manager Detail View) or directly on the User
Groups entry

3. Select the New user group command in the context menu or alternatively click on the
corresponding symbol in the toolbar

The Create new user group dialog is opened.

4. Under Name (on page 21), define the naming of the user groups and the desired authorizations
under authorization levels (on page 22).
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¥ |nformation

Each user group must have an unambiguous name in a project.

It is possible to create user groups with the same name in the global project and
in the local project. If this is the case, the authorizations of the user group from
the local project are used in the event of a conflict. If the local user group is
deleted, the user again receives the rights from the group of the global project
after the Runtime files are compiled in the Editor.

Example:

A user group A is present in both the local project and in the global project. In
the global project it is allocated the authorization levels 7, 2, 3, 700 and 707, and
authorization levels 7 and 2 in the local project. In the Runtime, the rules from
the local project apply; only the authorization levels 7 and 2 are assigned. If user
group A is not present in the local project, members of group A have
authorization levels 7, 2, 3, 700 and 707 from the global project.

3.4.1 Name the user group

User group | Autharization levels

Cancel
Mame ]
| Help

Name Name of the new user group

Attention: @ is not a valid character for a user group.
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CLOSE DIALOG

o =

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.

3.4.2 Authorization levels

Assignment of the authorization levels to a user group. 128 authorization levels (from 0 127) are
available.

You assign authorization levels using the dialog to create an user group or by using the Authorization
levels property.

DIALOG AUTHORIZATION LEVEL

(i g Asrzstioniess |
Available authorization levels Selected autharization levels
Mumber Mame i Mumber Mame Cancel
1 1 E u] u] -
2 2 i Help
A <
5 5
[} [}
7 7
g g
9 9
1n 1n
11 11
12 12
13 13
14 14
15 15
16 16 il
(’ = 10 [3
Parameter Description
Available authorization levels List of all available authorizations
Selected authorization levels List of assigned authorizations
Button double arrow to the right Entries selected in the list Available authorization levels
are added to list Selected authorization levels.
Button double arrow to the left Selected entries in list Selected authorization levels are

removed from the list.
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Note: Each desired level must be assigned and dedicated to that. A selected level closes neither the
one above nor following levels.

CLOSE DIALOG

o (= R

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.

3.4.3 Order in Message Control

Defines the order of users within a group for the use of module Message Control.

User order for Message Control @
Sorting order
User
Cancel
Help
| up | | down |
Parameter Description
User List of all available users.
Up Moves selected user up one place.
Down Moves selected user down one place.
OK Applies settings and closes the dialog.
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Cancel Discards all changes and closes the dialog.

Help Opens online help.

3.5 Editing an user

A user is changed by selecting the user from the list in the detail view. As a result of this, the
corresponding properties are displayed in the properties window and can be changed here.

3.6 Changing a user group

A user group is changed by selecting the user group from the list in the detail view. The respective
parameters are displayed in the properties window as a result of this. You can change the Name and

Authorization levels parameters.
* |Information

If you rename a user group, all users that are linked to this user group lose this
link. The user group is displayed with (del).

If there is already a user group with the same name in the global project
however, all users previously linked to the group that has now been renamed
assume all authorization levels of this user group.
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3.7 Changing the names of the authorization levels

You can change the names of the authorization groups globally for your project. To do this, go to the
User Administration group in project properties and click on the Rename authorization levels
property there.

Rename authorization leveal -
Autharization levels

Mumber Mame = Rename

Ok

Cancel

|.m

Help

Open the editing field with a double click in the desired line of the Name column. Make the changes.
The input is closed as soon as the focus is no longer in the field or it has been confirmed with Enter. The
name is not changed if you press the Esc key or leave the edit field empty.

3.8 User selection: individual user
In the user selection dialog, you select a user in the Runtime for use in another module.
To select a user:
1. Highlight the desired driver in the list of existing users.
2. Confirm the settings with OK.
The user is added.
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USER SELECTION DIALOG

a':) User selection @

= dE Workspace: 70016) Usera... | Useridentification Complete name Password | Authorization levels User gr
oy GLOBALPROJEKT

MESSAGE I
i} John Doe

4 m 3
3 total /1 filtered / 0 selected

Mo selection [ OK ] | Cancel | | Help |
opon———————— Joepton
List workspace Display and selection of the projects from which users can
be selected.

List user Display of the users of the selected projects. The list can
be filtered.

No selection An already existing user is deselected.

CLOSE DIALOG

I

OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.
Help Opens online help.

3.9 User selection: several users

In the user selection dialog, you select several users in Runtime for use in another module.

To select users:
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1. Highlight the desired users in the list of existing users.
2. Add the selection to the list of selected users with Add.
3. Confirm the settings with OK.

The users are added to the dialog that is called up.

USER SELECTION DIALOG

"4 User selection

= 'i Workspace Usera... | User name Complete name Login c..| Authorization levels #
i EQUIPMENTMODEL_FIL 7 7 7 7 &

John John Doe 0

Jane John Doe 0
Manager Manager 0,1,23,4567, .

Global Global User 1234 0

< >
< » | 4 total/4 filtered/0 selected
User name Complete user name
v
Add Remove Mo selection Cancel
Project list Contains the projects available for selection.

Note: Only the active project is available for shift

management.

List of existing users Displays all users available.

Arrow keys Allows navigation in the list with touch operation.

List of selected users Shows all users selected for use in the module.

Arrow keys Allows navigation in the list with touch operation.

Add Adds the users highlighted in the list of existing users to
the list of selected users.

Remove Removes all highlighted users from the list of selected
users.

No selection Removes the users who are already present in the list of
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selected users from the dialog.

CLOSE DIALOG

N

OK Applies settings and closes the dialog.

Cancel Discards all changes and closes the dialog.

3.10 Function authorizations

Function authorizations can be assigned in zenon. These function authorizations relate to functions in
the Runtime and the configuration of modules in the Editor. If a user does not have the function
authorization, then

» Inthe Runtime: the corresponding functions cannot be executed

» in the Editor: Toolbars and context menus of the corresponding module are grayed out

CONFIGURATION OF THE FUNCTION AUTHORIZATIONS

Function authorizations are configured in the zenon Editor (on page 29).

ASSIGNING THE FUNCTION AUTHORIZATIONS

This assignment is effected by means of:
» Function authorizations Runtime (on page 30)

» Function authorizations Editor (on page 38)

For global projects, the assignment is the same as for the Editor. In the process, the possibilities for
selection are determined by the node points present in a global project.

As soon as one or more authorization levels greater than 0 are used, a login dialog appears when the
project is loaded in the Editor. This dialog also appears if only one user was created in the project. This
means that projects can be protected in the Editor. When entering the user name and password, a
distinction is made between capital letter and small letters (case sensitivity).

IN GENERAL, THE FOLLOWING APPLIES:
»  All project configurations for DragOver and drag&drop take module rights into account.

»  For module rights that are not granted:
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» The respective menu and toolbars are grayed out in the zenon Editor.

» No change to the project configuration is possible in the nodes and sub-nodes of the detail
view.

» The corresponding key combinations are not active.

» The properties are grayed out in the properties window. As a result of this, further or "more
in-depth" project configurations cannot be reached (for example combined elements,
reaction matrix statuses, archive configuration etc.).

» If there are no module rights for the function authorization screen, editing of screens with
the mouse is also no longer possible.

A Attention

Therefore please note, even at the engineering stage, that at least one user is
assigned to the following three authorization levels:

» Load project
» Project

P User Administration

¥ |nformation

If, for the global project, an authorization level (on page 38) greater than O is
configured for the editing of screens and the logged-in user does not have this
authorization level, the adding of symbols into the symbol library of the global
project is not possible. Linked symbols from the global project also cannot be
edited in screens of the local project in this case.

3.10.1 Configuration of function authorizations

To issue a function authorization:
1. Select the User Administration property group in the project properties.
2. In the Function authorizations properties field, click on the ... button
The dialog for configuration is opened
3. Issue the function authorization for:

» The respective function in the Runtime
and/or
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»  For the respective model in the Editor

4. Allocate the desired function authorization to an authorization level (on page 22).

To do this, it is necessary to have the respective licensing rights for the corresponding module. This is
not taken in to account when engineering the individual authorization levels.

Note on function authorizations for the Editor:

» Changes to the function authorizations are only effective once the Editor has been restarted or
the project has been reloaded.

» Ensure that at least one user has the required authorizations in order to edit user authorization
settings.

3.10.2 Function authorizations Runtime

If function authorizations have been issued for Runtime, users must log in and have the corresponding
authorization level in order for them to be able to execute this function.

CONFIGURATION OF FUNCTION AUTHORIZATIONS IN RUNTIME

.
Change function authorization

Function authorizations Runtime | Function authorizations Editor

o]

Function Authorization level Change...
Ackn. alarm via alarm status linefcontext menu Cancel
Acknowledge alarm via function

Acknowledge alarm via screen Alarm Message List

Batch Control: Control recipe - create, rename, duplicate

Batch Control: Control redpe - delete

Batch Control: Control redpe - edit phase

Batch Control: Control redipe (execution) - abbort recipe

Batch Control: Control redpe (execution) - execute, jump single steps
Batch Control: Control redpe (execution) - exit phase

Batch Control: Control redpe (execution) - hold phase

Batch Control: Control redpe (execution) - hold recpe

Batch Control: Control recipe (execution) - pause phase

Batch Control: Control recipe (execution) - pause recpe

Batch Control: Control redipe (execution) - restart phase

Batch Control: Control redipe (execution) - restart recipe

Batch Control: Control redipe (execution) - resume phase

Batch Control: Control redpe (execution) - resume recpe

Batch Control: Control redpe (execution) - skip active condition

Batch Control: Control redpe (execution) - start recipe

Batch Control: Control redpe (execution) - stop recipe

Batch Control: Control redpe (execution) - switch REE mode

Batch Control: Master recipe - create, edit, rename, duplicate, save
Batch Control: Master recipe - delete

Batch Control: Master recipe - release

Batch Control: Master recipe - Switch between test mode and edit mode
Batch Control: Master recipe (test mode) - abbort recipe

E g

Help

m

== = R R R = = T R O = = = T O = = R = = =]

%

For all actions, the user must be logged in and have the corresponding authorization levels.
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FUNCTION AUTHORIZATIONS, GENERAL

Edit Extended Trend

Return to last screen (PgUp)

Screen switch: Enable "Show this
dialog in Runtime"

Notepad: Open file

Notepad: Save file

Curves in Extended Trend can be edited in the
Runtime. The following control elements are not
available if the user does not have authorization:

» Diagram
» Curves
» Settings

» Cursor on/off
»  X-axis
Screen 'back' functions can be executed in Runtime.

The Screen switch function, with the Show this
dialog in Runtime option active, can only be executed
if the user who is logged in meets authorization
requirements.

The function Open file in screen Notepad can only be
carried out if the logged in user has the appropriate
authorization level.

The function save in screenNotepad can only be
carried out if the logged in user has the appropriate
authorization level.

FUNCTION AUTHORIZATIONS FOR ALARMS

Change alarm comment

Enter alarm comment

Confirm alarm acknowledgement

Acknowledge alarm via alarm status
line / context menu

A comment necessary for acknowledgment can be
changed.

A comment necessary for acknowledgment can be
entered.

Alarms can be acknowledged in the Runtime.

Acknowledging an alarm via the alarm status line or
the context menu is only possible if there is an
authorization in the project of the alarm that is
currently displayed.

For multi-project administration: Acknowledging
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the system message in the alarm status line or via the
context menu is only possible if there is authorization in
the integration project.

Comment: System messages are messages that
appear in the alarm status line when a certain
(configurable) number of alarms has been reached.

Acknowledge alarm via screen Acknowledging via Alarm Message List screens is only
Alarm Message List possible with authorization in the project linked to the
variable (multi-project administration).
Note:lf there is no authorization, the flashing is
stopped but the alarm is not acknowledged.

Acknowledge alarm via function Acknowledging via a function is only possible if there is
an authorization for the selected alarms in the
respective projects.

Edit archive Archive data (Archive server) can be amended in the
Runtime.

You can set different authorization groups for each of these acknowledging methods. This allows you,
for example, to configure that a certain user group can only acknowledge via the alarm status line, not
in any other way.

¥ Info

Acknowledging an alarm is only possible if there is an authorization for the
selected alarms in the according projects.

FUNCTION AUTHORIZATION BATCH CONTROL

Batch Control: Import Recipes can only be imported as an XML file in the
recipe/operation Batch Control module if the user has the
corresponding rights.

Batch Control: Control recipe - Control recipes in the Batch Control module can only
create, rename, duplicate be created and administered if the user has the
corresponding rights.

Batch Control: Control recipe - edit ~ Settings in control recipes in the Batch Control module
control recipe can only be edited if the user has the corresponding
rights.
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Parameter

Batch Control: Control recipe -
Delete

Batch Control: Control recipe
(execution) - skip active condition

Batch Control: Control recipe
(execution) - exit phase

Batch Control: Control recipe
(execution) - switch execution mode

Batch Control: Control recipe
(execution) - execute, jump single
steps

Batch Control: Control recipe
(execution) - hold phase

Batch Control: Control recipe
(execution) - resume phase

Batch Control: Control recipe
(execution) - restart phase

Batch Control: Control recipe
(execution) - pause phase

Batch Control: Control recipe
(execution) - abort recipe

Batch Control: Control recipe
(execution) - hold recipe

Batch Control: Control recipe
(execution) - resume recipe

Control recipes in the Batch Control module can only
be deleted if the user has the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be exited if the user has the
corresponding rights.

When executing control recipes in the Batch Control
module, pending conditions can only be skipped if the
user has the corresponding rights.

When executing control recipes in the Batch Control
module, the execution mode can only be switched if
the user has the corresponding rights.

When executing control recipes in the Batch Control
module, the execution of individual steps can only be
skipped if the user has the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be stopped if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be continued if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be restarted if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be paused if the user has the
corresponding rights.

When executing control recipes in the Batch Control
module, execution of the recipe can only be aborted if
the user has the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be stopped if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be continued if the user has
the corresponding rights.
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Parameter

Batch Control: Control recipe
(execution) - restart recipe

Batch Control: Control recipe
(execution) - pause recipe

Batch Control: Control recipe
(execution) - start recipe

Batch Control: Control recipe
(execution) - stop recipe

Batch Control: Operation: create,
edit, rename, duplicate, save

Batch Control: Operation: release

Batch Control: Operation: delete

Batch Control: Master recipe -
highlight as outdated

Batch Control: Master recipe -
create, edit, rename, duplicate, save

Batch Control: Master recipe -
release

Batch Control: Master recipe -
Delete

Batch Control: Master recipe -
Switch between test mode and edit
mode

Batch Control: Master recipe (test
mode) - skip active condition

When executing control recipes in the Batch Control
module, a recipe can only be restarted if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be paused if the user has the
corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be restarted if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be stopped if the user has
the corresponding rights.

Operations in the Batch Control module can only be
created, edited or administered if the user has the
corresponding rights.

Operations in the Batch Control module can only be
approved if the user has the corresponding rights.

Operations in the Batch Control module can only be
deleted if the user has the corresponding rights.

Master recipes in the Batch Control module can only
be marked as obsolete if the user has the
corresponding rights.

Master recipes in the Batch Control module can only
be created and administered if the user has the
corresponding rights.

Master recipes in the Batch Control module can only
be approved if the user has the corresponding rights.

Master recipes in the Batch Control module can only
be deleted if the user has the corresponding rights.

Switching between test mode and editing mode is only
possible for master recipes in the Batch Control
module if the user has the corresponding rights

In test mode, with master recipes in the Batch Control
module, it is only possible to skip a pending condition
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Parameter

Batch Control: Master recipe (test
mode) - escape phase

Batch Control: Master recipe (test
mode) - switch execution mode

Batch Control: Master recipe (test
mode) - execute, jump single step

Batch Control: Master recipe (test
mode) - hold phase

Batch Control: Master recipe (test
mode) - edit phase

Batch Control: Master recipe (test
mode) - resume phase

Batch Control: Master recipe (test
mode) - restart phase

Batch Control: Master recipe (test
mode) - pause phase

Batch Control: Master recipe (test
mode) - abort recipe

Batch Control: Master recipe (test
mode) - hold recipe

Batch Control: Master recipe (test
mode) - continue recipe

if the user has the corresponding rights.

In test mode, with master recipes in the Batch Control
module, it is only possible to exit a phase if the user
has the corresponding rights.

In test mode, with master recipes in the Batch Control
module, the execution mode can only be switched if
the user has the corresponding rights.

In test mode, with master recipes in the Batch Control
module, it is only possible to skip the execution of
individual steps if the user has the corresponding
rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be stopped if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be edited if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be continued if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be started if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be paused if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be aborted if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be held if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be continued if the user has
the corresponding rights.
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Parameter

Batch Control: Master recipe (test
mode) - restart recipe

Batch Control: Master recipe (test
mode) - pause recipe

Batch Control: Master recipe (test
mode) - start recipe

Batch Control: Master recipe (test
mode) - stop recipe

In test mode, with master recipes in the Batch Control
module, a recipe can only be continued if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be paused if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be started if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be stopped if the user has
the corresponding rights.

COMMAND SEQUENCER FUNCTION AUTHORIZATIONS:

Command Sequencer: Cancel
execution

Command Sequencer: Continue
execution

Command Sequencer: Pause
execution

Command Sequencer: Start
execution

Command Sequencer: Switch
execution mode

Command Sequencer: Execute,
Jump single steps

When executing command sequences in the
Command Sequencer module, execution of the recipe
can only be aborted if the user has the corresponding
rights.

In the Command Sequencer module, a paused
command sequence can only be continued if the user
has the corresponding rights.

In the Command Sequencer module, a corresponding
command sequence can only be paused if the user has
the corresponding rights.

Starting a command sequence in the Command
Sequencer module is only possible if the user has the
corresponding rights.

When executing command sequences in the
Command Sequencer module, individual steps can
only be executed or the execution of individual steps
can only be skipped if the user has the corresponding
rights.

When executing command sequences in the
Command Sequencer module, individual steps can
only be executed or the execution of individual steps
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can only be skipped if the user has the corresponding
rights.

Command Sequencer: Create, edit, ~ The administration of command sequences in the

rename, duplicate, save Command Sequencer module - for example creation,
changing, editing, duplicating and saving - can only be
configured if the user has the corresponding rights.

Command Sequencer: Delete In the Command Sequencer module, configured
command sequences can only be deleted if the user
has the corresponding rights.

Command Sequencer: Import Command sequences can only be imported as an XML
command sequences file in the Command Sequencer module if the user has
the corresponding rights.

Command Sequencer: Switching Switching modes (edit mode and execution mode) is
between execution and edit mode only possible in the Command Sequencer module if
the user has the corresponding rights.

FUNCTION AUTHORIZATIONS FOR SHIFT MANAGEMENT:

Shift Management: create, edit or When configuring shifts in the Shift Management

delete shift module in the Runtime, a shift can only be created,
edited or deleted if the user has the corresponding
permissions.

Shift Management: create, edit or When configuring shift models in the Shift

delete shift model Management module in the Runtime, a shift can only
be created, edited or deleted if the user has the
corresponding permissions.

EDIT AUTHORIZATION LEVELS

Change Opens the dialog (on page 22) to select the authorization
levels. (The user group tab is hidden in the process)

The selected authorization level is set for all selected
functions.
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CLOSE DIALOG

o =

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.

3.10.3 Function authorizations Editor

If a function authorization has been issued for at least one module, users must log in when opening the
Editor. To do this, a dialog is called up when the editor is started. This shows the current project name in
the header and allows login.

These function authorizations can only be amended again in this project. It is not possible to edit
function authorizations with users from the global project or other projects.

A Attention

Ensure that at least one user has the required authorizations in order to edit
settings for the user authorization in the Editor. If no user, or only users with
missing authorization levels, have been configured, this can lead to the project
no longer being editable.
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CONFIGURATION OF FUNCTION AUTHORIZATIONS IN THE EDITOR.

r ~
Change function authorization &J
Function authorizations Runtime | Function authorizations Editor
Module Authorization level Change...
Energy Management System
Fies

Functions

Historian

Interlockings

Language file

Load project

Menus

Message Control

Production & Fadlity Scheduler
Programming interfaces
Project

Recipes

Report Generator

SAP interface

Screens

Switch on/foff history of changes
Time control

User administration

Variables

zenon Logic

(= R I = R = T R O I = = O A = = = -

e

Switch on/off history of changes The history of changes can only be switched on or off in
the Editor,If the logged-in user is assigned to the
corresponding user level.

Equipment Modeling Only then is the Equipment modeling module available in
the Editor for editing and engineering, If the logged-in
user is assigned to the corresponding user level.

Historian Only then is the Historian module available in the Editor
for editing and engineering,If the logged-in user is
assigned to the corresponding user level.

Batch Control Only then is the Batch Control module available in the
Editor for editing and engineering,If the logged-in user is
assigned to the corresponding user level.

User Administration Only then can users (on page 12) and user groups (on
page 19) be edited or engineered in the Editor,If the
logged-in user is assigned to the corresponding user
level.

Comment: In order to not be blocked out of a project,
at least one user must be assigned to this function
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authorization.

Screens Only then is the Screens node available in the Editor for
editing and engineering, If the logged-in user is assigned
to the corresponding user level.

Files Only then is the Files node available in the Editor for
editing and engineering,If the logged-in user is assigned
to the corresponding user level.

Functions Only then can functions and scripts be edited or
engineered in the Editor,If the logged-in user is assigned
to the corresponding user level.

Load Management Only then is the Load management module available in
the Editor for editing and project configuration,If the
logged-in user is assigned to the corresponding user
level.

Menus Only then can menus be edited or engineered in the
Editor,If the logged-in user is assigned to the
corresponding user level.

Message Control Only then is the Message Control module available in the
Editor for editing and project configuration,If the
logged-in user is assigned to the corresponding user
level.

Production & Facility Scheduler Only then is the Production& Facility Scheduler module
available in the Editor for editing and engineering,If the
logged-in user is assigned to the corresponding user
level.

Programming Interfaces Only then is the Programming interfaces node available in
the Editor for editing and engineering,If the logged-in
user is assigned to the corresponding user level.

Project The project properties can only be amended in the
Editor,If the logged-in user is assigned to the
corresponding user level.

Comment: In order to not be blocked out of a project,
at least one user must be assigned to this function
authorization.

Load project The project can only be loaded in the Editor,If the
logged-in user is assigned to the corresponding user
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level.

Comment: In order to not be blocked out of a project,
at least one user must be assigned to this function
authorization.

Report Generator Only then is the Report Generator available in the Editor
for editing and engineering,If the logged-in user is
assigned to the corresponding user level.

Recipes Only then can Standard recipes and the Recipegroup
Manager be edited or engineered in the Editor,If the
logged-in user is assigned to the corresponding user
level.

SAP Interface Only then is the SAP interface module available in the
Editor for editing and engineering, If the logged-in user is
assigned to the corresponding user level.

Language File Only then can Language switching be edited or
engineered in the Editor,If the logged-in user is assigned
to the corresponding user level.

Styles Only then is the Styles module available in the Editor for
editing and engineering,If the logged-in user is assigned
to the corresponding user level.

Note: Styles are only avialable in the Global Project.

Variables Only then is the Variables node available in the Editor for
editing and engineering,If the logged-in user is assigned
to the corresponding user level.

Interlockings Only then can Interlockings be edited or engineered in
the Editor,If the logged-in user is assigned to the
corresponding user level.

Time Control Only then can Time Control be edited or engineered in
the Editor,If the logged-in user is assigned to the
corresponding user level.

zenon Logic Only then can zenon Logic projects be edited or
engineered in the Editor,If the logged-in user is assigned
to the corresponding user level.
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EDIT AUTHORIZATION LEVELS

Change Opens the dialog (on page 22) to select the authorization
levels. (The user group tab is hidden in the process)

The selected authorization level is set for all selected
functions.

CLOSE DIALOG

N

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
Help Opens online help.

* Info

You can select several entries at the same time with the keyboard shortcut
Ctrl+mouse click or Shift+mouse click.

» You can select a number of entries by pressing and holding the Ctrl key.

» By pressing and holding Shift and select two entriey, you select all entries
which lie between the two selected entries.

» By pressing and holding both Ctrl and Shift and selecting two entries, all
entries which lie between the selected entries are selected. The entries
which were selected beforehand remain selected.

3.11 Screen types, dialogs and functions for login and user
administration

LOGIN

It is possible to log in to the Runtime by means of:

» Alogin (on page 43) screen: Permanent login, temporary login or entry of a signature via
screen switching.

» Temporary login (on page 74) modal dialog: Is used for a temporary login if no login screen is
linked.
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» Login with dialog (on page 87) function: Login via a modal dialog or the login screen if this has
been linked.

» Login without password (on page 88) function: Logging in a user without entering a password
by means of direct linking or by chip identification system.

If a login screen is to be used for temporary login or the Login with dialog function is to be used, it
must be linked in the Screen for Login project property.

USER ADMINISTRATION

The following types of user are available:

»  User list (on page 46) screen: Lists all zenon users who have been created and makes it possible
to create, edit or delete these via the Edit user screen and to configure authorization levels.

»  User group list (on page 54) screen Lists all zenon user groups that have been created and
makes it possible to create new ones and configure authorization levels.

»  Edit user (on page 58) screen: Makes it possible to edit users and passwords in the Runtime.
» Change user (on page 93) function: Opens a dialog to edit users and user groups.

» Change password (on page 116) function: Opens a dialog to edit your own password.
3.11.1 Creating a screen of the type Login

CREATING A SCREEN OF THE TYPE LOGIN

ENGINEERING

Two procedures are available to create a screen:
» The use of the screen creation dialog

» The creation of a screen using the properties

Steps to create the screen using the properties if the screen creation dialog has been deactivated in the
menu bar under Tools, Settings and Use assistant:

1. Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

2. Change the properties of the screen:
a) Name the screen in the Name property.

b) Select Login in the Screen type property.
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C) Select the desired frame in the Frame property.

3. Configure the content of the screen:

a) Select the Elements (screen type) menu item from the menu bar.

b) Select Insert template in the drop-down list.
The dialog to select pre-defined layouts is opened. Certain control elements are inserted
into the screen at predefined positions.

C) Remove elements that are not required from the screen.

d) If necessary, select additional elements in the Elements drop-down list. Place these at the

desired position in the screen.

4. Create a screen switch function.

SCREEN OF TYPE LOGIN

Login

User name Password

Signature

[7“\
Cancel
Control element Description

Insert template

Opens the dialog for selecting a template for the
screen type.

Templates are shipped together with zenon and can
also be created by the user.

Templates add pre-defined control elements to
pre-defined position in the screen. Elements that are
not necessary can also be removed individually once
they have been created. Additional elements are
selected from the drop-down list and placed in the
zenon screen. Elements can be moved on the screen
and arranged individually.
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Control element

Current user (Display)

User name

Password

Signature

OK

Cancel

Apply

COMPATIBLE ELEMENTS

Display of the currently logged in user

Note: Element of the type Dynamic text.
Functionality is assigned using the Screen type
specific action property.

Input area for username.

Note: Element of the type Dynamic text. Functionality
is assigned using the Screen type specific action

property.
Input field for password.

Note: Element of the type Dynamic text. Functionality
is assigned using the Screen type specific action

property.
Input field for signature.

Note: Element of the type Dynamic text. Functionality
is assigned using the Screen type specific action

property.

Button to close the screen after login.

Cancels the login process.

Applies all changes and leaves the dialog open.

Exception: The window is closed if the maximum
number of invalid login attempts has been set to 0
using the Max. user error property.

Compatible elements

Users

Current user (display)

Control elements that are replaced or removed by
newer versions and continue to be available for
compatibility reasons. These elements are not
taken into account with automatic insertion of
templates.

Properties for users.

Static Win32 control element. Was replaced by a
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dynamic text field. For the description, see current
element.

User name Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Password Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Signature Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Note: For dynamic text or switch control elements , the respective functionality is assigned using the
Screen type specific action property.

¥ |nformation

When logging in/out, the corresponding entries are created in the CEL all
projects concerned.

3.11.1.1Screen switch to login

With screen switching, you define which screen is opened in the Runtime for the login of users.

To create a screen switch to a login screen:
1. Create a function.
Select screen switching.

select the login screen.

oW

Link the function to a button.

3.11.2 Creating a user list screen

The user list screen lists all zenon users of the project who have been created and makes it possible to
call up the Edit user screen and thus create, edit or delete users and configure authorization levels. Users
from the global project are not displayed and cannot be administered.

If you want to edit the list directly using the monitor, activate the Multi-Touch functionality.
You can find detailed information in relation to this in the Configure interactions chapter.
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ENGINEERING

Two procedures are available to create a screen:

»
»

The use of the screen creation dialog

The creation of a screen using the properties

Steps to create the screen using the properties if the screen creation dialog has been deactivated in the
menu bar under Tools, Settings and Use assistant:

1.

Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

Change the properties of the screen:

a) Name the screen in the Name property.

b) Select User List in the Screen type property.

c) Select the desired frame in the Frame property.

Configure the content of the screen:

a) Select the Elements (screen type) menu item from the menu bar.

b) Select Insert template in the drop-down list.
The dialog to select pre-defined layouts is opened. Certain control elements are inserted
into the screen at predefined positions.

C) Remove elements that are not required from the screen.

d) If necessary, select additional elements in the Elements drop-down list. Place these at the
desired position in the screen.

4. Create a screen switch function.

Note: This screen type is not available under Windows CE.

DISPLAY OF LONGER TEXTS IN LISTS

Longer texts can also be displayed in the Runtime over several lines using the Automatic word wrap
property.

In the Editor, go to Representation in the properties of the respective list properties and activate the
checkbox of the Automatic word wrap property.
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The line height must be amended manually.

User

User List L |
Typ: STATIC —
ID: 53504 B

Edit...

Function
authorization

- |}

Insert template Opens the dialog for selecting a template for the screen
type.

Templates are shipped together with zenon and can also be
created by the user.

Templates add pre-defined control elements to pre-defined
position in the screen. Elements that are not necessary can
also be removed individually once they have been created.
Additional elements are selected from the drop-down list
and placed in the zenon screen. Elements can be moved on
the screen and arranged individually.

User List Displays the configured users.

New Opens the screen defined in screen switching to create a
new user.

Edit Opens the screen defined in screen switching to edit a new
user.

Delete Deletes the selected user after requesting confirmation.

Function authorizations Opens the dialog for issuing function authorizations.
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3.11.2.1 Screen switching to the user list

With screen switching, you define which screen is opened in the Runtime for the creation or editing of
users.

To create a screen switch to a user list screen:
1. Create a function.

Select screen switching.

Select user list screen.

The dialog for configuration is opened

Configure the screen switching.

Confirm the configuration by clicking on OK.

N W N

Link the function to a button.

USER LIST DIALOG
Filter...

User List

QK
Column settings

Benutzer aktiv | Benutzemame Vollstandiger Name Berechtigungsebenen | Benutzergruppen Cancel

Help
£ >

Column selection... Column format...

Linked screens

Screen for button Mew user...”

User edit

Screen for button "Edit user...”

User edit

Column settings Display and configuration of the columns.

Changing the order is carried out by moving the mouse
or with the column selection button.

The column width is set by moving the mouse or with the
column format button.

Column selection Opens the dialog for configuration (on page 50) of the
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Parameter

Column format

Linked screens

Screen for "New user" button

Screen for "Edit user" button

CLOSE DIALOG

columns.
Opens the dialog to format (on page 52) the columns..

Configuration of the screens that are opened in the
Runtime by clicking on the New and Edit buttons.

Opens the dialog to select a screen in order to select a
screen to create a new user in the Runtime. Only Edit
user screens can be selected.

Opens the dialog to select a screen in order to select a
screen to edit a user in the Runtime. Only Edit user
screens can be selected.

o i T

Applies settings and closes the dialog.

oK
Cancel

Help

Discards all changes and closes the dialog.

Opens online help.

3.11.2.1.1 Column selection

Configuration of the columns to be displayed:

Column selection

Available columns

Equipment groups

Column settings

Add all -

<-Remove all

Selected columns

User active

User identification
Complete name
Authorization levels
User groups
Administrator
Locked

Runtime profile
Message Control user
Substitute person
GSM

Telephone

E-mail

Cancel

Help
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o i

Available columns List of columns that can be displayed in the table.
Selected columns Columns that are displayed in the table.
Add -> Moves the selected column from the available ones to the

selected items. After you confirm the dialog with OK, they
are shown in the detail view.

Add all -> Moves all available columns to the selected columns.

<- Remove Removes the marked columns from the selected items
and shows them in the list of available columns. After you
confirm the dialog with OK, they are removed from the

detail view.

<- Remove all All columns are removed from the list of the selected
columns.

Up Moves the selected entry upward. This function is only
available for unique entries, multiple selection is not
possible.

Down Moves the selected entry downward. This function is only
available for unique entries, multiple selection is not
possible.

CLOSE DIALOG

optors———————Jowatpion

OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.
Help Opens online help.
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3.11.2.1.2 Column Format

Configuration of the properties of the columns for configurable lists. The settings have an effect on the
respective list in the Editor or - when configuring screen switching - in Runtime.

Column properties

Format columns
]

Cancel

Available columns

Settings
Text

Width

100 Character

Alignment User-defined colors

@ Left [use user-defined colors

O centered Text color _l
L Background color _l

AVAILABLE COLUMNS

I

Available columns List of the available columns via Column selection. The
highlighted column is configured via the options in the
Settings area.

SETTINGS
N T
Settings Settings for selected column.
Labeling Name for column title.
The column title is online language switchable. To do this,
the @ character must be entered in front of the name.
Width Width of the column in characters.
Calculation: Number time average character width of the
selected font.
Alignment Alignment. Selection by means of radio buttons.

Possible settings:
» Left: Textis justified on the left edge of the column.

» Centered: Text is displayed centered in the
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N

column.

» Right: Text is justified on the right edge of the
column.

User-defined colors Properties in order to define user-defined colors for text
and background. The settings have an effect on the Editor
and Runtime.

Note:

» These settings are only available for configurable
lists.

» In addition, the respective focus in the list can be
signalized in the Runtime by means of different text
and background colors. These are configured using
the project properties.

User defined colors Active: User-defined colors are used.

Text color Color for text display. Clicking on the color opens the
color palette to select a color.

Background color Color for the display of the cell background. Clicking on
the color opens the color palette to select a color.

Lock column filter in the Runtime » Active: The filter for this column cannot be changed
in the Runtime.

Note: Only available for:
» Batch Control
» Extended Trend
» Filter screens
» Message Control

» Recipegroup Manager

v

Shift Management

» Context List

53 | 224



CLOSE DIALOG

o =

OK
Cancel

Help

Applies all changes in all tabs and closes the dialog.
Discards all changes in all tabs and closes the dialog.

Opens online help.

3.11.3 Creating a user group list screen

CREATING A USER GROUP LIST SCREEN

The User Groups list screen lists all zenon user groups created in the project and makes it possible to
create new groups and assign authorization levels. User groups from the global project are not
displayed and cannot be administered.

ENGINEERING

Two procedures are available to create a screen:

»
4

The use of the screen creation dialog

The creation of a screen using the properties

Steps to create the screen using the properties if the screen creation dialog has been deactivated in the
menu bar under Tools, Settings and Use assistant:

1.

Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

Change the properties of the screen:

a) Name the screen in the Name property.

b) Select User Groups list in the Screen type property.

C) Select the desired frame in the Frame property.

Configure the content of the screen:

a) Select the Elements (screen type) menu item from the menu bar.

b) Select Insert template in the drop-down list.
The dialog to select pre-defined layouts is opened. Certain control elements are inserted
into the screen at predefined positions.

C) Remove elements that are not required from the screen.
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d) If necessary, select additional elements in the Elements drop-down list. Place these at the
desired position in the screen.

4. Create a screen switch function.

User Groups Authorization levels
Group List [ ] Available Selected
Typ: TouchBox List of available levels [~ | List of selected levels [
ID: 53505 B Typ: TouchBox n Typ: TouchBox m
ID: 53512 ID: 53517

==

e

Mew group Delete group - -

Properties

Group name

Insert template Opens the dialog for selecting a template for the
screen type.

Templates are shipped together with zenon and
can also be created by the user.

Templates add pre-defined control elements to
pre-defined position in the screen. Elements that
are not necessary can also be removed individually
once they have been created. Additional elements
are selected from the drop-down list and placed in
the zenon screen. Elements can be moved on the
screen and arranged individually.

GROUP LIST

Control elements for the display of the user groups.
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Previous group Goes to the previous group.

Group list List of available user groups.

Next group Goes to the next group.

New group Creates a new user group. The focus is set to the

group name control element for input. Clicking on
the OK button after input creates a new user

group.

Delete group Deletes selected group after a confirmation
message.

PROPERTIES

Issue of group names and confirmation/rejection of changes.

Group name Display or entry of a group name.

Note: Element of the type Dynamic text.
Functionality is assigned using the Screen type
specific action property.

oK Applies changes.
Cancel Discards all changes since the last acceptance with
OK.

AUTHORIZATION LEVELS

Configuration of the authorization levels.

Available authorization levels Display of the authorization levels available.
Previous available authorization level Goes to the previous level.

Listbox Display of the authorization levels.

Next available level Goes to the next level.

Apply level (>>) Moves selected level from available authorization

levels tO selected authorization levels.
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Remove level (<<) Moves selected level from selected authorization
levels to available authorization levels.

Selected authorization levels Display of the authorization levels selected for the
user group.

Previous selected level Goes to the previous level.

Listbox Display of the selected authorization levels.

Next selected level Goes to the next level.

COMPATIBLE ELEMENTS

Compatible elements Control elements that are replaced or removed by
newer versions and continue to be available for
compatibility reasons. These elements are not
taken into account with automatic insertion of
templates.

Group name Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Note: For dynamic text or switch control elements , the respective functionality is assigned using the
Screen type specific action property.

3.11.3.1 Screen switching to user group list

With screen switching, you also define which screen is opened in the Runtime for the creation or editing
of user groups.

To create a screen switch to a user group list screen:
1. Create a function.

Select screen switching.

Select the user group list screen

Confirm the configuration by clicking on OK.

v W

Link the function to a button.
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3.11.4 Create Edit user screen

This screen type allows the editing of users in the Runtime. Depending on the configuration of screen
switching, users can be created or edited and passwords can be changed. Users and user groups from
the global project cannot be administered.

Note: This screen type is not available under Windows CE.

ENGINEERING

Two procedures are available to create a screen:
»  The use of the screen creation dialog

» The creation of a screen using the properties

Steps to create the screen using the properties if the screen creation dialog has been deactivated in the
menu bar under Tools, Settings and Use assistant:

1. Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

2. Change the properties of the screen:
a) Name the screen in the Name property.
b) Select Edit User in the Screen type property.
c) Select the desired frame in the Frame property.
3. Configure the content of the screen:
a) Select the Elements (screen type) menu item from the menu bar.

b) Select Insert template in the drop-down list.
The dialog to select pre-defined layouts is opened. Certain control elements are inserted
into the screen at predefined positions.

C) Remove elements that are not required from the screen.

d) If necessary, select additional elements in the Elements drop-down list. Place these at the
desired position in the screen.

4. Create a screen switch function.

58 | 224



CONTROL ELEMENTS

User Autherization levels Message Control

User name Available Selected r User

Available authorization lefeds | Selected authorization leels | —

Typ: TouchBox m Typ: TouchBaox -l elephone
Complete name ID: 53522 H: 1D: 53523 HE

Cell phone

User type =
User type _
Typ: COMBOBOX < et
IP=1003ive
[~ Locked Subsfiiute person
Lock code for Command Processing L | — —
Login profile User Groups NA code
Legin profile
Typ: COMBOBOX Available Selected
ID: 53510

Available user groups Selected user groups [ |
Typ: TouchBox Typ: TouchBox F
Change password ID: 53526 10: 53527

™ il

Old password

==

MNew password e

Confirm password :
| | |l Undo

Control element Description

Insert template Opens the dialog for selecting a template for the

screen type.

Templates are shipped together with zenon and
can also be created by the user.

Templates add pre-defined control elements to
pre-defined position in the screen. Elements that
are not necessary can also be removed individually
once they have been created. Additional elements
are selected from the drop-down list and placed in
the zenon screen. Elements can be moved on the
screen and arranged individually.

USER

Control element for user configuration.

User name Enter the username. The user logs in to the system
with his username.

Maximum length: 20 characters.
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Note: This name must be unigue and can only be
issued once. If an attempt is made to create a
pre-existing user again, an error message is issued.

Complete name Enter the full name of the user. With this you can
allocate a username to a real person.

Login code Entry of the login code for login without password.

The following is applicable for the login code:

»  Must be unique within the project.
Note: If the same login code is used for a
user in the local project and the global
project, the user from the global project is
not transferred when creating the Runtime
files in the Editor. Note the corresponding
error message in the output window.
When the login code is changed in the
Runtime, it must not be the same as the
code of a user from the global project.

» Canbeempty.
[t is thus deactivated for this user.

»  Maximum length: 7000 characters
»  Must not consist of spaces only.

» Leading or closing spaces are not
permitted.

» All other characters are permitted.
Default: (empty)

If an invalid login code is entered, a corresponding
error message is shown when the dialog is closed.

For details, see the Login via login code (on page
90) chapter.

User type Drop-down list for the selection of the user type:

»  User:
Can carry out actions according to the
authorization levels they have been
assigned.
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» Power user:
Can also create and edit users. Whether this
is also applicable for other power users is
configured using the Power user can
create/edit other power users option.

» Administrator:
Can create and edit all other users and
power users.

Active Checkbox.

Active: The user is active and can login in the
Runtime.

Note: According to FDA 21 PART 11 regulations, a
user can never be deleted, so it is possible to trace
who carried out which action at any time.
Therefore for projects which adhere to these
regulations, a user must not be deleted but only
deactivated.

To prevent the deletion of users, deactivate the
User Administration property in the Deleting
users group in the project properties.

Locked Checkbox.

Active: The user is locked in the Runtime and
cannot login.

This option is set automatically if a user enters an
incorrect password more than is permitted.

Power user can create/edit other power Checkbox.
users
Settings for the power users' detail rights:

» Active: Can also create and edit other power
users.

» Inactive: Can only create and edit users.

Default: inactive

Lock code for command processing Four-digit PIN code.
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This code is used by the user in the command
processing to block areas or to unlock them.
Only available if zenon Energy Edition has been
licensed.

Login profile Selection of the Runtime profile that is used for
login from a drop-down list:

» None
» Default
» Last

CHANGE PASSWORD

Control element for password configuration.

Old password Current password.
New password Enter new password. Input is automatically hidden.

For projects with multiple languages, note that it
must be possible to enter the characters with the
respective keyboard in the Runtime.

Confirm password Repeat the password. Input is automatically
hidden.

MESSAGE CONTROL

Control element for configuration of Message Control.

Message Control User Checkbox.

Active: The user is used by the module Message
Control.

Telephone Number of the voice-compatible telephone device
of the user. Used for text to speech.

Enter numbers. In addition, the following are
permitted:

» The prefix + as an abbreviation for 00 of the
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international area code is permitted.

The following separators are also permitted in AD
user administration: Minus (-), slash (/) and space
Note: When communicating between AD and
Message Control, separators are ignored as soon
as the data from the AD is mapped to a zenon
object.

Cell phone Cellphone number of the user. Used for messages
via GSM and SMS (text messages).

Enter numbers. In addition, the following are
permitted:

» The prefix + as an abbreviation for 00 of the
international area code is permitted.

The following separators are also permitted in AD
user administration: Minus (-), slash (/) and space
Note: When communicating between AD and
Message Control, separators are ignored as soon
as the data from the AD is mapped to a zenon

object.
Email E-mail address of the user
Substitute person If a user has not been reached or they do not

accept the message, a substitute person can be
given. Click the ... button and the dialog (on page
25) opens to select an user. Only users who have
been activated as Message Control users are
offered for selection.

Select substitute person Click on the ... button to open the dialog (on page
25) to select a substitute person.

PIN code PIN code with which the user confirms the receipt
of the message.
The code consists of a four-digit number between
0000 and 9999.

NA code PIN code with which the user rejects the receipt of
the message (not available). The message is then
sent to the next user in the list.

If there is no other user entered in the list, the
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message is entered as "not successfully
acknowledged". The function assigned to this is
executed. In addition, a "rejected by" CEL entry is
created in each case.

The code consists of a four-digit number between
0000 and 9999.

Note: You can find further information on the
assignment of functions in the Confirmation of
receipt - confirmation of receipt settings chapter.

AUTHORIZATION LEVELS

Control element to configure the authorization levels.

Available authorization levels List of all available authorizations.

Selected authorization levels List of all selected authorizations.

Apply authorization level (>>) Entries selected in the list Available authorization
levels are added to list Selected authorization
levels.

Remove authorization level (< <) Selected entries in list Selected authorization levels

are removed from the list.

USER GROUPS

Control element to configure the user groups.

Available user groups List of all available user groups.
Selected user groups List of assigned user groups.
Apply user group (>>) Entries selected in the list Available user groups are

added to list Selected user groups.

Remove user group (<<) Selected entries in list Selected user groups are
removed from the list.

TOUCH

Control element for navigation in list boxes, optimized for Touch operation.
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Available authorization level up Navigates one authorization level up in the
Available authorization levels list box.

Available authorization level down Navigates one authorization level down in the
Available authorization levels list box.

Selected authorization group up Navigates one authorization level up in the
Selected authorization levels list box.

Selected authorization group down Navigates one authorization level down in the
Selected authorization levels list box.

Available user groups up Navigates one authorization level up in the
Available user groups list box.

Available user groups down Navigates one authorization level down in the
Available user groups list box.

Selected user group up Navigates one authorization level up in the
Selected user groups list box.

Selected user group down Navigates one authorization level down in the
Selected user groups list box.

OK/CANCEL

Control element to confirm or discard changes.

oK Applies changes.
Cancel Discards all changes since the last acceptance with
OK.

COMPATIBLE ELEMENTS

Compatible elements Control elements that are replaced or removed by
newer versions and continue to be available for
compatibility reasons. These elements are not
taken into account with automatic insertion of
templates.

User Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
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Control element

User name

Complete name

Administrator [Button]

Administrator [Switch]

Active

Locked

Lock code for Command Processing

Change password

Old password

New password

Confirm password

Message Control

Message Control user

element.

Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Static Win32 control element. Was replaced by a
switch element. For the description, see new
element.

Switch element. Has been replaced with the user
type drop-down list.
For the description, see new element.

Static Win32 control element. Was replaced by a
switch element. For the description, see new
element.

Static Win32 control element. Was replaced by a
switch element. For the description, see new
element.

Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Properties for the password.

Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Properties for use in the Message Control module.

Static Win32 control element. Was replaced by a
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switch element. For the description, see new
element.

Telephone Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Cell phone Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Email Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Substitute person Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

PIN code Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

NA code Static Win32 control element. Was replaced by a
dynamic text field. For the description, see current
element.

Note: For dynamic text or switch control elements , the respective functionality is assigned using the
Screen type specific action property.

3.11.4.1 Screen switching for edit user
With the screen switching, you define how the edit user screen is called up. Depending on the
configuration, you can:
» Create a new user
»  Edit a user from the user list or from a string variable
» Change passwords
To create a screen switch to an edit user screen:
1. Create a function.
2. Select screen switching.

3. Select the edit user screen.
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The dialog for configuration is

~Noo s

Link the function to a button.

USER LIST DIALOG

Filter...

User

'Z§Z' Create new user
() apply user from calling screen

() Apply user from variable

() Change password of logged in user

[ show dialog in Runtime

Parameter

Create new user

Apply user from calling screen

Apply user from variable

Change password of logged in
user

Show dialog in the Runtime

opened

Configure the screen switching.

Confirm the configuration by clicking on OK.

The edit user screen is used to create a new user. The
corresponding control elements are activated.

If the call is from the user list screen, the edit user screen
that is selected in the user list is used to edit the user. The
corresponding control elements are activated.

Note: The editing user must have administrator rights in
the Runtime. At least one user must be selected in the list.

The edit user screen whose name is transferred form the
defined string variable is used to edit the user. The
corresponding control elements are activated.

Click on the ... button to open the dialog for selecting a
variable.

The edit user screen is only used to change the password
of the user who is currently logged on. The corresponding
control elements are activated.

Checkbox to select whether this dialog is shown in
Runtime:

» active: This dialog is called up during operation in
the Runtime on the current computer. In the
network, this dialog is called up on the computer
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that executes the function. As a result, changes to
existing parameter settings of an zenon Editor
configuration are possible during execution in
zenon Runtime.

» Inactive: This dialog is not shown in the Runtime
during operation. The function or the command is
immediately executed with the project
configuration created in the Editor.

CLOSE DIALOG

R === R

OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.
Help Opens online help.

4 zenon login and user administration in the Runtime

Windows AD or AD LDS can also be used for user administration. Users can be logged in permanently
or temporarily and administered in the Runtime.

Note: It is not possible to rename user groups in the Runtime.

Values or functions can also be protected by means of a signature. To do this, the Signature necessary
property must be activated for the corresponding element. In this case, the user must enter their
password and signature again, even if they are logged in and have the appropriate rights. In doing so,
an additional entry is created in the Chronological Event List.

Note: The Signature necessary property can also be used for changes to Recipegroup Manager
variables.

69 | 224



A Attention

Settings for users who are changed in the editor can only be applied if the
Runtime changeable data project property (General group) allows overwriting
of user properties when writing Runtime files.

Settings changed in Runtime can be applied using the Import Runtime files
command (Runtime files toolbar) in the Editor. To do this, decompiling must be
permitted in the Runtime changeable data property. This is the case if the
checkbox in the Do not decompile column is not activated in the User
Administration row.

4.1 Login process and administration

The current user SYSTEM will be logged in with the approved user level LEVEL O after Runtime is started.
In multi-project administration, users can also be automatically (on page 76) be logged into all
subprojects.

RULES FOR LOGIN IN THE RUNTIME.

Logging in in the Runtime has the following safety precautions:
» Password
Note that different conditions are applicable for the password length:
» Local users: a maximum password length of 20 characters is permitted
» AD users: a maximum password length of 255 characters is permitted

A user is locked after having entered a wrong password several times and they are logged out
automatically. Therefore no elements of the system can be operated if they require an
authorization level higher than 0. They cannot carry out any operations linked to a user level
any more. The number of login attempts that are permitted is configured in the project settings
with the Max. user error property.

The user name that was used for the login attempt is logged in the Chronological Event List.
The administrator has to unlock this user (deactivating the Locked property).

» User name

If a non-existent user name is entered, the error message 'Invalid user name' is displayed. After
three unsuccessful attempts, the system is blocked for all elements that require a higher
authorization level than 0. No user is therefore in a position to carry out protected operations
with a user level. Only the administrator can unlock the system.
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The username of a user trying to log in incorrectly is logged in the Chronological Event List as
an event for the user that is currently logged in.

If a correct user name is used for login but the password field remains empty, this is considered
an invalid password. The user is blocked after a defined number of permitted unsuccessful
attempts (default 2, block after a third failed attempt).

» Loqgging in after deactivation

If an user is deactivated and he tries to log in, this is not possible. This attempt is logged in the
Chronologic Event list.

Note: Changes to the password via functions, screens, dialogs and API are also checked and lead to
the user being blocked if the current password is entered incorrectly several times. The number of
characters in the field of the current password does not provide any indication of its the length of the
password.

EXTERNAL AUTHENTICATION

User authentication can be carried out for external programs or applications using zenon API. If there is
an incorrect external authentication, the system or the user can be blocked.

Activate the System lock for wrong external authentication property and/or User lock for wrong
external authentication in the User Administration properties group.

Note: It is recommended that these options are activated in order to achieve the highest degree of
security.

Furthermore, it is possible to state, under the options Max. user error or Max. password error, the
amount of incorrect entries that are permitted to occur before a block is activated.

4 Attention

This setting has no influence on the user block in the Active Directory when
using AD users. The domain settings are always applicable here.

REQUIREMENTS FOR AD AND AD LDS USE

In order to be able to use AD and AD LDS for logging in to zenon Runtime, the zenon project property
User Administration/Access to Active Directory must be configured.

» AD: Yes must be selected for the property and the computer must be in the domain.

» AD LDS: ADAM/AD LDS must be selected for the property.
The properties AD LDS connection, AD LDS user name and AD LDS password correctly
configured.

» AD LDS must be prepared accordingly.
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Note: ADAM is not supported.

Administration is possible for:
» From Windows 8 and Windows Server 2012 (on page 133)
»  Windows 7 (on page 166)
»  Windows Server 2008 (on page 186)

A Attention

Rights that are issued in zenon are applicable for the respective project or the
workspace. Permissions that are issued in the Active Directory are applicable
globally.

If rights have been issued to users or user groups of the Active Directory, then
the rights for these users are applicable in all zenon projects!

ADMINISTRATION IN THE RUNTIME

Each user has the possibility to change their own password in the Runtime. But he cannot edit another
user. Only an administrator can do that. Changes in the Runtime must be read back in the Editor, in
order to be available there. Note the Runtime changeable data property when transferring Runtime
files. Here, it is specified whether the configuration of the user administration is transferred to Runtime
and overwrites the configuration in the Runtime. The contents of the user administration are not
replaced by default when transferred to Runtime.

RIGHTS IN THE RUNTIME USING FUNCTIONS AND SCREEN TYPES

Depending on the user type, users can carry out different actions in the Runtime:

User type / rights Administrator

Create and administer users

Create and administer power users X 0 —
if configured

Create and manage administrators X -- --
Create and manage user groups X = —
Issuing authorization levels X X --

Note: Only authorizations that the user
also has can be issued. This prevents
administrators or power users enabling
the system themselves.
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Change your own password

Note: User and user groups from the Editor global project are combined with the users and user
groups of the project in the Runtime. They can neither be edited in the Runtime, nor read back in the
Editor.

A Attention

Compliance with FDA 21 CFR Part 11:
»  Neither user nor administrator can change the user name in the Runtime.

» Deleting users can be prohibited in the project settings with the help of the
Deleting users property in the User Administration group.

PASSWORD

The user himself is the only one knowing his password. And he is the only one able to change his
password. Once the user has been given a password by the Administrator, they must change it when
they first log in. This makes sure, that no administrator knows user passwords und thus could effect
wrong signatures. (Important for FDA 21 PART 1).

If an user forgets his password, the administrator can delete his password und enter a new initial
password. To do this the administrator does not have to know the password. The user must change
their password the next time they log in.

For more information on changed Runtime files see also chapter: Files that can be changed in Runtime

A Attention

Login via screen of type Login: If, when logging in via a Login screen (on page
43), no password is entered for a valid user, you do not receive an error
message. The user is not logged in. Even after three failed login tries with no
password entered the system is not logged.

If entering a wrong password or a not existing user name, the system is locked
after three tries as usual.

4.2 User login

Logging into a project is carried out by means of a modal dialog or a login screen.
Users can be signed in in different ways:
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Permanent
Temporary
Automatic
Externally via the API

With cached sign-in information (only with Active Directory)

v v Vv Vv v Vv

Without pre-existing domain connection

4.2.1 Permanent login

After a permanent login, the user is permanently logged in and can carry out all operations that they are
authorized (on page 18) to do. For actions that the user is not authorized to carry out, a message is
shown accordingly.

Permanent login can be effected by means of:
» A screen switch to a login (on page 43) screen
» The function (on page 87) Login with dialog

» The Login without password function (on page 88)

Hint: Password-protected buttons can be made invisible for logged-in users. To do this, the Locked
buttons property (Project properties -> User Administration -> Login and signature) must be
configured accordingly.

Note: Temporary login is not possible for logged-in users. Logged-in users therefore do not receive a
dialog to log in temporarily for functions for which they do not have sufficient authorization.

4.2.2 Temporary login

If an operation that requires authentication is necessary for a user who is not logged in, or entry of a
signature is required, the user can be logged in temporarily. To do this, the User Administration
property (-> Login and signature -> Temp. login active) must be activated.

Temporary login can be effected by means of:
» Modal dialog, which is automatically called up by zenon.

» Login (on page 43) screen that is linked to the Screen for Login property.

Procedure for login in the Runtime:

1. The configured dialog to log in or enter a signature is opened when a password-protected
function is executed.
Ifa Login (on page 43) screen is linked, this is opened. Otherwise a modal dialog is opened.
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2. The user can log themselves in and execute operations in accordance with their rights. If the
user does not have authorizations, they receive a corresponding message.

3. The user is automatically logged out again immediately after the operation
¥ Information

Temporary login:
» Isonly effective if a function is executed
»  Supports switches, but not pushbutton

» Is deactivated for permanently logged in users

SCREEN OF TYPE LOGIN

This screen type allows temporary login or the entry of a signature.

Login

Current user:
SYSTEM

User name

Password

xxxxxxxx

Control element Description

Current user (Display) Display of the currently logged in user

Note: Element of the type Dynamic text.
Functionality is assigned using the Screen type
specific action property.

User name Input area for username.

Note: Element of the type Dynamic text. Functionality
is assigned using the Screen type specific action

property.
Password Input field for password.

Note: Element of the type Dynamic text. Functionality
is assigned using the Screen type specific action

property.

Signature Input field for signature.
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Note: Element of the type Dynamic text. Functionality
is assigned using the Screen type specific action

property.
OK Button to close the screen after login.
Cancel Cancels the login process.
Apply Applies all changes and leaves the dialog open.

Exception: The window is closed if the maximum
number of invalid login attempts has been set to 0
using the Max. user error property.

TEMPORARY LOGIN MODAL DIALOG

This dialog allows temporary login. If a signature is required, this must be entered in a second stage.

E—
I ‘ aaaa - | o
Current user (display) Display of the currently logged in user
User name Input area for username.
Password Input field for password.
OK Button to close the screen after login.
Cancel Cancels the login process.

4.2.3 Automatic login and logout for subprojects

In multi-project administration, users can be logged into subprojects and logged out from them
automatically.

The basis for automatic login are central users (the same for all projects).

There are several possibilities to achieve this:

»  Use of Active Directory or AD LDS/ADAM users
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»

»

» Isthe preferred possibility for administering users throughout projects.

» You can find more detailed information on configuration and use in the Active Directory
(on page 119), AD LDS (on page 132) and ADAM (on page 193) chapters.

Use of users from the global project

»  Users from the global project are available for all projects in the workspace.
» Attention: Users from the global project cannot be edited in the Runtime.
Manual administration/synchronization of users

» If, in the integration project and/or in the subprojects, there are users with the same name
and the integration project is logged into, the users with the same name are also logged
into the subprojects.

CONFIGURATION IN THE EDITOR

To configure automatic login/logout:

1.

oW

Open the project properties.
Go to the User Administration node.
Activate the Automatic login/logout in subprojects property.

Repeat this step for all projects that are to support automatic login/logout.

APPLICATION IN THE RUNTIME

Log into Runtime with a user in a project.

The following is applicable in the Runtime:

4

When logging into a project, an user is automatically logged in to all subprojects that support it.
They are logged out of all subprojects when logging out.

No corresponding dialogs are called up in the subprojects when logging in or out. Users who
are already logged in are logged out.

If the user logs out from a subproject, then:

» They are logged out of this project and all its subprojects

» They remain logged in to all superordinate projects in which they are logged in

When logging in/out, the corresponding entries are created in the CEL all projects concerned.

Automatic login/logout only works in the direction of projects to subprojects, never the other
way round.

Note: This functionality is not suitable for temporary login.
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PROCEDURE FOR WINDOWS USERS

A Windows user who is already logged into a subproject (AD/AD LDS/ADAM) is reused in a subproject
with automatic login. To do this, the context (AD path or AD LDS/ADAM path) must be the same. If a
Windows user is used for the first time in the login chain, the password is checked at this point. If a
check at the start of the login chain returns invalidity, the complete login process is canceled. If a login
attempt in a subproject is rejected, this login is canceled, but the process is continued for all other
projects.

¥ |nformation

For the logged-in user, the authorization level of the project that comes from
the user is always used.

Example:

In the integration project, a user A can have the authorization levels 7,2,3, whilst
in the subproject, a user A can have the authorization levels 7,2,3,4,5.

The same applies for users from the Active Directory and the assignment of
authorization levels via zenon user groups. A user B can thus inherit, from the
Active Directory, the authorization levels 7,2,3 from a zenon user group in the
integration project and a user B in the subproject can inherit the authorization
levels 7,2,3,4,5 from the user group of the subproject.

You can find further information in relation to this in the Same user groups in
zenon and in the Active Directory (on page 123) chapter.

4.2.4 External authentication

User authentication can be carried out for external programs or applications using zenon API. If there is
an incorrect external authentication, the system or the user can be blocked.

Activate the System lock for wrong external authentication property and/or User lock for wrong
external authentication in the User Administration properties group.

Note: It is recommended that these options are activated in order to achieve the highest degree of
security.

Furthermore, it is possible to state, under the options Max. user error or Max. password error, the
amount of incorrect entries that are permitted to occur before a block is activated.
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A Attention

This setting has no influence on the user block in the Active Directory when
using AD users. The domain settings are always applicable here.

4.2.5 Login with cached credentials.

For AD domain users (on page 118), login with cached sign-in information is possible. The sign-in can
also take place if there is no connection to the AD Domain Controller.

CONFIGURE LOGIN

To allow a login with cached login information:
1. Go to the User Administration group in the project properties.
2. Go to the Active Directory/AD LDS section.

3. Inthe User group for Active Directory login with cached credentials property, click on the
... button.

The dialog for selecting an user group is opened.
4. Select the desired user group.
5. Close the selection dialog.

The GUID of the selected user group is saved in project.ini .

CONFIGURE USER GROUP

For the selected user group, issue the authorization levels that are to be available to all users. The users
do not also need to be added to the group. The group properties are automatically applicable for all
users who are signed in with cached sign-in information.

If the user group is deleted, its GUID remains saved. Users can continue to be signed in, but do not
receive any authorization levels. If the group in the User group for Active Directory login with
cached credentials property is set to No selection or a new selection is made, the GUID will be deleted
or reentered accordingly.

BEHAVIOR IN THE RUNTIME

If an AD user logs on in the Runtime, if there is no connection to the AD Domain Controller, a check is
made to see whether, in the project.ini file, there is a GUID for a user group for the
USRGROUP_AD_CACHED entry:
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» The sign-inis rejected if there is no GUID.
No user group has been configured or a configured user group has been removed by clicking

on No selection.

» If there is the GUID of a valid user group, the user is signed in with authorization levels from this
group.
A valid user group has been configured.

» If there is the GUID of an invalid user group, the user is signed in without authorization levels.
A user group was entered in the User group for Active Directory login with cached
credentials property but the user group has been deleted however.

Each attempt to sign in with cached login information is entered in the CEL.

HANDLING DELETED USER GROUPS

User groups are linked by means of their GUID, not their name.

If an AD_Login user group is selected, its GUID is entered into project.ini and queried on sign-in. If the
AD_Login user group is deleted, its GUID remains entered. If a new AD_Login user group is created, this
gets a new GUID. The original GUID remains entered in project.ini. The new AD_Login user group is not
automatically linked. It must be newly selected using the dialog of the User group for Active Directory
login with cached credentials property.

A Attention

in the Runtime, a user who is signed in with cached login information gets all
rights of the selected group. Their authorizations can thus also exceed the rights
that they normally have.

4.2.6 Login with alternative domain

AD domain users (on page 118) can, for signing into zenon, even use a different AD domain than that
which is used for sign-in in Windows.

¥ |nformation

Automatic login in subprojects:

If, in the integration project, the Access to Active Directory property is active
and an alternative domain has been configured for the Acive Directory
domain property, users are only logged in subprojects automatically if, for its
Acive Directory domain property, the same domain has been configured as in
the integration project.
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CONFIGURATION OF ALTERNATIVE DOMAINS

If an alternative domain is to be used, this must be configured in the Editor:
1. Inthe Editor, go to the project properties for User Administration.
2. Ensure that Access to Active Directory is activated.

3. Inthe Acive Directory domain property, enter the name of the desired domain.
Attention: If the entry stays empty, it is not possible to sign into another domain.

4.2.7 Login without existing domain connection

Active Directory users can log in to zenon, even if Runtime has not been started by an Active Directory
user.

¥ |nformation

Automatic login in subprojects:

If, in the integration project, the Access to Active Directory property is active
and a domain has been configured for the Acive Directory domain property,
users are only logged in subprojects automatically if, for its Acive Directory
domain property, the same domain has been configured as in the integration
project.

CONFIGURATION OF LOGIN IN DOMAINS

In order to allow the login of AD users under these circumstances, the project must be configured
accordingly:
1. Inthe Editor, go to the project properties for User Administration.

2. Ensure that Access to Active Directory is activated.

3. Inthe Acive Directory domain property, enter the name of the desired domain.
Attention: If the entry stays empty, it is not possible to log in.

4.2.7.1 Read user names from domains for AML and CEL

The complete Windows user names can be displayed in the AML and CEL. If Runtime is started by an
AD user, this data is automatically available. If Runtime is started by a local user, the reading-out must
be configured in the domain controller.

To display user data by means of AD:

1. In zenon Editor, enter the domains in the Active Directory/AD LDS group in the Acive
Directory domain property.
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2. Enter the desired user data in the Windows login information administration in the Generic
login information:

» Net address: Domain
P User name: Windows user identification of a user entitled to read access
» Password: User's password

Hint: You get to the Windows login information administration via Control Panel -> System
and Security -> User Accounts -> Generic login information or via the command line with
rundll32.exe keymgr.dil,KRShowKeyMgr.

Note Runtime: There must already be a connection to the domain controller when Runtime is started.
Otherwise no complete user names are displayed. They are also not displayed if a connection to the
domain controller is subsequently established. In this case, Runtime must be restarted with the
connection established.

4.3 Administer users and user groups

Users and user groups can also be administered in the Runtime.
* Information

Note the following with changes in the Runtime:
»  Write them back to the Editor of the project configuration computer

» Do not overwrite them with Editor settings

The following possibilities are available for user administration in the Runtime:
Create user »  User list screen
»  Edit user screen
» Change user function
Edit user »  User list screen
» Edit user screen
» Change user function
Delete user »  User list screen

» Change user function

Attention: Do not delete a user who is a general
module owner.

Change password »  Edit user screen
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» Change user function

» Change password function

Assign function authorization »  Change user function
Creating a user group »  User group list screen
Edit user group »  User group list screen
Assign authorization level »  User group list screen
4.4 Screen types to administer users and user groups

Users cannot only be administered in the Runtime with functions and modal dialogs; they can also be
administered by means of special screen types:

4

4

User list (on page 83): Lists all users and offers possibilities to create, edit and delete users as well
as to assign function authorizations.

User group list (on page 84): Lists all user groups and offers the possibility to create and
administer user groups and to assign function authorizations.

Edit user (on page 85): Allows the creation and administration of users.

You must be logged in as an administrator for all actions. Exception: Users without administrator rights
can change their own password.

4.41 User List

You administer users with this screen.
In doing so, the following applies:

4

4
4
»
»

You must be logged in as an administrator or as a power user.
You can create new users.

You can edit users.

You can delete users.

You can only issue function authorizations that you have yourself directly or as a member of a
user group.

To administer users:

1.
2.

Log in as an administrator or power user.

Create a user list screen.
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3.

User active | User identification Complete name Authorization levels| User gropus v.'s I
= w o W w
g gb 0,10, 11,12, 13... 24 Z1 |
JD John Doe 0.1.7.12. 14, 16 |
be be 0
|
|

Configure the desired settings.

» Clicking on New opens an edit user screen. This must be linked for screen switching.

» Clicking on Edit opens an edit user screen. This must be linked for screen switching.

™

Edif:

Delete

Ei

Function

CEET

You can read details about the control elements in the Create user list screen (on page 46) chapter.

4.4.2 User Groups List

You administer user groups with this screen.
In doing so, the following applies:

4
4
4

You must be logged in as an administrator.

You can only administer user groups to which you also belong.

You can create new user groups.

User groups that you create are assigned to you immediately. The group thus has at least one

member and can be assigned further users.

To administer user groups:

1.
2.

Log in as an administrator.

Open a user group list screen.

84| 224



3. Configure the desired settings. The possible settings correspond to those in the Editor.

teergronrs Prooerties:

Auailable levels Selected Authorization leveds

‘ Erevious group ‘

Previout available authorization leve! ‘ Previous selocted lovel ‘

Al
22 Fl
: B
4

5

‘ Nextavailabie leve] ‘ Nextselected level

Group Name:

New group [ o oK ] Cance |

You can read details about the control elements in the Create user group list screen (on page 54)
chapter.

4.4.3 Edit users and change password
You can administer other users with this screen. All users can also change their own password.
In doing so, the following applies:

1. You must be logged in as an administrator or as a power user.
Exception Users without administrator rights can change their own password.

»  You can only issue authorization levels that you have yourself directly or as a member of a user
group.

P You can only assign user groups to which you also belong.

»  You cannot change your own authorization levels or user groups in the Runtime.

EDIT USER

To administer users:
1. Log in as an administrator or power user.

2. Open an edit user screen
or open a user list and click on New or Edit there.
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3. Configure the desired settings. The possible settings correspond to those in the Editor or the
Change user (on page 93) function.

User identification

Complete name

[l Administrator
[+#] Active
[CJLocked

Login profile
Mone

Leck code for Command Procesain

— Change
O pas s o o

Mew password

Confirm password

— Santral

Telephone

[IMessage Control user

— AUTROrIZAtGn 18wels
Available authorization levels

Up

=
10
1

12
13
1a
15
16
17
18
14

Down

=
=N

Selected authorization levels

Up

o

Down

— User groups

Available user groups

Up
Z1
Za

Down

BE [

1

Selected User GrouRs

Up

Down

You can read details about the control elements in the Create edit user screen (on page 58) chapter.

CHANGE PASSWORD

A modal dialog is called up in order for users to be able to change their own password. This dialog can

also be replaced by an edit user screen. The dialog or screen can be called up modally if:

» The Change password function is executed

» The user who is logged in is to change their password (new user, expired password, password

reset)

To allow users to edit their password by means of a screen:

1. Link, in the User Administration Login and signature project properties, the Screen for

password change property to an Edit user screen.

2. The screen is opened modally instead of the modal dialog in the Runtime.

3. Users can change their password.
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A Attention

Note when changing passwords for AD users:

The requirements of zenon for a minimum and maximum length of password
take priority.

Example of minimum length: AD requires a minimum length of 4
characters. In zenon, a minimum length of 8 characters has been configured
using the Minimum password length property. If a password with fewer than 8
characters is entered, this leads to an error message. The password can be valid
for AD, but is rejected by zenon.

Note on maximum length: Different maximum password lengths are
permitted in zenon Runtime:

P Local user: maximum of 20 characters

P AD user: maximum of 255 characters

If the AD password is longer than 20 characters, an AD can use it to sign into
zenon. The password can also be changed in zenon however.

4.5 Functions for the user administration module

The following functions are available for the user administration in the Runtime:

»

4.5.1

Login with dialog (on page 87): Opens a modal dialog or the login screen for permanent login

in the Runtime.

Login without password (on page 88): Logs in the user defined in the Editor without password

entry or allows login with a chip identification system.

Logout (on page 93): Logs out the user who is currently logged in and logs in the System user

with authorization level 0.

Change user (on page 93): Opens a dialog to edit users and user groups.

Change password (on page 116): Opens a dialog in the Runtime to change the password.

Login with dialog

This function opens in the Runtime, depending on the configuration:

»
4

The modal login dialog

The login (on page 43) screen
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Modal dialog

T
] ‘ ”””” - | -
Current user (display) Display of the currently logged in user

User name Input area for username.

Password Input field for password.

OK Button to close the screen after login.

Cancel Cancels the login process.

The login is logged in the Chronological Event list.

SIZE AND POSITION

The size and position of the login window in the Runtime can be defined in zenoné.ini:
1. Open zenon 6.ini.
2. Create or modify the area:
[Command Processing]
3. Enter a values for:
POSITION= left, right, top, bottom
Default: POSITION= 0.001, 0.999, 0.835, 0.964

Attention: The size relates to the screen size and not the size of the main window.
¥ Information

You can findzenoné.ini in the following path:
%ProgramData%\COPA-DATA\System)\

4.5.2 Login without password
This function makes it possible to log in a user to zenon without a password in the Runtime. To do this,

the user is logged on directly and without making any selection or entering anything. To do this, the
user is identified by means of a variable, a code or a chip identification system. This function can be
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executed by an event (status of a key) or by time control. The login is logged in the Chronological Event
List.

Login without a password is also suitable for automatic login using card reading devices. There are two
possibilities available for this:

»  Login via login code (on page 90):
Any desired code can be linked to a user and transferred to a variable. This transfers the code
to the Login without password function. This version is only available for zenon users.

» Log in via Chip Ident System (on page 92):
The user name is transferred to a variable that logs in the user. Available for zenon and AD
users.

4 Attention
Note the consequences if this function is configured with a string variable as a
parameter:

» The user administration can be avoided.

» For Active Directory users, the check of user name and password does not
take place via the domain controller. It is thus possible for users who have
been blocked due to incorrect password entries or who cannot be logged in
due to time limitations or workstation limitations.

Only use this possibility if other configurations are not possible and note the
effects on the security of the system.

CREATE A FUNCTION

To create the Login without password function:
» Create a new function.
» Go to the User Administration node.
» Select Login without password.
The dialog to configure the login user is opened.

»  Select the type of log in
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DIALOG LOGIN WITHOUT PASSWORD

Legin without password

@ User name

(O User name from Variable

<no variable linked:>
(O Login code from variable

<no variable linked:>

[ el [ neb

o e

User name Logs in the selected user.

Click the ... button and the dialog (on page 25) opens to select an

user.
User name from Logs in the user with the user name from the transferring variable.
Variable Makes it possible to login a user via a Chip Ident System.

Click on button ... in order to open the dialog for selecting a String
variable. For details see the "Login via Chip Ident System" section.

Login code from Logs a users in by means of a login code. This code is linked to the
variable user in the user administration (on page 12) and transferred in the
Runtime by means of a STRING variable.

Attention: This type of login only works for zenon users and is not
available for AD users.

For details, see the Login by means of login code (on page 90)

chapter.
OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.
Help Opens online help.

4.5.2.1Login via login code

Users can also be logged in without a password in the Runtime by means of a separate login code. This
code is linked to the user and is transferred for login by means of a variable.
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LOGIN CODE

The login code can be linked to the user by means of:

»
4

The Users (on page 12) tab in the dialog for user configurationzur Benutzerkonfiguration

The Login code property

The following is applicable for the login code:

»

v v Vv Vv Vv

Must be unigue within the project.

Note: If the same login code is used for a user in the local project and the global project, the
user from the global project is not transferred when creating the Runtime files in the Editor.
Note the corresponding error message in the output window. When the login code is changed
in the Runtime, it must not be the same as the code of a user from the global project.

Can be empty.
[t is thus deactivated for this user.

Maximum length: 7000 characters

Must not consist of spaces only.

Leading or closing spaces are not permitted.
All other characters are permitted.

Default: (empty)

ACTION ON EXPORT AND IMPORT

The login code is exported in plain text during the XML export of a user.

During an XML import, the login code contained in the XML file is evaluated. It is removed if it does not
correspond to the input criteria. An error message is displayed in the output window.

LOGIN CODE FROM VARIABLE

To log a user in by means of a login code from a variable:

1.

2.

Link the desired code to a user in the dialog to create a user (on page ).

Create a STRING variable that transfers the code in the Runtime.

This variable must do the following in the Runtime:

a) Receive the code by means of an input field or from the ID card

b) Call up the Login without password function in the event of a value change
¢) Transfer the code

Create a Login without password function.

Select the Login code from variable option.
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5. Link the variable that transfers the code.

In the Runtime, the code of the ID card or the input from the input field is written to the variable. This
calls up the Login without password function and transfers the code. The linked user is searched for. If
a corresponding user is found, they are logged on.

If automatic login for subprojects (on page 76) has been configured, the login is also carried out for the
subprojects.

When incorrect login codes are transferred, the same rules (on page 70) as for login with incorrect user
names are applied.

A Attention

Login with a login code only works for zenon users and is not available for AD
users.

EDIT LOGIN CODE IN THE RUNTIME

In the Runtime, the login code can only be amended by a user with administrator rights. Other users
also cannot amend their own code.

The administrator has two possibilities for changing the login code in the Runtime:

»  Edit screen of type user (on page 58): The input field for the login code must be configured in
the screen, so that a login code can be issued in the Runtime.

» Change user function (on page 93): Allows the amendment and creation of users, including
login code.

Each change to the login code is logged in the CEL.

4.5.2.2Log in via Chip Ident System

The Login without password function with the User from variable option makes it possible to use
chip identification systems such as the Eucher or Keba identification systems. To use the function, please
note:

»  The user must exist in the zenon user administration or in the Active Directory with the same
user name as in the chip.

For example: The user name in the chip is J. Smith; there must be a J. Smith with corresponding
rights in the user administration or in the Active Directory.

» If the user holds his chip in front of the chip reader, the String variable (e.g. username) is filled
with the data of the chip (e.g. J. Smith) and the user is logged in.

» Inorder for this to work, a reaction matrix of the type String must exist which reacts to each
value change and executes the function.
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»  This reaction matrix must be linked with the variable (e.g. username).

4.5.3 Logout

When this function is used in the Runtime, the current user is logged out and the user SYSTEM is logged
in with authorization level 0. The log in of an user is logged in the Chronological Event List. If an Active
Directory user is logged in, they are also logged out.

No transfer parameters are needed.

A Attention

Automatic logout vs. automatic function:

» Automatic Logout: Happens permanently after the defined time has
passed after the last user action.

» Automatic function: Happens only once after the defined time has passed
after the last user action.

4.5.4 Change user

The Change user function makes it possible to create and administer users and to assign them
authorization levels in the Runtime.

To create the function:
1. Create a new function.
Go to the User Administration section.

Select the Change user function.

oW

Link the function to a button.

USAGE IN THE RUNTIME

This dialog is opened in the Runtime when the function is called up. This allows the creation and editing
of:

» Users (on page 94)
» User Groups (on page 113)
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¥ |nformation

Rules:

»  Administrators can administer all other users and their settings.

»  Administrators cannot grant additional authorization levels themselves or
add themselves to other user groups.

» Power users can administer other users.

»  Users without administrator rights can only change their password and their
settings for Message Control.

4.5.4.1 User

Users are configured in this tab.

User | User groups

User identification Complete name User act ..
be be TRUE
a agb TRUE
JO John Doe TRUE

Administ..

FALSE
TRUE
FALSE

User administration

Locked
FALSE
FALSE
FALSE

Runtime profile
Mone

Mone
DEFAULT

OK

Cancel

Change function
authoritation.

List user

New

Change

Delete

Change function authorization

Lists all configured users.

Opens the dialog (on page 95) to create and amend new
users.

Opens the dialog (on page 95) to create and amend new
users.

Deletes the selected user after requesting confirmation.

Opens the dialog dialog (on page 104) to assign function
authorizations to authorization levels for Runtime.
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CLOSE DIALOG

o =

OK Applies settings and closes the dialog.

Cancel Discards all changes and closes the dialog.

ADMINISTER USERS

To administer a user:
1. Highlight the user in the list.

2. Select the desired action by clicking on one of the buttons.

Note: Amending the dialogs for users and creating new users is different.

4.5.4.1.1Users

Entry of the user data.

Create new user

Users  Change password Message Control  Authorization levels  User Groups
Users
User name Cancel
| |
Complete name
| |
Login code
| |
User type
Users ~
Power user can createfedit other power users
I:l Active
[Locked
Options
Lock code for Command Processing
Login profile
MNone ~
USER
User name Enter the username. The user logs in to the system with

his username.

Maximum length: 20 characters.
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Note: This name must be unique and can only be issued
once. If an attempt is made to create a pre-existing user
again, an error message is issued.

Complete name Enter the full name of the user. With this you can allocate
a username to a real person.

Login code Entry of the login code for login without password.

The following is applicable for the login code:

»  Must be unique within the project.
Note: If the same login code is used for a user
in the local project and the global project, the
user from the global project is not transferred
when creating the Runtime files in the Editor.
Note the corresponding error message in the
output window. When the login code is changed
in the Runtime, it must not be the same as the
code of a user from the global project.

» Can be empty.
It is thus deactivated for this user.

Maximum length: 7000 characters
Must not consist of spaces only.

Leading or closing spaces are not permitted.

v v v Vv

All other characters are permitted.
Default: (empty)

If an invalid login code is entered, a corresponding error
message is shown when the dialog is closed.

For details, see the Login via login code (on page 90)
chapter.

User type Selection of the user type from a drop-down list:

» User:
Can carry out actions according to the
authorization levels they have been assigned.

» Power user:
Can also create and edit users. Whether this is also
applicable for other power users is configured
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using the Power user can create/edit other
power users option.

» Administrator:
Can create and edit all other users.

» Default: User
Description Text field to enter additional information

Power user can create/edit other Settings for the power users' detail rights:

ower users , 4
P » Active: Can also create and edit other power users.

» Inactive: Can only create and edit users.
Default: inactive
Active Active: The user is active and can login in the Runtime.

Note: According to FDA 21 PART 11 regulations, a user
can never be deleted, so it is possible to trace who
carried out which action at any time. Therefore for
projects which adhere to these regulations, a user must
not be deleted but only deactivated.

To prevent the deletion of users, deactivate the User
Administration property in the Deleting users group in
the project properties.

Locked Active: The user is locked in the Runtime and cannot
login.

This option is set automatically if a user enters an
incorrect password more than is permitted.

OPTIONS
opion————————Jowerpion
Lock code Four-digit PIN code.
This code is used by the user in the command processing
to block areas or to unlock them.
Only available if zenon Energy Edition has been licensed.
Login profile Selection of the Runtime profile that is used for login

from a drop-down list:
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» None
» Default
» Last

CLOSE DIALOG

T (2

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.

4.5.4.1.2Change password

Issue of the password for the user.

Create new user ﬂ

User | Change password Message Control | Authorization levels | User groups
OK

Cancel

MNew password

Confirm password

Old password Current password.
New password Enter new password. Input is automatically hidden.

For projects with multiple languages, note that it must be possible
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to enter the characters with the respective keyboard in the
Runtime.

Confirm password Repeat the password. Input is automatically hidden.

Note: The function Copy and Paste is not available for entering information in the password field.

CLOSE DIALOG

T (2

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.

¥ |nformation

An administrator can only enable users for groups for which he has the rights
himself.
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4.5.4.1.3Message Control

Configuration for Message Control.

Create new user ﬂ

User | Change password Message Conirol | Authorization levels | User groups

OK
[[1 Message Control user
Cancel
Telephone
Cell phone
E-mail

Substitute person
PIN code

NA code

Message Control User Active: The user is used by the module Message Control.

Telephone Number of the voice-compatible telephone device of the user.
Used for text to speech.

Enter numbers. In addition, the following are permitted:

» The prefix + as an abbreviation for 00 of the international
area code is permitted.

» The following separators are also permitted in AD user
administration: Minus (-), slash (/) and space
Note: When communicating between AD and Message
Control, separators are ignored as soon as the data from
the AD is mapped to a zenon object.

Cell phone Cellphone number of the user. Used for messages via GSM and
SMS (text messages).

Enter numbers. In addition, the following are permitted:

» The prefix + as an abbreviation for 00 of the international
area code is permitted.
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» The following separators are also permitted in AD user
administration: Minus (-), slash (/) and space
Note: When communicating between AD and Message
Control, separators are ignored as soon as the data from
the AD is mapped to a zenon object.

Email E-mail address of the user

Substitute person If a user has not been reached or they do not accept the
message, a substitute person can be given. Click the ... button and
the dialog (on page 25) opens to select an user. Only users who
have been activated as Message Control users are offered for
selection.

PIN code PIN code with which the user confirms the receipt of the message.
The code consists of a four-digit number between 0000 and 9999.

NA code PIN code with which the user rejects the receipt of the message
(not available). The message is then sent to the next user in the
list.

If there is no other user entered in the list, the message is entered
as "not successfully acknowledged". The function assigned to this is
executed. In addition, a "rejected by" CEL entry is created in each
case.

The code consists of a four-digit number between 0000 and 9999.

Note: You can find further information on the assignment of
functions in the Confirmation of receipt - confirmation of receipt
settings chapter.

CLOSE DIALOG

N T

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.
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A Attention

The acknowledgment codes for PIN (confirmation) and NA (rejection) must differ
and should not be too similar.

If both codes are identical the code is interpreted as PIN and therefore as
confirmation of the message.

If an unknown code is received, a SMS and e--mail is sent to the substitute
person. The error message is played back for voice messages.

4.5.41.4 Authorization levels

Assignment of authorization levels to a user. 128 authorization levels (from 0 127) are available.

DIALOG AUTHORIZATION LEVEL

Create new user ﬂ

User | Change password Message Control Authorization levels | User groups

Available authorization levels Selected authorization levels OK
Num Name = Num Name
3 1 0 0 Cancel
10 10
11 11
12 12
13 13
14 14
15 15
16 16
17 17
18 18
19 19
20 20
21 21
2 2
23 23
24 24
25 25
26 26 5
< >
Available authorization levels List of all available authorizations.
Selected authorization levels List of assigned authorizations.
Button double arrow to the right Entries selected in the list Available authorization levels
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are added to list Selected authorization levels.

Button double arrow to the left Selected entries in list Selected authorization levels are
removed from the list.

Note: Each desired level must be assigned and dedicated to that. A selected level closes neither the
one above nor following levels.

CLOSE DIALOG

[ === R

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
4.5.4.1.5User groups

Assignment of user groups.

Note: You can only assign user groups that you have yourself.

Create new user ﬂ

User | Change password Message Control = Authorization levels User groups

Available user groups Selected user groups OK
Name Name
71 Cancel
Z4
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Available user groups List of all available user groups.
Selected user groups List of assigned user groups.
Button double arrow to the right Entries selected in the list Available user groups are

added to list Selected user groups.

Button double arrow to the left Selected entries in list Selected user groups are removed
from the list.

CLOSE DIALOG

e === R

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.

4.5.4.1.6Issue function authorizations

Issue of function authorizations to authorization levels.
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Note: You can only issue function authorizations that you have yourself directly or as a member of a
user group.

Change function authorization ﬂ
Function authorizations Runtime
Function Authonzation level ) 1 oK
Ackn. alarm via alarm status line/context menu
Cancel

Acknowledge alarm via function

Acknowledge alarm via screen Alarm Message List

Batch Control Control recipe - create, rename, duplicate

Batch Control: Control recipe - delete

Batch Control: Control recipe - edit phase

Batch Control: Control recipe (execution) - abort recipe

Batch Control: Control recipe (execution) - execute, jump singl..
Batch Control: Control recipe (execution) - exit phase

Batch Control: Control recipe (execution) - hold phase

Batch Control: Control recipe (execution) - hold recipe

Batch Control: Control recipe (execution) - pause phase

Batch Control: Control recipe (execution) - pause recipe

Batch Control: Control recipe (execution) - restart phase

Batch Control: Control recipe (execution) - restart recipe

Batch Control: Control recipe (execution) - resume phase
Batch Control: Control recipe (execution) - resume recipe
Batch Control: Control recipe (execution) - skip active condition
Batch Control: Control recipe (execution) - start recipe

Batch Control: Control recipe (execution) - stop recipe

Batch Control: Control recipe (execution) - switch execution m...
Batch Control: Master recipe - create, edit, rename, duplicate, ..
Batch Control. Master recipe - delete

Batch Control: Master recipe - highlight as outdated

Batch Control: Master recipe - release

Batch Control: Master recipe - Switch between test mode and
Batch Control: Master recipe (test mode) - abort recipe

Batch Control: Master recipe (test mode) - continue recipe

(=jl=]=]l=j=j====l=l=N=R=R=R=l=l==l====l=N=R=D=0=1=]

List of functions List of existing functions and the assigned authorization
levels.
Change Opens the dialog to assign a new authorization level.

CLOSE DIALOG

I

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.

FUNCTION AUTHORIZATIONS, GENERAL

Edit Extended Trend Curves in Extended Trend can be edited in the
Runtime. The following control elements are not
available if the user does not have authorization:

» Diagram
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Parameter

Return to last screen (PgUp)

Screen switch: Enable "Show this
dialog in Runtime"

Notepad: Open file

Notepad.: Save file

FUNCTION AUTHORIZATIONS FOR

Parameter

Change alarm comment
Enter alarm comment
Confirm alarm acknowledgement

Acknowledge alarm via alarm status
line / context menu

» Curves
» Settings
»  Cursor on/off
P X-axis
Screen 'back’ functions can be executed in Runtime.

The Screen switch function, with the Show this
dialog in Runtime option active, can only be executed
if the user who is logged in meets authorization
requirements.

The function Open file in screen Notepad can only be
carried out if the logged in user has the appropriate
authorization level.

The function save in screenNotepad can only be
carried out if the logged in user has the appropriate
authorization level.

ALARMS

A comment necessary for acknowledgment can be
changed.

A comment necessary for acknowledgment can be
entered.

Alarms can be acknowledged in the Runtime.

Acknowledging an alarm via the alarm status line or
the context menu is only possible if there is an
authorization in the project of the alarm that is
currently displayed.

For multi-project administration: Acknowledging
the system message in the alarm status line or via the
context menu is only possible if there is authorization in
the integration project.

Comment: System messages are messages that
appear in the alarm status line when a certain
(configurable) number of alarms has been reached.
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Acknowledge alarm via screen Acknowledging via Alarm Message List screens is only
Alarm Message List possible with authorization in the project linked to the
variable (multi-project administration).
Note:lf there is no authorization, the flashing is
stopped but the alarm is not acknowledged.

Acknowledge alarm via function Acknowledging via a function is only possible if there is
an authorization for the selected alarms in the
respective projects.

Edit archive Archive data (Archive server) can be amended in the
Runtime.

You can set different authorization groups for each of these acknowledging methods. This allows you,
for example, to configure that a certain user group can only acknowledge via the alarm status line, not
in any other way.

¥ |nfo

Acknowledging an alarm is only possible if there is an authorization for the
selected alarms in the according projects.

FUNCTION AUTHORIZATION BATCH CONTROL

Batch Control: Import Recipes can only be imported as an XML file in the
recipe/operation Batch Control module if the user has the
corresponding rights.

Batch Control: Control recipe - Control recipes in the Batch Control module can only
create, rename, duplicate be created and administered if the user has the
corresponding rights.

Batch Control: Control recipe - edit ~ Settings in control recipes in the Batch Control module

control recipe can only be edited if the user has the corresponding
rights.

Batch Control: Control recipe - Control recipes in the Batch Control module can only

Delete be deleted if the user has the corresponding rights.

Batch Control: Control recipe When executing control recipes in the Batch Control

(execution) - skip active condition module, a phase can only be exited if the user has the

corresponding rights.

Batch Control: Control recipe When executing control recipes in the Batch Control
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Parameter

(execution) - exit phase

Batch Control: Control recipe

(execution) - switch execution mode

Batch Control: Control recipe

(execution) - execute, jump single

steps

Batch Control: Control recipe
(execution) - hold phase

Batch Control: Control recipe
(execution) - resume phase

Batch Control: Control recipe
(execution) - restart phase

Batch Control: Control recipe
(execution) - pause phase

Batch Control: Control recipe
(execution) - abort recipe

Batch Control: Control recipe
(execution) - hold recipe

Batch Control: Control recipe
(execution) - resume recipe

Batch Control: Control recipe
(execution) - restart recipe

Batch Control: Control recipe
(execution) - pause recipe

module, pending conditions can only be skipped if the
user has the corresponding rights.

When executing control recipes in the Batch Control
module, the execution mode can only be switched if
the user has the corresponding rights.

When executing control recipes in the Batch Control
module, the execution of individual steps can only be
skipped if the user has the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be stopped if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be continued if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be restarted if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a phase can only be paused if the user has the
corresponding rights.

When executing control recipes in the Batch Control
module, execution of the recipe can only be aborted if
the user has the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be stopped if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be continued if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be restarted if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be paused if the user has the
corresponding rights.
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Parameter

Batch Control: Control recipe
(execution) - start recipe

Batch Control: Control recipe
(execution) - stop recipe

Batch Control: Operation: create,
edit, rename, duplicate, save

Batch Control: Operation: release

Batch Control: Operation: delete

Batch Control: Master recipe -
highlight as outdated

Batch Control: Master recipe -
create, edit, rename, duplicate, save

Batch Control: Master recipe -
release

Batch Control: Master recipe -
Delete

Batch Control: Master recipe -
Switch between test mode and edit
mode

Batch Control: Master recipe (test
mode) - skip active condition

Batch Control: Master recipe (test
mode) - escape phase

Batch Control: Master recipe (test
mode) - switch execution mode

When executing control recipes in the Batch Control
module, a recipe can only be restarted if the user has
the corresponding rights.

When executing control recipes in the Batch Control
module, a recipe can only be stopped if the user has
the corresponding rights.

Operations in the Batch Control module can only be
created, edited or administered if the user has the
corresponding rights.

Operations in the Batch Control module can only be
approved if the user has the corresponding rights.

Operations in the Batch Control module can only be
deleted if the user has the corresponding rights.

Master recipes in the Batch Control module can only
be marked as obsolete if the user has the
corresponding rights.

Master recipes in the Batch Control module can only
be created and administered if the user has the
corresponding rights.

Master recipes in the Batch Control module can only
be approved if the user has the corresponding rights.

Master recipes in the Batch Control module can only
be deleted if the user has the corresponding rights.

Switching between test mode and editing mode is only

possible for master recipes in the Batch Control
module if the user has the corresponding rights

In test mode, with master recipes in the Batch Control
module, it is only possible to skip a pending condition
if the user has the corresponding rights.

In test mode, with master recipes in the Batch Control
module, it is only possible to exit a phase if the user
has the corresponding rights.

In test mode, with master recipes in the Batch Control
module, the execution mode can only be switched if
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Parameter

Batch Control: Master recipe (test
mode) - execute, jump single step

Batch Control: Master recipe (test
mode) - hold phase

Batch Control: Master recipe (test
mode) - edit phase

Batch Control: Master recipe (test
mode) - resume phase

Batch Control: Master recipe (test
mode) - restart phase

Batch Control: Master recipe (test
mode) - pause phase

Batch Control: Master recipe (test
mode) - abort recipe

Batch Control: Master recipe (test
mode) - hold recipe

Batch Control: Master recipe (test
mode) - continue recipe

Batch Control: Master recipe (test
mode) - restart recipe

Batch Control: Master recipe (test
mode) - pause recipe

the user has the corresponding rights.

In test mode, with master recipes in the Batch Control
module, it is only possible to skip the execution of
individual steps if the user has the corresponding
rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be stopped if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be edited if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be continued if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be started if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a phase can only be paused if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be aborted if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be held if the user has the
corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be continued if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be continued if the user has
the corresponding rights.

In test mode, with master recipes in the Batch Control
module, a recipe can only be paused if the user has the
corresponding rights.
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Batch Control: Master recipe (test In test mode, with master recipes in the Batch Control
mode) - start recipe module, a recipe can only be started if the user has the
corresponding rights.

Batch Control: Master recipe (test In test mode, with master recipes in the Batch Control
mode) - stop recipe module, a recipe can only be stopped if the user has
the corresponding rights.

COMMAND SEQUENCER FUNCTION AUTHORIZATIONS:

Command Sequencer: Cancel When executing command sequences in the

execution Command Sequencer module, execution of the recipe
can only be aborted if the user has the corresponding
rights.

Command Sequencer: Continue In the Command Sequencer module, a paused

execution command sequence can only be continued if the user

has the corresponding rights.

Command Sequencer: Pause In the Command Sequencer module, a corresponding
execution command sequence can only be paused if the user has
the corresponding rights.

Command Sequencer: Start Starting a command sequence in the Command
execution Sequencer module is only possible if the user has the
corresponding rights.

Command Sequencer: Switch When executing command sequences in the

execution mode Command Sequencer module, individual steps can
only be executed or the execution of individual steps
can only be skipped if the user has the corresponding

rights.
Command Sequencer: Execute, When executing command sequences in the
Jjump single steps Command Sequencer module, individual steps can

only be executed or the execution of individual steps
can only be skipped if the user has the corresponding
rights.

Command Sequencer: Create, edit, ~ The administration of command sequences in the

rename, duplicate, save Command Sequencer module - for example creation,
changing, editing, duplicating and saving - can only be
configured if the user has the corresponding rights.
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Command Sequencer: Delete In the Command Sequencer module, configured
command sequences can only be deleted if the user
has the corresponding rights.

Command Sequencer: Import Command sequences can only be imported as an XML
command sequences file in the Command Sequencer module if the user has
the corresponding rights.

Command Sequencer: Switching Switching modes (edit mode and execution mode) is
between execution and edit mode only possible in the Command Sequencer module if
the user has the corresponding rights.

FUNCTION AUTHORIZATIONS FOR SHIFT MANAGEMENT:

Shift Management: create, edit or When configuring shifts in the Shift Management

delete shift module in the Runtime, a shift can only be created,
edited or deleted if the user has the corresponding
permissions.

Shift Management: create, edit or When configuring shift models in the Shift

delete shift model Management module in the Runtime, a shift can only
be created, edited or deleted if the user has the
corresponding permissions.
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4.5.4.2User group

User groups are configured in this tab.

User administration ﬂ

User | User groups

OK
Mame

a Cancel
72

73
74
75

List of user groups Lists all configured user groups.

New Opens the dialog (on page 95) to create and amend new
user groups.

Change Opens the dialog (on page 95) to create and amend new
user groups.

Delete Deletes the selected user group after confirmation.

CLOSE DIALOG

I

OK Applies settings and closes the dialog.

Cancel Discards all changes and closes the dialog.

ADMINISTER USER GROUPS

To administer a user group:
1. Highlight the user group in the list.

2. Select the desired action by clicking on one of the buttons.
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4.5.4.2.1User group

Creation of a new user group.

Create new user group [ x |

User group | Authorization levels
OK

Cancel

Name

Name Name of the new user group

Attention: @ is not a valid character for a user group.

CLOSE DIALOG

I

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.
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4.5.4.2.2 Authorization levels

Assignment of authorization levels to a user. 128 authorization levels (from 0 127) are available.

Create new user group ﬂ
User group Authorization levels
Available authorization levels Selected authorization levels OK
Num Name = Num Name C |
1 1 0 0 ance
10 10
11 11
12 12
13 13
14 14
15 15
16 16
17 17
18 18
19 19
20 20
21 21
22 22
23 23
24 24
25 25
26 26 5
~ e i
Parameter Description
Available authorization levels List of all available authorizations
Selected authorization levels List of assigned authorizations
Button double arrow to the right Entries selected in the list Available authorization levels
are added to list Selected authorization levels.
Button double arrow to the left Selected entries in list Selected authorization levels are

removed from the list.
Note: Each desired level must be assigned and dedicated to that. A selected level closes neither the

one above nor following levels.

CLOSE DIALOG

o N = TR

OK Applies all changes in all tabs and closes the dialog.

Cancel Discards all changes in all tabs and closes the dialog.
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4.5.5 Change password
When this function is used, the user who is logged in can change their current password in the Runtime.
For system-internal users no changes are possible.

Note that different conditions are applicable for the password length:

» Local users: a maximum password length of 20 characters is permitted

» AD users: a maximum password length of 255 characters is permitted

A dialog to change the password is called up in the Runtime.

Change password

Change password

O passward

New password

Cancel

Confirm password

Required inputs:

Old password Enter current password.

New password Enter new password.

Confirm password Enter new password again.

oK Accepts the new password and

closes the dialog.
Cancel Cancels the process.

If no password has been assigned to the user, he can define it, the first time he executes the function in
the Runtime. In this case, no old password is asked for in the dialog.

4.6 Password protection for dynamic elements

All dynamic screen elements that either allow a function execution or the Write set value function can be
linked to an authorization group in the Runtime.

1. Create a dynamic element. E.g. a text button.
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Now all configurable properties for this dynamic element will be displayed in the property

window.

2. Go to the authorization level property in the the properties in the Authorization group.

You can set the authorization level necessary to execute the function with the drop-down list.

Note: With dynamic elements for which the setting of values should be secured, you must first link a
variable using the properties window and activating the Write set value property before the
authorization level can be set.

e W g I e T = =i

B

----- ) Representation

I Visibility/flashing

..... ) General

..... ) Positicn

-2 Size and rotation dynz
#- Runtime

----- [ Authorization

-2y VBA macros

----- ) Write set value

----- ) Variable/function

< >

”~

w

Authorization
[1 Signature necessary

Signature text:

Signature text editable: Apply project settings Authorization level: |0 ~ |

Interlocking: <Unused=> v|

4.7 Apply changes in the Editor in the Runtime

Not all changes to the user administration are accepted in the Runtime after a reload. Note most of all:

THE MAXIMUM NUMBER OF INCORRECT PASSWORD INPUTS

If you change the default setting for the maximum number of erroneous attempts for entering a
password in the Editor, this change is only effective once Runtime is restarted. Reloading alone is not
sufficient, because otherwise as many attempts at entering a password as desired would be possible.
You change the value at: Project properties -> User Administration -> Max. user error

CHANGES TO USER GROUPS AND AUTHORIZATIONS

If user groups are added or removed or authorizations are changed in the Editor, these changes are not
accepted in the Runtime for users that are logged in on reloading. In order for these changes to be
effective, users who are logged in must log out of the system and log in again. This also applies to use

by Active Directory users.
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5 External user administration with Microsoft Active
Directory

With zenon, you can also use Microsoft Active Directory for user administration:

In order to be able to use AD and AD LDS for logging in to zenon Runtime, the zenon project property
User Administration/Access to Active Directory must be configured.

» AD: Yes must be selected for the property and the computer must be in the domain.

» AD LDS: ADAM/AD LDS must be selected for the property.
The properties AD LDS connection, AD LDS user name and AD LDS password correctly
configured.

» AD LDS must be prepared accordingly.

Note: ADAM is not supported.

GENERAL RULES

The following is applicable for the administration of zenon users in the Active Directory (on page 197):

»  Users from the Active Directory do not automatically get administrator rights in zenon.
These can however be issued in the Runtime using an Active Directory user administration
screen (on page 198).

Attention: These rights are applicable globally regardless of the project, i.e. for all other
zenon projects too.

»  Users from the Active Directory cannot load or edit any projects in the Editor.

Attention: zenon does not support any fine-grained password guidelines.
For example, the automatic unblocking of blocked user accounts is not supported.

USER RIGHTS FOR AD USERS

The rights that an Active Director user gets in the Runtime depend on the type of login and how they
belong to user groups:

» Login with Domain Controller contactable:
The user can get user authorizations via:

» an Active Directory Schema Extension (on page 123)

» an Active Directory user group description with special syntax to which the user belongs
» an Active Directory user attribute groupMembershipSAM
»

A local zenon user group that corresponds to an AD user group to which the user belongs
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» Login with cached login information:
If a user with cached login information logs in, because the Domain Controller cannot be
contacted, they then get the rights of the zenon user group that has been configured for the
login with cached login information (on page 79).

A Attention

Rights that are issued in zenon are applicable for the respective project or the
workspace. Permissions that are issued in the Active Directory are applicable
globally.

If rights have been issued to users or user groups of the Active Directory, then
the rights for these users are applicable in all zenon projects!

5.1 Active Directory (AD)

Active Directory can be used in zenon for login and for user administration in zenon Runtime. For the
zenon Editor AD is not available.

¥ |Information

Active Directory and AD LDS, as well as ADAM (for Windows XP), are not
available under Windows CE.

USE OF AD IN ZENON

The active directory can be used for three types of zenon:

1. The name of the authorization group in zenon user administration corresponds to the of the
group names of a user group in Active Directory: Automatic assignment of the Active Directory
user to zenon authorization group. All AD group users receive user rights that are defined in
the zenon authorization group. See User groups in zenon and groups in Active Directory have
the same name (on page 123)

2. Inthe description of the Active Directory group, the zenon authorization levels and the project
are stored in a certain syntax. All users of the group receive the user rights stored in the AD
group in zenon. See Assignment of an Active Directory user to zenon authorization levels (on
page 120)

3. The Active Directory schema is expanded by fields in which the zenon authorization levels are
saved. This requires an Active Directory extension schema. However this is not suitable for use
in an FDA 21 CFR Part 11 regulated environment. See: Active Directory extension schema (on
page 123).
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¥ |nformation

When checking the password in zenon, the Active Directory Max. password
age property is also checked.

5.1.1 General

In order to be able to use the users of the Active Directory (hereinafter called AD) in zenon, a domain
based on a Windows server operating system is required. In order to be able to administer user in the
Active Directory, the server has to be a DNS server.

So a domain controller with DNS and Active Directory has to be available to be able to use these user
accounts as users of zenon on a PC in the domain.

Access to the users of the Active Directory has to be activated in the properties of the project.

Basic knowledge about the Active Directory and the Windows server technology is assumed.

A Attention

If login is via Active Directory, all computers without exception must have access
to the Active Directory. This also applies to clients and zenon Web Clients.

Background: A client is logged in directly from the client to the Active
Directory. The zenon Runtime server is not involved in this.
An Active Directory user can therefore only be logged on if a client:

» Is a member of the domain
and

» has access to the domain

5.1.2 Setting the zenon authorization levels in Active Directory

Windows users can be assigned authorization levels for zenon in the Active Directory. These are set in
the description field of a user group.

In order to allocate a user zenon authorization levels:
1. Create a domain group that is used for authorization levels in zenon.
2. Assign the user to this domain group.

3. Link the domain group to the domain for zenon users.
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4

Note

. Assign the authorization levels in the domain group.

To do this: Enter the authorization levels in the Description option.
P Syntax: [free text] ##[group description=HEX number]##
»  Free text: Optional text to identify the group.

»  Group name: zenon authorization levels in HEX format.
The group description is introduced and concluded by ##.

grp12 Properties ? *

General Members Member Of  Managed By

i gpl2
=)
Group name (pre-Windows 2000): o 12]

Description: [Viewers (1) and Operators (2J##GRP=3-0-0-014% |

E-mail: | |

Group scope Group type

(® Domain local (®) Securty
Global (O Distribution

() Universal

MNotes:

A group for Viewers and Operators

Cancel Apply

: A user can belong to several groups. In this case, they get the sum of the authorization levels of

all groups.

Procedure when logging in to zenon:

4
4
4

»

Note

The information about the users is read.
Whether the user is present in zenon is established.

If they are not found in zenon, a check is carried out to see whether the user belongs to an
appropriate domain group.

The group description in the AD domain is read.

Whether corresponding authorization levels for the domain user in zenon Runtime have been
defined is established.

The domain user is assigned the defined authorization levels.

2 If a user exists in neither zenon nor in the AD domain, the user is not logged in. If the user does

not exist in AD, but has no valid authorization levels assigned, they are logged in with the authorization
level 0. An entry in the CEL is created in both cases.
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ZENON AUTHORIZATION LEVELS AS A HEX NUMBER

The authorization levels are assigned in binary format. This is shown in hex format in the description of
the AD group for greater readability. The HEX number has 32 digits and is subdivided into four groups.
These are each separated by a hyphen. Not all 32 digits need to be given. Missing digits are interpreted
as 0.

Examples:
#H#GRP=7## 01,2 7 hexadecimal equals 111 as binary

number.

For each 1in the binary number,
the corresponding authorization
level is set.

» The bit on the far right
stands for the authorization
level 0.

» The bit in the middle stands
for the authorization level 7.

» The bit to the left of this
stands for authorization level
2.

##GRP=FFFFFFFF-FFFFFFFF-FFFF  Oto 127
FFFF-FFFFFFFF#

EXAMPLE OF AUTHORIZATION LEVELS IN ACTIVE DIRECTORY

Configuration:
» Inthe Active Directory, there is a domain user called user_grp12.
»  This user is a member of the domain group grp12.
» The domain group grp12 is a member of the domain for zenon.
»

The following is entered in the description of the domain group: Viewers (1) and Operators
C)#H#GRP=3-0-0-0##.

Procedure in the Runtime:
»  The user user_grp12 is logged into zenon.
P Itis established that they belong to the grp12 domain group.

»  The description of the domain group is read.

122 | 224



» The authorization levels are read from the entry.

» The user is assigned the authorization levels O, 7.

5.1.3 The same user groups in zenon and in Active Directory

The following applies for users in zenon and in Active Directory:
» Ifauserisinthe AD, but notin zenon, then:
» The user groups are checked in zenon
» The group authorization levels to which the user belongs, are allocated to the AD user
» If a user exists in both AD and in zenon and the user logs into Runtime, then:
» The local zenon user has priority over the AD user

» If no authorization levels are checked in AD, because the local user is logged in

5.1.4 Active Directory extension scheme

Note: This expansion should not be used in an FDA 21 CFR Part11 regulated environment. For FDA 21
CFR Part 11 compliant user administration, use either the User groups in zenon and groups in the Active
Directory (on page 123) method or Allocation of an Active Directory user to zenon authorization levels
(on page 120).

¥ |nformation

Active Directory and AD LDS, as well as ADAM (for Windows XP), are not
available under Windows CE.

5.1.4.1 Installation of the schema extension

In order for the users in AD to also be able to be assigned the 128 authorization levels of zenon, the AD
schema must be supplemented with these entries (4 integer values).

For this purpose, two files (zenonUserLevel.exe and zAD_UserDlg.exe) are copied to the server (ideally to
their own folder). As soon as the setup (zenonUserLevel.exe) has been started, this folder and the files
contained therein must no longer be renamed or deleted.
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4 Attention

You can find the two files zenonUserLevel.exe and zAD_UserDIg.exe on the zenon
installation medium in the /Software/zenonUserLevel/ folder

<\ |D:\AD_Users\zenOnUserLevel.exe M[=] B3

Adding Active Directory Attributes...

vel2 zenOnUserLevel3 zenOnUserLeveld added
UserDlg.exe
ser—Adninistration menu <(zenOnUserLevel)

A reference to the ZAD_UserDlg.exe file is stored in the AD schema.

Furthermore, 4 integer values (zenonUserLevell, zenonUserLevel?, zenonUserLevel3, zenonUserLevel4)
are added to the AD schema.

¥ |Information

Only a user from the Schema administrators group can make these changes!
The domain administrator normally has these rights.

5.1.4.2 Granting user rights

After the successful extension of the schema the authorization levels can be granted to the single users.
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For this purpose, the Microsoft Management Console (MMC) with the Active Directory Users and

Computers plug-in is opened.

“fa Console1 - [Console Root\Active Directory Users and Computers [cdsrv815.test.copadata.local]\test.cop... =] E3
) Fle Action View Favortes Window Hep =18 x|
- . 5 ~
s AE e XEFIB R BB vYEE ,
] Consale Root Name T ion
= é Active Directory Users and Computer
"‘i :—l Saved Queries € test user2 User
= t‘j_’ FF“;::':‘”&"'“‘ € test users User
i :I' CO'm':ute's € test users User
) (&) Domain Controllers g :’:: “”’E i”'
(] ForeignSecurityPrincipals retny i
(2) TEST_USERS € test user7 User
& \agE: € test users User
« @ ADSI Edit ﬂ test user9 User
|| — 3|
| I [
| |

A context menu is opened by clicking on the desired user with the right mouse button. A new menu

item is visible in the context menu: zenonUserLevel.

Tﬂ Consolel - [Console Root'\Active Directory Users and Computers [cdsrv815.test.copadata.ocal]\test.cop.. =] E3

[Bide ko Ven Fioks hiw b |t
¢~ OB B XFIR R 0RBVLE
] Console Root Name [ Type Description |
=) 6 Active Directory Users and Computer .
[’? ] Saved Queries €3 test user2 e
B2 5‘? Ses!.copadata.bcal g test user3 User Copy...
: j ?:r:;xers € test userd User A_ddtoagup...
o (2] Domain Controllers ﬁ festseeS Lisee R P, d.
s (] ForeignSecurityPrincipals € test users User SRl
() TEST_USERS €3 test user? User  Move...
& Usere: € test users user  Qpen Home Page
! < ADSI Edit € test users User  SendMal
Al Tasks »
Cut
Delete
Rename
—Pioperties
Help
K | 3|
lazenOnUserLevel [

In this context menu, the zenonUserLevel entry has to be selected, so that the administration tool

(zAD_UserDlg.exe) for the selected user is opened.
¥ Information

The authorization levels for zenon can only be granted directly to the user,
groups and organization units are not supported.
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o e 1
lLDAP://cdsrv31 5 test.copadata local/CN=test user1 OU=TEST_USERS DC=test, DC=copadata DC=local
Last Name: [M— First Name: [M—
User Level 0 - 31 User Level 32 - 63 User Level 64 - 95 User Level 96 - 127
1 B B B H
Vo [~ 186 | (i3 [~ 48 [~ B4 [~ 80 [~ 96 | Et2
o | IE | [iss [~ 49 [~ 85 [~ 81 [~ 97 | EtiE
2 [~ 18 [~ 34 [~ 50 [~ 86 [~ 82 [~ 98 [~ 114
| 1Fd [~ 19 | [E55 | [iat [~ 67 [~ 83 [~ 99 | EtS
4 [~ 20 [~ 36 | 2 [~ 88 T [~ 100 [~ 116
| k5 21 [~ 37 | [i5s [~ 89 [~ 85 [~ 1m | T
"6 [~ 22 [~ 38 [~ 54 [~ 70 [~ 86 [~ 102 [~ 118
|k | |E2s [~ 39 | [i55 7 [~ 87 [~ 103 [~ 119
8 [~ 24 [ 40 [~ 56 [~ 72 [~ 88 [~ 104 [~ 120
[Ca | [E25 ™ #1 | i | IkFa [~ 89 [~ 105 121
[~ 10 [~ 26 [~ 42 [~ 58 [~ 74 [~ 90 [~ 106 |22
| IEtd [~ 27 [~ 43 [~ 59 [~ 75 [~ 9 [~ 107 [~ 123
[~ 12 [~ 28 [ 44 [~ B0 [~ 76 [~ 92 [~ 108 [~ 124
{8 [~ 29 [~ 45 [~ 81 [ 77 [~ 93 [~ 109 | EEs
[~ 14 [~ 30 [~ 46 [~ 62 [~ 78 [~ 94 [~ 110 [~ 126
§ 5 § it I~ 47 [~ 83 =79 [~ 95 | [~ 127
Select |  Select | Select | Select |  Select |  Select |  Select Select |
Clear l Clear l Clear l Clear l Clear l Clear l Clear Clear l
Save Cancel
Logging:
Given LDAP Parameter:
"LDAP: jicdsrv815 test copadata local/CN=test user1 OU=TEST_USERS DC=test DC=copadata DC=local" user

Up to 128 authorization levels per user can be defined with the help of the administration tool.
* Information

As a default, the authorization level 0 is granted to each user; this cannot be
deactivated in the administration tool.

This level corresponds to the SYSTEM user of zenon.
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5.1.4.2.1 Description of the administration tool

i eeroircerivenseess e e
ILDAP://cdsrv31 5 test.copadata local/CN=test user1 OU=TEST_USERS DC=test, DC=copadata DC=local
Last Name: [M— First Name:
User Level 0 - 31 User Level 32 - 63 User Level 64 - 95 User Level 96 - 127
1164595839 ﬂ 65535 ﬂ 65536 ﬂ 1431655765 ﬂ
v o i v 32 [~ 48 [~ 64 v 80 v 96 v 112
v 1 v 17 v 33 [~ 49 [~ 65 v 81 [~ a7 [ Ed8
v 2 | EE v 34 {50 [~ 66 v 82 v 98 v 114
v 3 v 19 v 35 [ 1§51 [~ 67 v 83 [~ 99 [ Eds
v 4 [~ 20 v 36 | 52 [~ 68 v 84 v 100 v 116
v 5 v 21 v 37 | [i55 [~ 69 v 85 [~ 101 | Eay
v 6 v 22 v 38 [~ 54 [~ 70 v 86 v 102 v 118
[ { 229 v 39 | [i55 [ v &7 [~ 103 [~ 118
{ g8 v 24 v 40 | [i55] [ 52 v 88 v 104 v 120
v g | 25 v # | i i v 89 [~ 105 [~ 121
{ R v 26 v 42 | [i58) [~ 74 v 90 v 108 v 122
{ [ 2% v 43 [~ 59 [ s v a1 [~ 107 [ E23
v 12 [~ 28 v 44 [~ 60 [~ 76 v 92 v 108 v 124
{ B [~ 29 v 45 { 1§61 [ B v 93 [~ 108 [ E2s
v 14 v 30 v 46 | 562 [~ 78 v 94 v 110 v 126
| S [ 1§51 v 47 [~ 63 [~ 79 v 95 [ Edd [~ 127
Select |  Select | Select | Select | Select |  Select |  Select |  Select |
Clear | Clear I Clear | Clear I Clear | Clear I Clear | Clear |
Cancel | OK |
Logging:
Given LDAP Parameter:
"LDAP: jicdsrv815 test copadata local/CN=test user1 OU=TEST_USERS DC=test DC=copadata DC=local" user

[first line] LDAP parameter that serves as connection string.
Last name Last name of the selected user.

First Name First name of the selected user.

User Level Four integer values represent 32 authorization levels.

They are inputted by activating or deactivating the checkboxes or
directly inputting into the field.

# Updates display of authorization levels.

Select Activates all checkboxes in a column.

Clear Deactivates all checkboxes in a column.

Save Saves current settings.

Cancel Rejects all changes made since the last save and closes the dialog.
OK Saves all settings and closes dialog.

Logging Displays logging information.
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5.1.5 Schema extension — details

To clarify the whole background, the schema extensions are explained in detail here, so that they can be
checked in the event of problems.

In order to be able to see the details of the AD schema, ADSI Edit has to be installed on the server. This

tool is available as soon as the support tools for the Microsoft Server have been installed.

Then the ADSI Edit plug-in can be opened in the Microsoft Management Console (MMC). Now different

connections can be established.

5.1.6 Schema

The additional attributes can be checked in the schema. These are normally listed at the bottom.

zenonUserLevell - zenonUserLevel4

"1 Console1 - [Console Root\ADSI Edit\Schema [cdsrv815.test.copadata.local]\CN=Schema,CN=Configuration,DC =test,DC=cop... =] E3

%) Ele Action Wew Favarkes Window Heb | =181
s OB XEB (@
2] Consale Root Nome [ Closs | Distinguished Name |
1 < Active Directory Users and Computer | ) C=USN-Last-Obi-Rem sttrbuteSche...  CN=USN-Last-Obj-Rem, CNeSchems, CN=Configuration,
£ <) ADSLEdt [E] CNwUSN-Source atrbuteSche... CNwUSN-Source, CNwSchema, CNConfiguration, DCste
B c“'wmg;’;':;““““ %CN-V&G—A«W buteSche... CN=Vald-Accessas, Chi=Schema, CN=Conf oCe
2B Sdm‘a‘ C 2 .copadatz (%] e " v CN=Cordi jon,DC=test,|
"~ (21 Ch=Schera, Chi=Configurath i]i Yopcar % s g Knbe i
4 [ Domain [cdsrva15.test.copadata R c AT % & shamber-H, ChSchoma, CN=C or'fwm
%cu-wmm{o o Number-Lo, CN=Schems, CN=Confi
[(E] CNwYol-Table-GUID attributeSche...  CNwVok-Table-GUID, CNeSchema, CNConfigur ation, C!
#] CN=Vol-Table-Idx-GUID attrbuteSche...  CNe=Yol-Table-1dx-GUID, CNe=Schema, CN=Configur ation
(4] CN=Vohume h N CN CN=Confi ion, DC=test, <
[E] CNeVolume-Count b CN=Vohume-Court, CNeSchema, CNConf OC=
¥) CN=Whem-Path attributeSche...  CN=Whem-Path, CNeSchema, CN=Configuration,OC=te
(4] CN=Well-known-Objacts attributesche...  CN=Wel-Known-Objects, CN=Schema, CN=Configuratiol
(] cN=When-Changed attributeSche...  C=When-Changed, CNeSchema, CN=Configuration, DC
gCN-when-creatad attributeSche...  CN=When-Created, CNmSchema, CN=Configuration,OCs
Mo A . o AL g I
[E] CN=WwW-Home-Page sttrbuteSche...  CN=WWW-Home-Page, CNe=Schema, CN=Configuration,
%CN-WW-PQQ:-O(M StributeSche...  CN=WWW-Page-Other, CNwSchema, CNmConfiguration,
|¥] CN=X121-Address Atributesche...  CN=X121-Address, CN=Schama, CN=Configuration,DC=
Ea i ttrb h e  CN=Schema, CN=Ci
§] CNwXS09-Cert SttrbuteSche...  CNwXS09-Cert, CNwSchema, CNmConfiguration, DCwtest
|¥] CN=zenOnliserLevell attributeSche...  Ch=zenOnlserLevell,CN=Schema, CN=Configuration,C
[E] CN=zenOnlsert evel2 Strbutesche...  CN=zenOnserlevelz, CNmSchems, CN=Configuration,
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CN=zenOnUserLevel4 Properties

Attribute Editor I Security I

[V Show optional attributes

[~ Show only attributes that have values

(2] x]

Attributes:
Attribute | syntax [ value 4|
adminDescription Unicode String ~ <Not Set>
adminDisplayN ame Unicode String  zenOnUserLeveld
allowedattributes Object Identifier  subSchemaSubEntry;moc
allowedattributesEffe...  Object Identifier  isCriticalSystemObiject;las!
allowedChildClasses Object Identifier  <Not Set>
allowedChildClassesE... Object Identifier  <Not Set>
attributelD Object Identifier  1.3.6.1.4.1.22050.1.4
attributeSecurityGUID  Octet String <Not Set>
attributeSyntax Object Identifier 2.5.5.9
bridgeheadServerList... Distinguished ...  <Not Set>
canonicalName Unicode String  test.copadata.local/Confis
classDisplayName Unicode String ~ <Not Set>
cr|1 Unicode Slr'ru zenOnUserLeveld - ~|
4

Edit |

o]

Cancel | Loply
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5.1.7 Configuration

After the connection to configuration has been defined, the details of the single AD objects can be
checked and edited. In this case, only the object user-display in the single 'DisplaySpecifiers' is of
interest, because here the link between user object and AdministrationTool is established.

"1 Console1 - [Console Root\ADSI Edit\Configuration [cdsrv815.test.copadatalocal]\CN=Configuration,DC =test,DC =copadata,D... [[=] E3

(%) Bl Adtion Yew Fovakes Widow Heb | =181 x|
e~ OB XEE @
) <5 ADSIEdt ] [ame [ Class | Distinguished Name -
- Configuration [cdsrvB1S.tek. &) CNevolume-Display displaySpeciier  CNemvohume-Display, CN=409, CN=DisplaySpecifiers, N
(] CN=Configuration,DCmte displaySpecifier  CNwuser-Display, CNw409,CNwDisplay o,

22 chvmDisgh

CN=trustedDomain-Display, CN=409, CN=DisplaySpecific

(] CN=sub -Display J fier  CN=subnetContaner-Display, CN=409,CN=DisplaySpeci
() CNesubnet-Display N Display, CNw409, CNwD ifiers, CNe
% CNe=skesContainer-Display displaySpecifier  CN=sitesContainer-Display, CN=409, CN=DisplaySpecifie
[¥] C=seLinkBridge-Displsy displaySpecfier  CN=skelinkEridge-Display, CN=409, CN=DisplaySpecifier
[(E] CNeskeLink-Display displaySpecifier  Chwsielink-Display, CNw409, CN=Display Spectiers, CNe
%CN-Q:»IXM displaySpecifier  Chmsite-Display, CN=409, CN=DisplaySpeciers, CN=Cor
(M) CN=servic Poin... = Display, CN=409,CN=Dis
(] CNese tainer-Display ™ ontainer-Display, CNe409, CNwDisplaySpec
¥ | CNeserver-Display displaySpecifier (N-s«mﬂsohy,CN-ﬂD?,CN-DsplaySped\e«s,CN-:_
[¥] CN=rpeContainer-Display CN=tpcC Display, CN=409, CN=Displ #i
Ea vicePoi... fier  CN Display, CN=409,CNe=D
% CNe=queryPolicy-Display displaySpeciier  CNequeryPolicy-Display, Chm409, CN=DisplaySpecifiers,
[¥] CN=printQueus-Display dsplaySpeciier  Ch=prinkQuaue-Display, CN=409, CN=DisplaySpechiers,
[¥] CNepKICertf late-Di... fier  CN=pKIC Display, CN=409,CN=Displa
&) Jeit-Display J fiee O\ rk-Display, CN=409, CNDisplaySpe
(%] CN=nTF Display Ch=nTF Display, CN=403, CN=DisplaySg
(] CN=nTF ber-Display fier CNen bscriber-Display, CN=409, CN=DisplaySpec
8] CNewnT Display J fier  CN Display, CN=409, CNwDisplaySpecific
(%] CN=nTF Display CN=nTF Display, CN=409,CN=DisplaySpec
[(E] CNenTF Display fier  CNen Display, CN=409, CN=DisplaySpexifie
3] CNenTOD! Display  displ fier  CNwnTD Display, CN=409,C!
%cmwtm-my ClNe= Display, CN=409,C)
"q A TNES ariea.Nienl s Acelminarfiar  CAmaTNGCanicarienlsm in-‘m Nmiend ../:M:]_'J
4 »
'
user-Display Properties ﬂ m

Attribute Editor I Secu[i!yl

V' Show mandatory attributes
¥ Show gptional attributes

I~ Show only attributes that have values
Attributes:
Attribute

U ing
adminD escription Unicode String ~ <Not Set>
adminDisplayName Unicode String ~ <Not Set>
adminMultiselectProp...  Unicode Sting  1,{50d30564-9311-11d1-t
adminPropertyPages Unicode String ~ 9{FA3E1D55-16DF-446d
allowedattributes Object Identifier  subSchemaSubEntry;moc
allowedattributesEffe...  Object Identifier  isCriticalSystemObject;uS|
allowedChildClasses Object Identifier  <Not Set>
allowedChildClassesE... Object Identifier  <Not Set>
attributeDisplayNames  Unicode Sting  wwWHomePage, Web P.
bridgeheadServerList... Distinguished ...  <Not Set>

canonicalName Unicode String  test.copadata.local/Confis =

classDisplavName Unicode Strina  User
i [ »
Edit |

oK I Cancel I Spply |

The properties of the user-Display object only contain attributes with the names adminContextMenu.
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This attribute contains the link to the administration tool (zAD_UserDlg.exe).

Multi-valued String Editor [ X}

Attribute: adminContexttenu

Walue to add:
fi Add
Walues:

AzenDnUserLevel, D:\AD_UsershzaD_UserDlg.exe Bemove
1,{08eb4fab-6ffd-11d1-b0e0-00c04fdBdcab}

< | 2l
0K | Cancel |

This entry can also be amended manually if necessary.

To do this:
1. Select the entry
Press the Remove button

Adapt the parameters

oW

Use Add to add again
The parameter has the following structure:
,name of the menu entry, path of the file zAD_UserDlg.exe
B Example
Example, if the EXE file is in the folder D:\\AD_Users.

,&zenonUserlevel,D./AD_Users/zAD_UserDlg.exe
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5.1.8 Domain

If the connection domain is openen, it looks similar to the MMC with the Plugin Active Directory Users
and Computers. Exactly this information can also be found here, but with more details.

"t Console1 - [Console Root\ADSI Edit\Domain [cdsrvB15.test.copadatalocal]\DC =test,DC=copadata,DC=local\OU=TEST_USER... =] E3

) e Ain View FavarRes Window Help =181 x]
e AR XFRE & [
) Console Root

%1 < Active Directory Users and Computer CNetest user
= ¢fw§l Edt I CNetest user2
® j Configuration [cdsrvB1S.tes2.cof | ) ryoract users

" SERS,DC=test, DC=copadal

CNetest user2,0U=TEST_UISERS,DCwtest,DCwcopadata,C
CN=test user3,0U=TEST_USERS,DC=test,DC=copadata,C
CN=test userd,0U=TEST_USERS,DC=test,DC=copadata,C
CNetest userS,0U=TEST_USERS,DCwtest,DCwcopadata,C
CNetest users, OU=TEST_USERS, DC=test,0C=copadata,C
CN=test user7,0U=TEST_USERS,DC=test,DC=copadata,C
CNetest users, OU=TEST_USERS,DC=test,DCwcopadata,
CNetest userd,OU=TEST_USERS, DC=test,0C=copadata,C

%) 4 Schema [cdsrv815.test.copadate |~
55 Domain [cdsrvB1S.test.copadata jz:::: -
=) (] OCwmtest,DC=copadata, 0C=|
# 1 CNeBuitin I Ch=test users
& &) CNmComputers I CN=test user?
% (1 OU=Domsin Controllers | —J CN=test user8
& () CN=ForeignSecurityPrine | — Ctest userd
+ () CN=LostAndFound
+ ] CN=NTDS Quotas
% (L] CNeProgram Data
= CN=System
=) () OUTEST_USERS
() C=test usert
4 ] CNwtest user2
@ ) CN=test user3
[# L CNe=test userq
% (L) CN=test userS

FISREEREE

@ L CN=test users

50 CNmtest user?

(] Cstest users

# (2] CNetest userd
= (1 CN=Users

L« 2l | |

If you check the properties of a user object and scroll down to the bottom of the list, here you will also
find 4 integer values for the authorization levels.

(|
CN=test user1 Properties ﬂm
Attribute Editor I Security I
V' Show mandatory attributes

[V Show optional attributes

[~ Show only attributes that have values

Attributes:
Attribute l Syntax I Value 3
uSNSource Large Integer/...  <Not Set>
whemPath Unicode Sting ~ <Not Set>
wellKnownObjects DN Binary <Not Set>
whenChanged UTC Coded Ti... 11.05.2005 12:47:23
whenCreated UTC Coded Ti... 11.05.2005 12:36:56
wwWHomePage Unicode Sting ~ <Not Set>
#121Address Numerical String ~ <Not Set>
#500uniqueldentifier Octet String <Not Set>
zenOnUserLevell Integer 1164595839
zenOnUserLevel2 Integer B5535
zenOnUserLevel3 Integer
zenOnlserleveld Integer
< |

Edit I

0K I Cancel Apply

5.2 Active Directory Lightweight Directory Services - AD LDS

Active Directory Lightweight Directory Services (abbreviation: AD LDS) is a simplified version of the
Active Directory (on page 119) and is suitable for use on normal desktop operating systems; it is not
necessary to use a server operating system. LikeAD (on page 119), AD LDS also supports:
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1. The name of the authorization group in zenon user administration corresponds to the of the
group names of a user group in Active Directory: Automatic assignment of the Active Directory
user to zenon authorization group. All AD group users receive user rights that are defined in

the zenon authorization group. See User groups in zenon and groups in Active Directory have
the same name (on page 123)

2. Inthe description of the Active Directory group, the zenon authorization levels and the project
are stored in a certain syntax. All users of the group receive the user rights stored in the AD

group in zenon. See Assignment of an Active Directory user to zenon authorization levels (on
page 120)

You can use AD LDS with:
»  Windows 7 (on page 166)
»  Windows 8 (on page 133)
»  Windows Server 2008 (on page 186)
»  Windows Server 2012 (on page 133)

5.2.1 AD LDS from Windows 8 and from Windows Server 2012

To use AD LDS from Windows 8 or from Windows Server 2012 and zenon:
1. Install AD LDS (on page 133)

Create anew AD LDS instance (on page 137)

Import an AD LDS scheme (on page 142)

Install the Remote Administration for Windows Server (on page 144)

Configure the Active Directory snap-in (on page 145) in order to manage the AD LDS instances

o v~ W N

Define the roles, organization units, users and user groups (on page 149)

Note: The instructions on installation and use of AD LDS sometimes use screenshots with an English
user interface.

5.2.1.1 Installing AD LDS

WINDOWS 8

To install AD LDS under Windows 8:
1. Open Control Panel.

2. Open Programs and Features.
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Select Turn Windows features on or off.

Turn Windows features on or off @

To turn a feature on, select its check box. To turn a feature off, clear its check box. A filled box
means that only part of the feature is turned on.

[#] || Media Features

I:‘_h RIP Listener
I:‘_h Services for NFS

[®] || .NET Framework 3.5 (includes .NET 2.0 and 3.0)
[®] || .NET Framework 4.5 Advanced Services
[Tl Active Directory Lightweight Directory Services
L10 Hyper-v
_L. Internet Explorer 10
I:‘_h Internet Information Services

I:‘_h Internet Information Services Hostable Web Core

[ 1 Microsoft Message Queue (MSMQ) Server
[] | Network Projection

E‘_h Print and Document Services
I:‘_h RAS Connection Manager Administration Kit (CMAK)
[#] || Remote Differential Compression AP| Support

_L. Remote Server Administration Tools

Zenon

Activate the check box in front of Active Directory Lightweight Directory Services.

Click on OK.

WINDOWS SERVER 2012

To install AD LDS under Windows Server 2012:

1.
2.

Go to Manage -> Add Roles and Features.

The wizard is started.

Before You Begin

Server Selection

DESTINATION SERVER

Select installation type Tos. 26N rsremvioca

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployrment.

[pwe] (ET] | oo | (o]

Select Role-based or feature-based installation.
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4. Click on Next.

. . DESTINATION SERVER
Select destination server TobT2EN8 estenuiocs
Bafore You Begin Select a server or a virtual hard disk on which to install roles and features.
() Select a virtual hard disk
Server Roles Server Pool
Features
Filter: | |
Name IP Address Operating System

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

[t | [Ccaneat ]

5. Select a server from the server pool.

6. Click on Next.

IJ—'EI

Select server roles
Bafore You Begin
Installation Type

Server Selection

Features

DESTINATION SERVER
TOR-12EN64 testenvjocal
Select one or more roles to install on the selected server.
Roles Description
. § . [a]  Active Directory Lightweight
L Active Directory Certificate Sevices | Directory Services (AD LDS) provides
[ Active Directory Domain Services a store for application-specific data,

[ Active Directory Federation Services for directory-enabled applications
[ M8 htweight Direct that do not require the infrastructure
tweight Direct of Active Directory Domain Sewv

[ Active Directory Rights Management Services Multiple instances of AD LDS can
[ Application Server exist on a single server, each of
[ owee = which can have its own schema.
[ ONS Server

[ Fax Server

[8] File And Storage Services (Installed)
[ Hyper-v

[ Metwork Policy and Access Services | |
[] Print and Decument Services

[] Remote fccess

[] Remote Desktop Services

W

[ ot | [Ccaneel ]

Zenon

7. Activate the check box in front of Active Directory Lightweight Directory Services for server

roles.
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8. Click on Next.

Add features that are required for Active Directory
Lightweight Directory Services?

You cannot install Active Directory Lightweight Directory Services
unless the following rele services or features are also installed.

4 Remote Server Administration Tools
4 Role Administration Tools
4 AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
[Tocls] AD LDS Snap-Ins and Command-Line Tools

Include management tools (if applicable)

| Add Features| ‘ Cancel

9. Activate the check box for Include management tools.

10. Click on Add Features.

DESTINATION SERVER

Active Directory Lightweight Directory Services (AD LDS) Tos- 126884 tesremvioca

Before You Begin mgmmmmmmkhmnumqmmmmau can use
Active Directory Lightweight Directory Services (AD LDS) as the data store. AD LDS runs as 3 non-
Installation Type operating-system service, and, 35 such, it does not require deployment on 3 domain controller. Running

Server Selection 35 3 non-operating-system service aliows multiple instances of AD LDS to run concurrently on a single
server, and each instance can be configured independently for servicing multiple applications.
Server Roles
Features Things to note:
* After installing AD LDS, instances of AD LDS can be created by launching the AD LDS Setup Wizard
Confirmation from the Advanced Tools section of the AD LDS home page.

* Before removing the AD LDS role, you must use Programs and Features in Control Panel to remove
all previously installed AD LDS instances.

Learn more about AD LDS

e | [ | e

Zenon
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1.

Click on Next.

Confirm installation selections

Before You Begin

To install the following roles, role services, or features on selected server, click Install,

DESTINATION SERVER
TO02-12EN64 testenviocal

Active Directory module for Windows PowerShell
AD LDS Snap-Ins and Command-Line Tools

Export configuration settings
Specify an alternate source path

Installation Type [Vl Restart the destination server automatically if required
Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear
Server Roles hek chack basas:
Features
AD LDS Active Directory Lightweight Directory Services
I
Role Administration Tools
AD DS and AD LDS Teols

Canar ] [Ccance ]

12. Confirm the automatic restart of the server.

5.2.1.2 Create new AD LDS instance

To create a new AD LDS instance:

1.

2.

Welcome to the Active Directory
Lightweight Directory Services
Setup Wizard

This wizard helps you install Microsoft Active Directory
Lightweight Directory Services (AD LDS).

AD LDS is & powerful directory service that is easy to install
and deploy. It provides a dedicated data store for
applications, and can be corfigured and managed
independentty.

To continue, click Next.

In Windows, go to the %ProgramData%\Microsoft\Windows\Start
Menu\Programs\Administrative Tools folder.

Start the Setup Assistant for Active Directory Lightweight Directory Services file.

Zenon

137 | 224



External user administration with Microsoft Active Directory

3.

4.
5.

Click on Next.

Setup Options

An AD LDS instance is created each time AD LDS is installed. %‘5

You can create a unique instance, or you can install a replica of an existing instance.

Select the type of instance you want to install.

(®) A unigue instance
This option automatically creates a new instance of AD LDS that uses the default

configuration and schema partitions. The new instance will not be able to replicate
with existing instances.
() Areplica of an existing instance

This option creates a new instance of AD LDS that uses the configuration and
schema partitions replicated from another instance of AD LDS. You can also select
the application partitions to replicate.

| <Back || Net>

Select unique instance as the installation type.

Click on Next.

The instance name is used to differentiate this instance of AD LDS from other AD %‘5

LDS instances on this computer.

Type a name for this instance. The name should reflect the use for which this instance
of AD LDS is intended.

Instance name:

|Copadata|

Example: Addressbook1
D iption:

|ﬁD LDS instance

The AD LDS service name is created when the instance name is combined with the
product name. i will be displayed in the list of Windows services, together with the
description you enter.

AD LDS service display name:  Copadata
AD LDS service name: ADAM_Copadata

| <Back || Net>

6. Assign an instance name.

Zenon
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7. Click on Next.

Ports § ‘
Computers will connect to this instance of AD LDS using specific ports on all of the =, ™%
IP addresses associated with this computer.

The ports displayed below are the first available for this computer. To change these
ports, type the new port numbers in the text boxes below.

If you plan to install Active Directory Domain Services on this computer, do not use 385
forthe LDAP port or 636 for the S5L port because Active Directory Domain Services
uses these port numbers. Instead, use available port numbers from the following range:
1025-65535.

LDAP port number:
389

S5L port number:
Fx

8. Enter the port number for LDAP and SSL.
Default LDAP: 389
Default SSL: 636
Note: If you change one of the port numbers, this must also be amended in some of the
following steps.

9. Click on Next.

Application Directory Partition § ‘
An application directory partition stores application-specific data. .

Do you want to create an application directory partition for this instance of AD LDS?

(") No, do not create an application directory partition
Select this option if the application that you plan to install creates an application directory
upon installation, or if you plan to create one later.

(®) Yes, create an application directory partition

Select this option if the application that you plan to install does not create an application
directory partition upon installation. A valid partition name is any distinguished name that does
not already exist in this instance. Example distinguished name:
CMN=Partition1,DC=Woodgrove, DC=COM

Partition name:
DC=copadata, DC=com|

| <Back || Net>

10. Activate the option for an application directory partition.

11. Enter Partition name.
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Note: The partition name is used together with the port number and server name in zenon.
In this example, the entry in the corresponding zenon AD LDS connection property would be:
\\w8x64-vm0009.testenv.local:389/DC=copadata, DC=com

Active Directory/ADAM/AD-LDS
Access to Active Directory:  ADAM/AD-LDS
ADAM/AD-LDS connection: (SRS S WU E B WAL e EL ety ADAM/AD-LDS user identification:

ADAM/AD-LDS password:

12. Click on Next in the assistant.

File Locations

You can specify a location for each type of file associated with this instance of AD -
LDs.

Specify the locations to store files associated with AD LDS.

Data files:
C:\Program Files\Microsoft ADAM\Copadata‘data

Data recovery files:
C:\Program Files'\Microsoft ADAM\Copadata“data

13. Enter the save location for data files and restores. (you can leave it at the default setting.)

14. Click on Next.

Service Account Selection r ‘
AD LDS perf perations using the pemissions iated with the accourt .
you select.

Set up AD LDS to perform operations using the pemissions iated with the following
account.

(®) Network service account
AD LDS has the permissions of the default Windows service account.

() This account:
AD LDS service has the permissions of the selected account.

User name: | 5§

Fazsword:

15. Select the authorization levels with which authorization processes are to be carried out.
(Network service account in this example)
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Note: If the computer on which you install AD LDS is not a member of a domain, you receive a
warning message accordingly:
[0/ Drecton Lobtweht Decctory ServiesSctup Wicaed 53

4 Youhave selected a system service account for this Active
4B, Orectoey Ughtweight Drectory Senvices nstance. Because this
computer is not 2 member of a domain, this nstance wll not be
able to repicate data with AD LDS instance on other computers
‘while using this service account.

Do you want to continue?

=l = |

This will not impair the functionality as long as you do not carry out any replications. Confirm
the notice by clicking Yes

16. Click on Next in the assistant.

AD LDS Administrators -~ ‘
[

L

You can specify the user or group that will have administrative privileges for this
instance of AD LDS.

Assign the following user or group of users administrative permissions for AD LDS.

(®) Curmently logged on user: CDot

The user that is installing AD LDS will have administrative permissions for this
instance of AD LDS.

() This account

The selected user or group will have administrative permissions for this instance of
AD LDS. You can choose any user or group from this computer, this computer's
domain, or any domain that is trusted by this computer's domain.

Account name:

17. Enter the user who is to administer AD LDS. The user who is currently logged on is used in this

example.

The user does not need to be a local administrator or domain administrator. A group can also
be given.

But: An individual user must be given in zenon. This can be a member of a group.

The user configured here is used in zenon in the AD LDS user name and AD LDS password
properties:

Active Directory/ADAM/AD-1DS
Access to Active Directory:  ADAM/AD-LDS

ADAM/AD-LDS connection:  \\w8x64-vm0009.testenv.local:389/DC=copadata,DC=com  ADAM/AD-LDS user identification:  co\ot

ADAM/AD-LDS password:  [ITEIITI T IR I ety
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18. Click on Next in the assistant.

Importing LDIF Files -~ ‘
You can import data from Lightweight Directory Interchange Format {LDIF) files into 0.
your AD LDS application directory partition. {

To configure the AD LDS service in a specific way, import one or more of the LDIF files listed
below.

LDIF file name Description
[[]:MS-AdamSyncMetadata LDF ADAMSync jata schema extension. Required for A

[] MS-ADLDS-DisplaySpecifiers.L... AD LDS Display specfiers schema and display specifiers
[] M5-AZMan LDF AD LDS schema extensions for AzMan.
M5-InetOrgPerson. LDF AD LDS inetOrgPerson, user and related classes.
M5-User LDF AD LDS user class and related classes.

MS-UserProsy. LDF AD LDS simple userProxy class.

[ MS-UserProxyFull LDF AD LDS full userProxy class. Requires MS-User LDF or I

<

| <Back || Net>

19. Import the required LFIF files: You need:
» MS-InetOrgPerson.LDF
» MS-User.LDF
» MS-UserProxy.LDF
20. Click on Next.
Ready to Install

The AD LDS Setup Wizard is ready to install AD LDS with the following
configuration.

Before continuing, review and corfimm your selections.

Selections:
Install @ unique instance of AD LDS.

Instance name: Copadata

Computers will connect to this instance of AD LDS using the following ports:
LDAP port: 385

S5L port: 636

AD LDS replication will use Negotiate authertication.

Store AD LDS data files in the following location:

To change your selections, click Back. To install AD LDS, click Mext.

[ |

21. Confirm the configuration by clicking on Next.
The installation is carried out.

22. Close the assistant by clicking on the Finish button

5.2.1.3 Importing an AD LDS schema

To import LD ADS schemas:
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Open the command line.
Navigate to the AD LDS folder: %WINDIR%\ADAM.

Enter the following command and press the Enter key:

Idifde -i -s localhost:389 -¢ CN=Configuration,DC=X #ConfigurationNamingContext -f

MS-adamschemaw?2k8.Idf

Attention: Windows Power Shell: If Windows Power Shell is used for input, the
configuration part must be placed in quotation marks: Idifde -i -s localhost:389 -c

"CN=Configuration,DC=X" "#ConfigurationNamingContext" -f MS-adamschemaw2k8.ldf

Note: If you have configured a dedicated user for the AD LDS partition, you must also enter:

P User
» Domain

P Passwort for Idifde

Syntax: user: ADLDS, domain: T08-12en64, password: password): Idifde -i -s localhost:389 -c
CN=Configuration,DC=X #ConfigurationNamingContext -f MS-adamschemaw2k8.Idf -b ADLDS

T08-12en64 Copadatatl
Quotation marks are needed again for Windows Power Shell.

= Command Prompt - 0O “

.2.92881]

You receive a confirmation once the changes have been made.

= Command Prompt - O “

t:389 -c CH=Configuration.DC=K HConfigurati
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5. Enter the following command and press the Enter key (the rules for dedicated users also apply
here too, as with the previous step):

Idifde -i -s localhost:389 -¢ CN=Configuration,DC=X #ConfigurationNamingContext -f
MS-AdamSyncMetadata.ldf

= Command Prompt - O “

—¢ CH=Configuration, #Conf igurat ij8

Logging in -]
Importing F 1~ Fi SyncHMetadata.ldf"
0 :

sosMWindows~ADAM>

6. You receive a confirmation once it has been successfully carried out.

5.2.1.4 Installing Remote Server administration under Windows 8

Under Windows 8, you must still install the Remote Server administration. To do this:

1. Open Control Panel.
2. Open Programs and Features.

3. Select Turn Windows features on or off.

il Windows Features = =

Turn Windows features on or off L7

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

7 Media Features s
= [ Microsoft Message Queue (MSMO) Server
[]}. Metwork Projection
# [®] || Print and Document Services
[] || RAS Connection Manager Administration Kit (CMAK)
Remote Differential Compression AP| Support
2 L | |
[] 1 RIP Listener
% [] | Services for NFS
=[] Simple Metwork Management Protocol (SMMP)
O Simple TCPIP services (i.e. echo, daytime etc)
[ Suhsvstem for LINIX-hased Annlicatinns [Nenrecated] &

oK Cancel

4. Activate the check box in front of Remote server administration tools.

5. Click on OK.
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Note: If the remote server administration tools are not displayed, download these from the
Microsoft website and install them.

5.2.1.5 Tools

The following tools are helpful for the administration of AD LDS:
»  Microsoft mmc with the Active Directory schema snap-in: mmc -a
» ADSI Edit

»  ADExplorer (can be downloaded from Microsoft Sysinternals)

5.2.1.6 Configuring Active Directory schema snap-in

To configure the Active Directory schema snap-in:
1. Open the command line with administrator rights.
2. Enter the following command and press the Enter key: regsvr32 schmmgmt.dil

3. You receive a confirmation after successful registration:

o DlIRegisterServer in schmmgmt.dil succeeded.

4. Open the version.
Enter: mmc /a

5. The administration console is opened:

@ File Action View Fovorites Window Help [=]=]x]
L E G
MName Actions
There are no items to show in this view. W—‘
More Actions 3
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10.
1.

Zenon

Click, in the File menu, on the Add/remove snap-in command.

‘You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.
Available snap-ins: Selected snap-ins:
Snapn Ver A [ console Root EditExtensions... |
3] Active Directory Domains and Trusts  Ma i Active Directory Schema —
"'__.h tive (um tory Schema Mig
Mia
. Mia Move Up
e Mave Dow
Mia Ve ul
ia Add >
Mia
[ certificates a
Ll Certification Authority Mia
. Component Services Mia
ﬁmnwwl-\mmt Ma
<« > Advanced... |
Description:
View and edit the Active Directory Schema
[ o ][ concel |

Select Active Directory Schema.

Click on Add.

Click on OK.

Highlight the Active Directory Schema entry.

Select the Change Active Directory Domain Controller command in the context menu

Current Directory Server:
atszg-de01 copa-data intemal
Change to:
() Aty writable Domain Controller
(®) This Domain Controler or AD LDS instance

|copa—dda.'rlund

ATCEE-le.cooa-date nand
ATSZG-DC01 .copa-data intemal
ATS5ZG-DC02 copa-data intemal
CDIB0010.copa-data intemal

CDSC0010.copa-data.intemal

DECGN-DC01.copa-data intemal
DELWH-DCO1.copa-data intemal
DEMUC-DCO1.copa-data intemal
FRGNB-DCO1.copa-data intemal
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12. Enter the server name and the port in the empty field. In our example:
w8x64-vm0026.testenv.local:389.
Select your server and port here.
You now see this view:

[ File Action View Favorites Window Help
s z@c= 0
7] Console Root MName

b ] Classes - N === -
7 Attributes [ Attributes More Actions 3

13. Save the snap-in via File -> Save.
14. Optional:

a) Open the Classes folder and navigate to the organization entry.

@ Fle Action View Favortes Window Help =ielx
e 2D c: BE
R WM UintSetPanam ~ || Name Type System Descrip ~ | Actions
B3 maWMI-UnknownRangeParam N
P fre e 1 e
s e &
e telephoneNumber  Optional Vi T
#13 nTDSConnection & eleph
1 ATDSDSA [ street Optiomal  Yes Street-s
2 ATDSDSARD st Optionsl ~ Yes State-O
7 ATDSService < seetino Optional  Yes See-Als
7 ATDSSaeSettings £ searchGuide Optionsl  Yes Seaech-
2 nTFRSMember 1" registeredddress Opticeal  Yes Registe
12 ATFRSReplicaSet 1 peeferredDebveryMet.. Opticnsl  Yes Preferre
2 ATFRSSettings 1 postalCode Optional  Yes. Postali
13 ATFRSSubscriber postaladdress Optional Yes Postal-,
13 nTFRSSubscriptions: 1" pestOfficeBox Optional  Yes Pest-Ot
12 oncRpc < physicalDeliveryOtfice... Optional  Yes Physica
[¥5; organization| | Optional  Yes Localiy
=3 organizationalPerson [ internationsiSONNu...  Optionsl  Yes Intemat
:"9"‘"""""'"’" L facsimdeTelephoneN... Optional  Yes Focseni
B e IR o | I destnationingicatee  Optiomsl  Yes Desting »
< > < >

b) Click on Properties in the context menu.

Zenon
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c) Open the Attributes tab.

organization Properties ?
General | Relationship | Attributes
_l| a organization
|
Mandatory: &
Optional: businessCategary ~ Add...

destinationIndicator
facsimile TelephoneMumber i —
intemationall SONNumber ==

|

physical DeliveryOffice Mame
postalAddress

postalCode

postOffice Box Y]

ok ][ Caron ][ mow ][ e

d) Click on Add and search for maxPwdAge. Click on OK.
Add lockoutDuration and lockoutThreshold too.
Close the dialog by clicking on OK.

These steps are optional and require the corresponding rights. maxPwdAge defines the
time period in which a password is valid before it must be renewed. lockoutDuration
defines how long a user is locked out after entering the password incorrectly after several
attempts. The permitted number of incorrect password entries is defined with
lockoutThreshold.

15. Open the Classes folder and navigate to the user entry.
a) Click on Properties in the context menu.
b) Open the Attributes tab.

¢) Click on Add and search for sAMAccountName. Click on OK.
Add groupMembershipSAM and userAccountControl too.

Close the dialog by clicking on OK.

16. Close the console.

PASSWORD GUIDELINES

The guidelines for password complexity, minimum password length and minimum password age are
configured in the local security guidelines of the computer. If the computer on which AD LDS is running
is in a workgroup, you see the local security guidelines. If the computer is in a domain, you see the
domain security policies. Depending on your installation, you must configure the password guidelines.

For local security guidelines:

148 | 224



External user administration with Microsoft Active Directory

Zenon

Go to %ProgramData%\Microsoft\Windows\Start Menu\Programs\Administrative Tools\Tools\

Start Local Security Policy

Configure Password Policy

File Action View Help

“=|2E Xz Hm
T Security Settings

h Palicy Security Setting
‘& n“:m Pelices. 5 Enforce password history 24 passwords remember.
i e e
» [ Local Policies [ Minimum password age 1 days
& () Windows Firewall with Advanced Sec 35 Minimum password length 7 characters
) Metwaork List Manager Policies a5 P d must meet complesity req Ensbled
& [ Public Key Policies 3&«! passwords using reversible encryption Disabled

&[] Software Restriction Policies
1 [ Application Control Palicies
& 38, IP Security Policies on Local Compute
» @ Audit Policy Config

4. Configure Account Lockout Policy

File Action View Help

| nm X=| Hm

B .Se(ulineuings Policy : Security Setting
4 [ Account Policies. [ Account lockout duration 30 minutes
::(“::Lm - 7 Account lackout threshold 5 invalid logen attempts
. _‘a_!L_ﬂ Policies Y] [ Reset account lockout counter after 30 minutes

b [ Windows Firewall with Advanced Sec
1 Metwork List Manager Palicies

[ Public Key Palicies

&[] Software Restriction Policies

1 [ Application Control Palicies

& 38, IP Security Policies on Local Compute

» @ Audit Policy C

5.2.1.7 Configure roles, organization units and users

Use the ADSI Editor to configure the roles, organization units and users. You can find it in the path
%ProgramData%\Microsoft\Windows\Start Menu\Programs\Administrative Tools\.

To set up configurations with the ADSI editor:
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1.

2.
3.

Start the ADSI editor.

File Action View Help
+«|@ c| B
ADSIFrn|_ N | Actions
| Connectts... ﬂ Welcome to ADS! Edit
View »
| Active Directory Services Interfaces Editor
Rakes | (ADSI Ed) is a low-level editor for Active
Directory Domain Services / Active Directory
Help ightweight Directory Services. it allows you to
view, modify, create, and delete any objectin
Microsoft's AD DS/LDS.
To create a connection to AD DS/LDS, on the
Action menu, clck Connect To.

Select Establish connection in the context menu.

The dialog for the connection settings is opened.

Mame: | Copadata]

Path: | LDAP: {flocalhost: 389/DC=c

Connection Point
(®) Select or type a Distinguished Name or Naming Context:
| DC=copadata,DC=com

() select a well known Naming Context:

| Default naming context

Computer
(®) Select or type a domain or server: (Server | Domain [:port])

| localhost: 339

() Default (Domain or server that you logged in to)
[]use 55L-based Encryption

(Advnce...

Configure the following options according to your selected settings:

» Connection point: DC=copadata,DC=com
» Computer: localhost:389
»  Close the dialog by clicking on OK.

Zenon

You should now have the following view of the editor (open the tree in the left window by

clicking on the cursor or double clicking on the entry):

File Action  View Help

s afXE e BE

= ADSI Edit [y Class Distinguished Name Acticns
Pl Copadata Slen Chel dsts DC=com

« [ DCecopadstaDCacom] | o5 ¢4y NTDS Quotas msD5-Quata.. CHsNTDS Guotss,DCs copadata,DCs com More et *
1 EN=Roles contanes CN=Roles, DC=copadata, DL=com
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This is the starting point for all other configurations. In our example:
» Configuring roles (on page 151)

Configuring maxPwdAge (on page 153)

Creating an organization unit (on page 154)

Creating a group (on page 155)

Creating a user  (on page 159)

v v Vv Vv v

Adding users to groups (on page 162)

5.2.1.7.1 Configuring roles

In this chapter, you find out how you can issue zenon read rights for the structure of the AD LDS tree.

To do this:

1. Expand the folder CN=Roles.
- e -cEE

File  Action  View Help
es 2@ XEc: BE
= 4DS! Eda Hame Cls o

4 [ Copedsta [locaihost:389] -
4 [ DCcopedsta,DCacom There are no items to show in this view. | CN=Readers
1 CHeLostindFound More Actions ¢
% CH=NTDS Cuetas
a [ CH=Redes
1 CN=Administestors
[ ChizRen
7 CN=Use
. ) QUszencmq  Mew Conmection from Here

Hew
View

Delete
Rename
Refresh
Expert List...
Help

2. Highlight CN=Readers.

3. select Properties in the context menu
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4. The properties dialog is opened

Attribute Editor

Attributes:

Attribute

mail

<not set>
memberlid
meD5-Az ApplicationD ...
msD5-AzBizRule
meD5-AzBizRulelang...
msD5-AzGenericData
meD5-AzLastimporte ..
msDS-AzLDAPGueny
meDS5-AzObject Guid
m5-D5-ConsistencyC...
m5-D5-Consistency....
msD5-LastknownRON

Navigate to the member entry.

Click on Edit.

Click on Add Windows account.

Add the user Everyone (Everyone) for the local host.
Close the dialog.

You will have the following view

Attribute:
Values:

Mame Container Distinguished Mame | 5ID
Everyone <5ID=010100000000000100000...

Remove

| | cancel

Zenon
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5.2.1.7.2Configuring the password duration

This area is important if you want dedicated password rules for the zenon organization unit. If you do
not configure these rules, the local security guidelines of the computer on which AD LDS was installed
are applied.

To configure rules:

1.

S v~ W N

9.

Highligt the folder DC=copadata,DC=com.
Click on Refresh.

Close the ADSI editor.

Open the editor again.

Highlight the DC=copadata,DC=com entry.

Open the properties using the context menu:

- ew -cEm
Fille Adtion Wiew Help
| 2 XE S BE
2 ADY Edit | ame Class Distinguished Name || Actions
B Copadua 2 CH=L =L DC=copadata DC=com A
| N:;:gombﬂr“- + Jotes maDS-Cucts..  CH=NTDS Cuotas, B Mare Actions L]
R CH=LostAn container CN=Roles,DC= copad
] CH=NTDS Qu View -
1 CN=Roles
Rename
Refresh
Properties

Navigate to the maxPwdAge entry.

Enter a valid value (format: DD:HH:MM:SS) and close the dialog.

DC=copadata,DC=com Properties ?

Attribute Editor

Attributes:

Attribute

managedBy
maxPwdAge
minPwdAge

Note: If the entry maxPwdAge is not available, check to see if the property has been added
correctly. The updating or closing and reopening of the editor can also rectify the problem.

Navigate to the lockoutDuration entry.
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10. Enter a valid value (format: DD:HH:MM:SS) and close the dialog.

DC=copadata,DC=com Properties ?

Attribute Editor

Attributes:

Attribute

lastknownParent
lockout Duration

lockout Duration

11. Navigate to the lockoutThreshold entry.
12. Enter a valid value and close the dialog.

DC=copadata,DC=com Properties ?

Attribute Editor

Attributes:

Attribute

lastknownParent
lockout Duration

lockout Threshold

5.2.1.7.3Creating an organization unit

To create a organization unit:

1. Highligt the folder DC=copadata,DC=com.

File  Action View Help

s 2@ X0 G BE

ATl Ednt Mo Class Distinguished Mame || Actions

# ] DC=copadsta,DC=com|

O CHslosth  Mew & Object... I N -

[ CHaNTDS | = |lm CH=Roles, DC=copad

] CHaRoles| VoW
Rename
Refresh
Expont Lint...
Properties
Help

More Actices

Zenon
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2. Select New -> Object in the context menu.

Select a dass:

msPKI-Key-Recovery-Agent
msSFU30MailAlizses
msSFU30Netld
msSFU30MNetworkUser
nisMap

nisMetgroup

nisObject

oncRpc

organization

physicalLocation
printQueue

remnteMsilR srinient

<Back | MNext> | | Cancel

3. Select organizationalUnit as a class.

4.  Click on Next.

Attribute:  ou
Syntax: Unicode String

Description:  Organizational-Jnit-Mame

ZENON USErs OU|

5.  Enter a name as a value.
6. Click on Next.
7. Click on Close.

5.2.1.7.4Creating a user group

To create user groups:

Zenon
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1. Highlight the folder with the organization unit that has been created.

File Action View Help

es n@XDc: BE

I ADsi Name Class Distinguished Name || Actions

4 [ Copsdata [locaihost:389]

4[] DC=copadata DC=com There ate nc items to thow in this view. ||

[ CH=LostAndFound More Actions. 3
(21 CH=NTDS Quetas
] Ch=eles

[ OU=zencn user 01|
Move

2. Select New -> Object in the context menu.

Select a dass:

document
documentSeries
domainPolicy
dsA
friendlyCountr:

groupOfilames
groupOfnigueMames
groupPolicyContainer
indexServerCatalog
inetOrgPerson
intellimirrorGroup
intallimirrnrar B

3. Select the group entry.
4. Click on Next.

Attribute:
Syntax: Unicode String

Description:  Common-Mame

zenon user group|

5. Enter a name for Value, zenon user group in this example.

Zenon
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6.

Click on Next.

To complete the creation of this object, click Finish.

To set more attributes, click More Attributes.

7. Click on the More attributes button.

8.

9.

Select the groupAttributes entry.

Attributes

Path:

Class: group

Select which properties to view: |Dpﬁond

Select a property to view: |g-oLp.Pd'h'bues

Attribute Values

Syntax: [INTEGER

Edit Attribute: 147483650

Value(s): |mot set>

Enter 2747483650 in Edit attribute.

Zenon
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10. Click on Define.

Attributes

Path:

Class: group

Select which properties to view: |Dpﬁond

Select a property to view: |g-oLp.Pd'h'bues

Attribute Values

Syntax: [INTEGER

Edit Attribute: ||

Value(s): |214?483650

11. Click on OK.

12. Select, in the More attributes dialog, the sAMAccountName property.

Attributes

Path:

Class: group

Select which properties to view: | Both

Select a property to view: |sAM.AccouiNa'ne

Attribute Values

Syntax: | DirectoryString

Edit Attribute: ||zenon user group

Value(s): |mot set>

13. Enter the same value as for group.
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14. Click on Define.

Class: group

Select which properties to view: | Both

Select a property to view: |sAM.AccouiNa'ne

Attribute Values

Syrtax: | Directory String

Edit Attribute: ||

Value(s): |zenon user group

15. Click on OK.

16. Click on Finish.

5.2.1.7.5Creating a user

To create a user:

1.

Highlight the organization unit.
= e -cEE

File Action View Help

e nfxE e BE

Zenon

Class Dintinguithed Name || Actions
There are ne ibems to thow i this view.

More Actions.
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2. Select New -> Object in the context menu.

Select a dass:

physicalLocation
printQueue
remoteMailR.edpient
remoteStorageServicePoint
residentialPerson
rFCa22LocalPart

room

rpcContainer
rRASAdministrationConnectionPoint
serviceAdministrationPoint
serviceConnectionPoint
user

nearProvy

3. Select user as object.

Attribute:
Syntax: Unicode String

Description:  Common-Mame

Value:

4. Enter a name as a value.

5. Click on Next.

To complete the creation of this object, click Finish.

To set more attributes, click More Attributes.

Zenon
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6. Click on More attributes.

7. Select sSAMAccountName.

Attributes

Path:

Class: user

Select which properties to view: |Dpﬁond

Select a property to view: |sAM.AccouiNa'ne

Attribute Values

Syntax: | DirectoryString

Edit Attribute: |zenon1

Value(s): |mot st

8. Enter the same value as for user.
Note: This is important in order for the user to be used in zenon.

9. C(lick on Define.

Attributes

Path:

Class: user

Select which properties to view: |Dpﬁond

Select a property to view: |sAM.AccouiNa'ne

Attribute Values

Syntax: | DirectoryString

Edit Attibute: ||

Value(s): |zenon1

10. Click on OK.

11.  Click on More attributes.
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12. Select displayName.

Attributes

Path:

Class: user

Select which properties to view: |Dpﬁond

Select a property to view: |dsplayNa'ne

Attribute Values

Syntax: | DirectoryString

Edit Attribute: |15t zenon usar

Value(s): | <not set>

13. Enter a description for the display
14. Click on Define.

Attributes

Path:

Class: user

Select which properties to view: |Dpﬁond

Select a property to view: |dsplayNa'ne

Attribute Values

Syntax: | DirectoryString

Edit Attibute: ||

Value(s): |15t Zenon user

15. Click on OK.
16. Click on Finish.

5.2.1.7.6 Adding users to groups and setting a password

In this section, you add a user to a group and issue a password.
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ADDING A USER

To add users to a group:

1. Highlight the group.

File Action View Help
e z2@lxXxEeE 0E

3 ADS Edit | Name Class Distinguizhed | Actioas
4 § Copadata [locathost:289] F ,—_————
There ate 00 items to show in this view,
Mare Actions »

4 ) DC=copadataDC=com

2 CN=tomAndfound

1 CN=NTDS Quotas.

1 CN=FRoles

4 (1] OU=zenon users OU
] Ohmwl
) CNszenont

New Connection from Here
New »
View »
Delete
Rename
Refresh
Export List...
Help

2. select Properties in the context menu

Attribute Editor

Attributes:

meD5-Az ApplicationD ...
msD5-AzBizRule
meD5-AzBizRulelang...
msD5-AzGenericData
meD5-AzLastimporte ..
msDS-AzLDAPGueny
meDS5-AzObject Guid
m5-D5-ConsistencyC...
m5-D5-Consistency....
msD5-LastknownRON

3. Highlight member.
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4. Click on Edit.

5.

6.

Container Distinguished Mame | 5ID

Remove

Click on Add DN.
The dialog to add a previously-configured user is opened

Multi-valued Distinguished Name With Security Principal Editor
Attribute: member
Values:
Mame Container Distinguished Mame | 5ID

Enter a distinguished name (DN) for an object.

-,”:N =zenon 1,0U=zenon users OU,DC=copadata,DC |

Lo || concel |

Remove

Zenon

Enter, for the user from our example: CN=zenon1,0U=zenon users OU,DC=copadata,DC=com
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7. Click on OK to close the dialog.

Container Distinguished Mame | 5ID

copadata.com/zenon users OU CM=zenon1,0U=zenon users OU. ..

Remove

| | cancel

8. Click on OK.

SET PASSWORD

Now define a password for the user. To do this:

1. Highlight the user that has just been created.

File Action View Help

e 2@XE ez BE

2 DS ida Harme Class Distingurshed || Actions
4 [ Copedsta [locaihost:389]
4 [ DCacopadata DCscom Theere are no items to show in this view.
Mot Actions »

2. Select Reset password in the context menu.

3. lIssue a password.
Note: the password must meet the requirements of the local security guidelines.

4. Close the dialog.

Zenon
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5. Select Properties in the context menu of the user

Attribute Editor

Attributes:

Attribute

mail

manager

middleMName

mobile
mS-D5-ConsistencyChildCount
m5-D5-ConsistencyGuid
msD5-LastknownRDN
msD5-UserAccount Disabled
meDS-UserDont Expire Password
me-D5-UserEncrypted Text PasswordAllo ..
me-D5-UserPassword Mot Required
name

nt PwdHistory

6. Selectthe properties msDS-UserAccountDisabled.

CM=zenon1 Properties ?

Attribute Editor

Attributes:

Attribute Value &
mail <not set>

msD5-UserAccount Disabled

7. Set the value to incorrect.

The user can now be used in zenon.

5.2.2 AD LDS with Windows 7

Zenon

AD LDS can also be used with Windows 7. You can find the setups for these on the Microsoft website

(http://www.microsoft.com/downloads/en/default.aspx).

After installation, configuration is carried out via System control-> Administration in the same way as

the description for Windows Server 2008 (on page 186).
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5.2.2.1 Create new AD LDS instance

To create a new AD LDS instance:

Zenon

1. Call up, in the Active Directory Lightweight Directory Services Control Panel, the AD LDS Setup

Wizard.

Create & new ADLDS instance [ ADLDS Setup Wizard

2. Start the wizard:

@' Active Directory Lightweight Directory Services Setup Wizard

Welcome to the Active Directory
Lightweight Directory Services Setup

Wizard
@ This wizard heps you install Mcrosoft Active Directory

Ughtweght Directory Services (AD LDS).

AD LDS is a powerful drectory service that is casy to instal
and deploy

R provides 3 dedicated data store for
;and Gen be carfguwed.

Independently
To continue. cick Next

s [CHets )] e |

W |

3. Select the A unigue instance option.

ADLDS ed each tme AD LDS

‘with exsting nstances.

' Aepica of an existing instance
Thes option creates a new instance of AD LDS that uses the

the appication paritions 10 rephcate.

and

configuration:
of AD LDS. You can also select

<M|M>IW|

wo |

4. Give the instance a name.

@1 Active Directory Lightweight Directory Services Setup Wizard

Instance Name

name is used to dfferertiate this instance of AD LDS from other AD
computer.

The instance
LDS instances on this

The

Type & name for
o 3D LDS 5 rened
Instance name:

Jratancet
Exsrle Addressbock
The

wibe of Windk

AD LDS senvice deplay name:  instancel
AD LOS service name- ADAM_nstancel

e |

Ho |

5. Configure the ports. Default:
» LDAP: 389
» SSL: 636
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Note: If you change the pre-set port here, you must also amend the port in some of the
following settings.
X

Ports Y
Computers wil connect to this nstance of AD LDS using speciic ports on all of the
1P addresses associated wih this computer L

<M|“>IWIN¢|

6. Specify the Partition Name.

In our example: o=zenon,c=com
X

Application Directory Partition &4
An apphcation Grectory parttion stores appicaton speciic data (

Doyou eneEl o ADLDS?

 No.ds s par

% Yas, creste an appication drectory padtion

Seloct this sookcaion

Y
ot aready Eampie
CNePation,0C+Woodgrove. DC«COM

Pattion name.

[o-zenen.cocom

<ok [ Met> | Coed | B |

The Partition Name is used together with the port and the server name later in zenon.

Active Directory/ADAM/AD-LDS
Access to Active Directory: ADAM/AD-LDS h

ADAM/AD-LDS connection: ADAM/AD-LDS user identification:

ADAM/AD-LDS password:

This configuration can also be set up later in zenon. Continue with configuration in the wizard.

7. Define the save location.
The setting can be left as the default setting.
X

:ggwudnlocwluwvypedfumedmummdw 4

Specky th fes ADLDS.
Data fies.

[C Program Fies\Mcrosch ADAM tance \data Brgwse.. |
Data recovery fles:

F\nganms\»am ADAM\natance 1'data Browse |

<M|&|>|Cmai|"¢|

8. Define the service account for AD LDS.
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In our example: Network service account
X

Service Account Selection ~ ‘
AD LDS performs cperations using the parmissions associated weth the account —"
you selact L

D LDS to perk e

Setup AD > &
accourt.

& Network senvice accourt
D LDS has the pemmissions of the defauk Windows senvice account.

€ This sccourt:
AD LDS service has the pemmissions of the selected account.

L—
—

dou [TE] oo | _ e |

If the computer on which AD LDS s installed is not a member of a domain, you receive a
warning message:

0 Active Directory Lightweight Directory Services Setup Wisaed 54 |

You have selected a system service account for this Active:
AU, Orectory Lightweight Drectory Services instance. Because this
4 computer is not 3 member of 3 doman, this instance wil not be
able to rephcate data with AD LDS nstance on other computers.
whie using this service account.

Do you want to continue?

= _= |

This does not impair the functionality of AD LDS. Exception: You use the Replication function.
Confirm the warning by clicking on the Yes button.
Define the user who receives administrator rights.

In our example, we use Currently logged on user. In our case, a local user with administrator
rights.

4
AD LDS Administrators 4 4
You can spachy the user o group that wil have administrative prvieges forthis I
rtance of AD LOS (4

or growp of x ADLDS.
@ Gumertly logged on user: SERVER 2008 Admivsirator|
The user that is nstaling AD LD! this
ratance of AD LOS.
 Ths account
= e o
AD LDS. You can chy or group from ter, thes
domain, of any Ser's doman

<ok [ Met> | Cocd | Mo |

The user and their password are used later in zenon.

Active Directory/ADAM/AD-LDS
Access to Active Directory: ADAM/AD-LDS -
ADAM/AD-LDS connection: ADAM/AD-LDS user identification:

ADAM/AD-LDS password:

This configuration can be set up later. Continue with configuration in the wizard.
Import the required LDIF files:
»  MS-InetOrgPerson.LDF
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»  MS-User.LDF
»  MS-UserProxy.LDF

@1 Active Directory Lightweight Directory Services Setup Wizard x|
You can impon data from Lightweight Drectory Interchange Fomat (LDIF) fles into
your AD LD application drectoey pattion. { e
T ADLDS of the LDIF fles leted
below.

[m] etadata LOF  ADAMSync matadata schema extension. Reaured for A
[0 MS-ADLDS-DispiaySpechers ... AD LDS Display spechiers schema and dsplay speckiers

[ MS-AZMan LDF AD LDS schema extensions for AzMan

[ MSinetOrgPerson LDF AD LDS inetOrgPerson, user and related classes

[ MSser LDF AD LDS user cisss and related classes

3 MS-UserProay LDF AD LDS simple userProxy class

[ MS-UserPronyFll LOF AD LDS ll userProny class. Requres MS-User LDF or b
R | »

ik [ o> | come | He |

11. Finish the installation

@1 Active Directory Lightweight Directory Services Setup Wizard

Ready to Install
The AD LDS Setup Wizard is ready 10 install AD LDS with tha folowing
configuraton.

Before T

‘Selections: 3
install 3 unique instance of AD LDS. Al
{nstance name: instance |

wi

pot: 389
podt: 636
|Store AD :l
To change your selections, chck Back. To instal AD LDS. cick Next.

<ok [ Net> | Coed | Wb |

@! Active Directory Lightweight Directory Services Setup Wizard

Completing the Active Directory
Lightweight Directory Services Setup

You have successfully completed the Active Drectory
& Lightweight Directory Services Setup Wazard

o) el o]

5.2.2.2Importing an AD LDS schema

To import the AD LDS schema:

1. In Windows Explorer, navigate to the

%WINDIR%\ADAM folder.

Zenon
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In the context menu, select [Shift key + right mouse key]: Open input request here.

g\ / = Computer « Local Disk (C:) » Windows = ADAM ~

Fle Edt Vew Toos Hep

Organze v Views v

| Mome - |- Oate modfed || Type I-{sze |-jteps |-|
2. 42

=101 x|

v i e

"

Fle Folder

Enter the following character string:

Idifde -i -s localhost -c CN=Configuration,DC=X #ConfigurationNamingContext -f

MS-AdamSchemaW?2k8.ldf

Press the Enter key:

Enter the following character string:

Idifde -i -s localhost:389 -c CN=Configuration,DC=X #ConfigurationNamingContext -f

MS-AdamSyncMetadata.ldf
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Note: If you have changed a port, it must be amended here accordingly.

#BConf igurat il

6. Press the Enter key:

5.2.2.3Configuring the AD Snap-in schema
To configure the Snap-in schema, first register using the command prompt (administrator rights are
required):
1. Click on the Start button.
Navigate to Command prompt.
Select Run as administrator in the context menu.

At the command prompt, enter: regsvr32 schmmgmt.dil.

HINF SN

Confirm with the Enter key.

6.0.6001)
. A1l rights veserved.

.d11

0 DiRegisterServer in schmmgmt.di succeeded.

CONFIGURATION

1. Right-click the Start symbol.
2. Open Run.

3. Enter: mmc /a.

I x|

= Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Qpen: [ mme/a -

£ This task will be created with administrative privileges.

ok | Conce gowse.. |
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4. Click on File -> Add/Remove Snap-in...

@ Fle Acton View Faverites Window Heb |,_[¢|5[
4

Hew
= Open... cHl+0 T

A, There are no items to show in this view, Consale Root
More Actions *

5. Select Active Directory Schema.
6. Click Add.
7. Click oK.

Add or Remove Snap-ins x|

[ cive Orectory Schoma | .
{2l Active Drectory Sites and ... Microsaft ¢ Remove |

=i'| Actrvex Control Microsaft ¢

2 ADs1 Edt Microsaft L] tave in I
i authorizason Marager Microsaft ¢
Ly Certificates Microsaft ¢
. Component Servces Microsoft ¢ Add > I
& Compauter Management Microsaft ¢
24 Device Manager Mcrosaft ¢
£ Oisk Management Maosaft i
[l Event viewer Mcrosaft ¢
2 Microsaft ¢

Folder
g Group Policy Object Editor hum?: n I

ruummummm

8. (o to Active Directory Schema.

9. In the context menu select Change Active Directory Domain Controller...

- =loix]
@ Be At yew Fories findm beb |.mﬂ
% |ms Bl

1 [Consae Root] |  Actions.
- Console Root -

More Actons »

oA b SOHES Ot s et
Cposs Biors 14stee)

Perimissions,,

Rekosd e Schema

New Window from Here.
Refresh
Hep

[Select a different Active Drectory Doman Conbroler [ [

Zenon
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10. Enter the server and port (in this example) localhost:389).

11.

12. Go to Classes -> organization.

13. Open Properties:

14. click Add.

a) Search for maxPwdAge.

174 | 224



External user administration with Microsoft Active Directory ﬂ
zenon

b) Click OK.

C) Repeat this step for lockoutDuration
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15. Click OK.
21

General | Relatonshp  Atisbutes |

i optzaton

Mandatory.

Opticnal [busnessCategory - Ad |
facsimie TelephoneNumber Bemove
Intemationall SONNumber —J
U

16. Open the Classes folder and navigate to the user entry.
a) Select the Properties entry in the context menu.
b) Open the Attributes tab.
¢) Click on Add and look for sAMAccountName.
d) Click oK.
e) Also add groupMembershipSAM and userAccountControl.
f)  Close the dialog by clicking on OK.

17. Close the console.

Note:

» These steps are absolutely necessary to have maxPwdAge available in the organization unit,
which is configured next.

» maxPwdAge defines the maximum password age; the password must be changed after
this time.

» lockoutDuration defines how long a user is locked out for after they have repeatedly
entered their password incorrectly.

» lockoutThreshold defines the number of possible failed attempts before a user is locked
out for a certain period.

» Inthe local security guidelines, you define the regulations for:
» password complexity

» minimum password length
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» age

=ioj x|
He Acton Yew fep

a7 mX = Bm

Th Secunty Settngs Pokcy - [seoritysetsrg |

=1 (1@ Account Poloes Enforce password history 0 passwords remen...
® @ Mavmun password age 42days
1 Account Lockout Polcy Mewmum password age 0days
3 g Local Polces Mmum password kength 4 characters
) -] Windows Frewal with Advanced Seaurity | o0 ve... Enobied
s @ mtmm Store passwords using reversble ... Disabled

@ ] software Restriction Pokces
& 1P Seaurity Pokces on Local Computer

< 1]
I ) I

5.2.2.4Configure organization units, groups and users

To configure organization units, groups and users:

1. Open Start -> Administrative Tools -> ADSI Edit

Fle Action View Hep
ewlmicl@lm
= ,

[ 0 Welcome to ADST Edit
View »
Refrech | Active Drectory Services Interfaces Editor (ADS! Edit) is 8 lov
e Directory Doman Services / Active Drectory Lightweight Direx
Hep

%o view, modify, create, and delete any object in Mcrosoft's )

To create 2 connection to AD DSADS, on the Action menw, o

2. Select Connect to... in the context menu

3. Use the following settings (change other settings if they have been set up previously):
a) Connection Point: o=zenon,c=com
b) Computer: localhost:389

You should now see the following configuration:

raosican =loixf
He Awn Vew Heb B
e 2(m| R0 = >lm
2 AOSIEG Name. [ Clozz | 4 Name. Actions §
= @ Oefault naming context flocalhost:389) S Chimd o ,0=zeron,Cocom | 0 ranonc=com «
o CN=NTDS Quotas mOSQUOta...  CN=NTDS Quotas,0=2enon,Cwcom
d Q=LostAndFound | CheRoles contaner CN=Roles, O mzenon,C acom More Actions ¥
| CNNTDS Quotas
1 CwRoles
< | o

CONFIGURING MAXPWDAGE
1. Highlight O=zenon,c=com

Click on Refresh

Close ADSI Edit

Open ADSI Edit again

ok W N

Highlight O=zenon,c=com

177 | 224



External user administration with Microsoft Active Directory a

Zenon

6. Select Properties in the context menu.

Fle Acton Vew Hebp
(G| 2m[ X0 o= Hlm
= ADSIEt Hame | Cass I
= | Defauit namng context flocahost:185] | Chi=LostandFound kstAndFound O
= R o = ) ENaNTDS Quatas me05-Quota... O
o o=y 7| enmficles container a
S o e * o " ¢
'__'GJ- Rename
Refresh
Export List..
| _Propertes |
Help.

7. navigate to maxPwdAge
a) Enter avalid value

b) Format: DD:HH:MM.SS (in our example 70:00:00:00)

g =)

oK | comes | mey | He |
TaT I

Note: If the maxPwdAge property is not visible, check to see that it has been correctly added.
A refresh, or closing and opening ADSI Edit or reloading the schemas may rectify the problem.

8. Navigate to lockoutDuration

a) Enter avalid value

b) Format: DD:HH:MM.SS (in our example 00:00:10:00, -> 10 minutes)

{ 0=zcnon.c=com Properties I E|
¢ arbute Edter |
Aetrkntes:
Atcbte [ Vae -l
I anot set>
Iast Known Panent ot set>
lockoutDuration 0001000
Large Integer Attribute Editor 5
Autribute: locheut Durstion
oo 000
Tow | I
objectGUID ‘se0danedboch-S 23 fec 3aTTTdbd53ds
byt Version anot st -
_= | B |
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9. Navigate to lockoutThreshold

20|
|
oo heeshois 3|
manPwdAge 10:00:00:00 J
mestingScope not set>
m5-05 ConsistencyC...  anot sets
m5-D5ConsistencyG... ot sets
name enon
L] enon
cbpectCategory (CNeOrgarization CH=Schema CNeConfigun
chpctass b erganization
et GUID eaedboch-2 73 Boct 3 TTTd%I%E
cljectVerson ot set> =
[0k | come | soow | o |

10. Enter the same value as in the local security guidelines (3 for example)

I tocatsecontvrober <

| He Acton Yew feb

[ [m XD [Hm

i Secunty Settings
£ [ Account Poloes
% | Password Pokcy

® ] Windows Frrewal with Advanced Seauty

[ searity settng

Account lodkout duration

1 minutes

Reset account lockout counter after 1 minutes

Note: The settings for the duration of the account block are ignored in AD LDS. The lockoutDuration
property (O=zenon,c=com) is used.

5.2.2.4.1Users

To create a user:

1. Highlight the organization unit.

2. Select New -> Object in the context menu

Fle Action View Hep

| [2[m| % 0 o = Hm

= ADS1 Edt Hame [ cass d Mame:
= [ Defaut naming context flecabhost: 359 ] ChmL | Omzenon, Cmcom
5 [ Omzenon cecom ] CN=NTDS GQuatas msDS-Quata...  CN=NTDS Quotss,O=zenon,C=com
| ChimLostAndFound | CheRioies contaner ChmRioles, Omzenon, Cmcom
| CH=NTDS Quotas ] ou Gmperian,
] Chisflcies

3 |
New Connection from Here
Delete
Rersema
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Select the user class.

Select a dass:
[physcal ocation :I
[printQueve
emotaMaiR t
emoteStorsgeServicePont
rFC822ocalPart
room
rpcContaner
RASAdminstratonConnectionPont
serviceAdminsty abonPon!
serviceConnectionPoint
aactrons g

o [aext> | come | mep |
Enter a name.
In our example: zenonT.
i
Atrbute: o
Synitan: Unicode String
Description: - Common-Hame:
Aokue: [ zercny
<ok [ mext> concd | b |
Click Next.

Switch to tab Attributes.

Click More Attributes.

a) Go to the Select a property to view property.

O

) Go to Edit Attribute.

o 0O

) Select sAMAccountName in the drop-down list.

) Enter the same value as for the user (zenoni)

This configuration is necessary in order for the user to be able to be used in zenon.

x|

8. Click Set.

180 | 224



9. Now, in the Select a property to view property, select displayName.

10. Enter a value for the display of a name, such as 1st SCADA user.
CTTE—— X

khbuul
Path:
Class: user
Select which properties to view:  [Optional -]
Select a property lo vew: | dispharyhlame ol
~ Aitribute Viakuss -

Ece Aetrbut: [Tt zencn user

Vaels: |1et zeon user

Set Oear |
ok ] _omen |

11. Click on Set, then on OK and on Finish.

ADDING A USER TO THE GROUP

To add users to a group:
1. Select zenon user group.

2. Select Properties in the context menu

Z ADSLEGt
= § Default naming context ocathost:389)
= O=zencn cmeom
CN=LostAndFound
CN=NTDS Quotas
Q=Roles
1 OU=2enon users OU

a  Move
New Connection from Here

3. Highlight member.
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4. Click on Edit.

5. To add the created AD LDS account (user):
a) Click Add DN....

b) At the input field, enter: CN=zenon1,0U=zenon users OU,O=zenon,C=com.
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7.

The user has now been created and can be used in zenon.

Define a password for the user zenon1.

| Fle Acton View Heb
o | 2mX D= im
2 AOStEat Name
= @ Default naming context focahost: 389]
B L] Owzencn,cmcom
1 ON=LostAndFound
ON=NTDS Quotas

CN=Roles
1 OU=zenon users OU
1 Cimzenon user group
—
New Connection from Here

New » ‘
View »

Note: The password must meet the requirements of the local security guidelines.

For the user zenon1, set the properties set msDS-UserAccountDisabled to False.

T 21
Attribute Editor |
A o con et cator S
Attribute:
lastKnownPan  Attribute: msD5-UserAccount Disabled
lastLogon Time Value:
lockout Time © Toe
mail
manager & False

middleMName " Not set

mobile
m5-DS-Consis ok ] _ cance

m5-DS-Consisrereyer—=rmorser
msD5-UserAccountDi... TRUE
meD5S-UserDortExpir...  <not set>
me-D5-UserEncrypte...  <not set>
ms-D5-UserPassword... <not set>

Edit | Filter

name zenon -
s | _'I_I

ok || Cancel | sl | Heb

5.2.2.4.2 Organization units

To create a organization unit:

1.
2.

Highlight O=zenon,c=com

Select New -> Object in the context menu

Fle Action View Help

e 2mXE0 =

' ADSI Edit

= ACsIEdt Hame | class
& [§ Default naming context locahost:385] | CH=LostAndFound lostandFound
B L_Low
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3. Select organizationalUnit

Select a dass:
oroupPoicyContainer -
[InetOrgPerson 'J

R T I |

4. Enter a name (in our example: zenon users OU)
X

Atrbute: o
Syrita: Unicode String
Descripton: - Organizational-Unit-Hame.

<ok [ mext> concd | b |

5. Click on Next and then on Finish

5.2.2.4.3 Groups

To create a group:
1. Highlight the organization unit

2. Select New -> Object in the context menu

B ADSI Edit
Fle Acton View Heb

@ | 2m[X D= Hm

= ADSTEGR Nome [oss I
@ Defaut naming context focahost: 359 Ot [EET 0 wzenon,Cecom
&[] O=zenon,cmcom 2] CN=NTDS Quotas meDS-Quota...  CN=NTDS Quotas,O=zenon,Cecom
3 contanes CNe=Roles,Omzenon,Cucom
ou J 0 =2EN0n, Cmcom

Zenon
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3. Select group

x|
Select a dass:
[ sopbeatoniersicn B
assstoce J
compuster
contact
container
device
document
doqumenSenes
| domainPolcy
dsa
ﬁwg\:i
P — =

4. Enter a name (in our example: zenon user group)
X

Attrbute: o
Symitax: Unicode String

Descrption:  Comman-Hame

R o o oo

<iock [ bent> cocd | ww |

5. Click on Next

6. Switch to the Attributes tab

7. Click on More attributes
a) Navigate to Select a property to view
b) Select groupAttributes in the drop-down list
¢) Navigate to Edit Attribute

d) Enter the value 2747483650 (represents an account group)

khbuul

Class: grop

[ e =]
Select a property to view: |
 perute ks -

Eot pebune: [21e7EE3650 0
Vagueds): [enct set>

8. Click on Set

9. Now select sSAMAccountName in Select a property to view
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10. Enter the same value as for the group (zenon user group)

1.

Note: This setting is necessary in order for the user groups in zenon to be configured
x|

Aerbutes |

Path:
Class: grop

Selact yhich properies to view: | Optional -]

Select a property to vew: [sAMACcount Name =

[~ Attribute Vakuss

Srtng [DescoeyStmg

it Aairue: [

Vguel  [zenon user group

o o |

_ ok | cnen |

Click on OK and then in Finish

5.2.3 AD LDS with Windows Server 2008

To install the AD LDS server role:

1.

Select Server Manager in the administrative tools

]

ﬁ Select Server Rol
Before You Begin

ADLDS
Confirmation

Frogress
Results

es

Select one or more roles to install on this server,
Rles:

L Active Drectory Certficate Services
[] Active Directory Domain Services

Deseription:

Active Directory Lightweight Directory.
Serviges (AD LDS) provides 2 store for
application-specific data, for directory-
applications that do not
rastructure.

require the infr; of Active
Directory Domain Services. Multiple
[ of AD LDS can edst on 3
single server, each of which can have
its own schema,
L] Fle Services
L] Metwork Pobcy and Access Services
[ Print Services
] Terminal Services
] woot services
L] web Server (it5)
[ windows Degloymant Services
Mare about server roles.
<prevess [ net> | carcel |
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2. Click on Add Roles
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]

l%‘ Installation Results

Before You Bagn
= The following roles, role senvices, or features were irstaled successfully:
Server Roles .
ADLDS (i) 1 informational message below
Confrmation ~ Active Directory Lightweight Directory .
S— Services @ Installation succeeded

(i) Enstances of ADLDS can be created by baunching the Active Drectory Lightweight Directory
 Services Setup Wizard from the Administrative Tools folder on the Start menuy,

|

5.2.4 zenon administration with Active Directory

For use in zenon, first configure the settings in the Editor (on page 188) and set the user identification to

AD LDS level in the Runtime (on page 189).

¥ |nformation

Active Directory and AD LDS, as well as ADAM (for Windows XP), are not

available under Windows CE.

5.2.4.1 Editor

Configuration is carried out in the project properties in User Administration:

Active Directory/ADAM/AD-LDS
Access to Active Directory: ADAM/AD-LDS

ADAM/AD-LDS connection:

ADAM/AD-LDS password:

EXAMPLE

The following settings have been made:

ADAM/AD-LDS user identification:
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» A user group with the name zenon user group has been created by the user.

=) oy Workspace: 700(3) » oo | Bz @ N | £3oam £ QT |

=) [B[D_700 (Start project)] - IR I S I B - N )|
E]---‘ Variables Name Messa...
i ® Screens Filter text % |Fiter... %
16 Functions ZENON USET group m|
----- m;? Language file
----- ﬂ Historian
- [#] Recipes
----- 5 Time cortrol
@ Programming interfz
s zenon Logic (|EC &
Production & Facilt
& Intedockings
----- @ Energy Manageme
----- § Message Control —
..... E’ Menus
----- R | Report Generator
% User administrat...
: s User
8 User groups
----- T SAP interfare o

Ll LLLJ 2 | 1 total /1 filtered / 0 selected |

.= Project tree Eﬁg Metwork topology

»  This was assigned an authorization level.

£
£

m

Allocate authorization levels to a user group
Available authorization levels Selected authorization levels
MNumber  Mame Il MNumber  Mame
1 1 ‘ = ‘ e 0 0
2 2
3 3
4 4 e
5 5
[ [
7 7
8 8
9 9
10 10
11 11
12 12
13 13
14 14
15 15
16 16 il
;_'| - i | »

5.2.4.2Runtime - system driver variables

» The user zenont can log in to zenon:
The Complete name property in zenon corresponds to the AD LDS attribute displayName.
The User name property corresponds to the AD LDS attribute sAMAccountName.

Complete name:

| 1stzenon user |

Usern identification:

| zenon |
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» The user receives their authorization levels from the zenon group:

Current authorization group 1:

| 1 |

Current authorization group 2:

| 1 |

Current authorization group 3:

| 1 |

Current authorization group 4:

| 1 |

» The remaining days until the password must be changed are displayed (with a day's difference):

Rest days of password change

| g |

ERROR TREATMENT

If errors in the Runtime occur, check whether:
»  The settings have been set up correctly:
» Username
»  sAMAccountName
» The firewall settings have been set up correctly:
» The Editor configuration is correct for:
» Connection

P Password

If the user does not receive any authorization levels from the zenon group, check if:

» The names correspond to each other
»  sAMAccountName of the group in AD LDS was set
» The userin AD LDS was added to the group

AD

If operating authorizations from the user group in AD are to come, the following must be the case in AD

LDS:

» The description property must be amended for the group
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»  The group must have the exact same name as the project

maosiean =10l
Fle Acton Vew Heb |
SR | |
Z osieat [ Pevtute Edto | [Hults valued strmg dtor A
= @ Default naming context flocahost:389]
S ) Owzencn,cmcom Aadntos: ’ -
] CetostindFound Horbte Von  yale 1o 0dd:
g-:ms: mh :: “Trower Tea 0GR ~FFFFFEFF-FFFFFFFFFFFFFFF
QU=zencn users OU daplayName oot Veles
Ch=zenon user group dstinguishedName CNe;. Remvrpe
§ Q=zenonl dSASgnatire et '———J
Qihugo dSCerePropagationD . OO+
ISMORoleOwner act
gabageColPescd et
gaMumber et
FoupAtibutes 247
goupMerbershpSAM  ant
gopType &0
rio ant
instancaType Oxd
Btk
Eoe oK Cancel I
a |
[

For further information, see the Setting the zenon authorization levels in the description field of an
Active Directory group (on page 120) section.

5.2.5 Problem handling

CHECK THE CONNECTION TO THE AD LDS DIRECTORY

1. Start the Microsoft ADExplorer on the computer on which the zenon Editor or zenon Runtime is
used.

2. Attempt to establish a connection to the AD LDS directory with the settings used in zenon.
3. The causes of the error can be:

» Incorrect host name

» Incorrect port

»  Firewall rules in the network

USER CANNOT LOG IN

Check to see if all attributes are set correctly in AD LDS:
»  sAMAccountName
»  groupMembershipSAM

P userAccountControl
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THE USER DOES NOT RECEIVE ALL AUTHORIZATION LEVELS THAT WERE
ASSIGNED TO THEM.

Please check:
» Is the Name of the zenonUser Group configured the same that in AD LDS?
» Isthe AD LDS user assigned to the corresponding AD LDS group?
» s the attribute sAMAccountName set in the AD LDS group?

NO CONTENT IN THE SNAP-IN

If no content is displayed after opening the Active Directory schema snap-ins, the access rights must be
amended. To do this:

1. Select Permissions... in the context menu

& Consclel - [Console RootActive Di hema [WIL:389]]
i File Action \View Favorites Window Help
o200 = BED

| 7 Console Root Mame

P e

e DAL 3002

Change Active Directary Domain Controller... here are no items to show in this view.
Connect to Schema Operations Master
Operaticns Mastes...

Permissions—.

Reload the Schema

View
MNew Windew from Here

Mew Taskpad View...

Refresh
Export List...

Help

2. Assign the necessary users the corresponding rights
(you add new users by clicking on Add)

| . Permissions for Schema ==
Securty
Group or Liser names
L itberticated Uoes |

Permissions for Authenticated
Users

Ao
Ful control £
Read i
Wite s
Creste ol chid objects £l
Dielete all chid objects i

For spocial permissions or advanced setngs. | advanced |
chck Advanced. L J

ok J (e ]
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3. Click on the Advanced button

Sebect Users or Groups =R ==
Select this object type

Users, Groups, or Buitin secuty prncipsls [ Qbrect Types... |
From this location

VWIT3E9 Locators_ |

Enter the object names to select (gxampies)
I

| Gevanced. | K \Cu'\od'

4. Click on the Advanced button
5. Open the Permissions tab

6. Activate the Apply to this object and all descendant objects option for the respective user

Advanced Security Settings for Schema
Pemmissions | Audting | Owner | Efective Pemissions

To view o adit detads for & permission enlry, select the entry and then click Edt

Permission Entry for Schema

Pesmission &
Tipe Object | Properties

Mow r .
Mow

FEEE

Apcly ti: | Thes cblect and ol descendant cbjects

Permissions: Allrwi Deny

Full control

List contents

Read al properties
\tirite all propertes
Delete

o [ € € =

7. Close the console and open it again (mmc /a) for further configuration

5.3 Active Directory Application Mode - ADAM (Windows XP
only)

Active Directory Application Mode (ADAM) is designed for use with Windows XP. Windows XP is no
longer supported by zenon, because Microsoft has discontinued the product and no longer supports it.
This documentation only relates to systems that still run under Windows XP.

For current operating systems, use Active Directory Lightweight Directory Services (on page 132):
Windows 7

Windows 8/8.1

Windows Server 2008

v v v WV

Windows Server 2012

REQUIREMENTS

In order to be able to use Active Directory Application Mode for zenon, you must pay attention to the
following points when configuring ADAM.

1. Create anew ADAM instance (on page 194)
2. Bringinan AD schema (on page 196)
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5.3.1

In order to make access possible for the ADAM user, click Program -> Administration ->
Local security guidelines. In the following dialog click Security settings -> Account
guidelines. Define the desired settings for password guidelines and account blocking
guidelines.

Configure the ADAM Snap-in (on page 197) schema.

In the snap-in, right-click under Classes -> Organization and select Properties. On tab Attribute
enter maxPxdAge as optional attribute. You thus ensure that the password validation and the
password change work in the same way as for the Active Directory.

Note: You must enter the validity period of the password in nanoseconds.
Create user and user groups in ADAM. Pay attention to the following:

» Atthe user and at the user group you must enter the name again manually under Property
-> Attribute-Editor at the Attribute sAMAccountName.

» At the user group you must enter the name as described in Using the Active Directory (on
page 119).

»  You can create the zenon authorization levels as described in Using the Active Directory
(on page 119) under attributedescription.

¥ Information

In order to display the username with the help of the system driver variable, you
must set the username manually in ADAM at the user under Properties ->
Attribute-Editor at the Attribute displayName.

Create new instance of ADAM

This is how you install an instance of ADAM using the Active Directory Application Mode setup assistant:

Click on start to launch the Active Directory Application Mode setup assistant, select All
programs and then on ADAM, and then click on Create ADAM instance.

On the welcome page, click on Next.

On the set up options page, you can choose if you wish to install a separate ADAM instance or
would like to assign an existing configuration to a new instance. Because you are installing the
first - ADAM instance, click on A unique instance Click on Next.

On the Instance name page, enter a name for the ADAM instance to be installed. The name is
used to clearly identify the ADAM instance on the local computer. Then click on Next.

On the Ports page, enter the communication ports that are to be used by the ADAM instance.
ADAM can communicate with the help of LDAP (Lightweight Directory Access-Protokoll) or SSL
(Secure Sockets Layer). You must therefore give a value for both ports. Then click on Next.
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10.

1.

Note: If one of the standard ports is already used on the computer on which you install ADAM,
the Active Directory Application Setup Assistant automatically looks for the next available port,
starting with 50000. For example, ports 389 and 636, as well as ports 3268 and 3269 are used
on global catalog servers. Therefore, when installing ADAM on a domain controller, the default
values sooo0 for the LDAP port and see01 are assigned to the SSL port.

On the Application directory partition page, you can create an application partition or a name
context) by clicking on Yes, create application directory partition. If, you click on No, do not
create application directory partition you must create an application partition manually after
installation. If you create an application partition, you must enter a defined name for the new
partition. Then click on Next.

Note: ADAM supports defined names in X.500 and in DNS style (Domain Name System) for
upper level directory partitions.

On the File path page, you can display and amend the installation folder for ADAM files and
recovery files (protocol files). ADAM files and recovery files are saved under
%ProgramFiles(x86)%\Microsoft ADAM\Instance name\data by default. In doing 5O, instance name
displays the ADAM instance name that you enter on the instance name Page. Click on Next, to
import the standard paths.

Note: When installing ADAM on a Windows XP XP, you must install these files on the same
logical volume. When installing ADAM under Windows Serve 2003 and Windows

Server 2003 R2 in a production environment, it is recommended that you install the files on
separate physical data carriers.

Program files and administration programs are installed by ADAM in %windir%\ADAM.

On the Select service account page, select an account that is used as a service account for
ADAM. The selected account determines the security context in which the ADAM instance is
executed. If you do not install ADAM on a domain controller, the network service account of
Active Directory Application Mode Setup Assistant is used by default. Click on Next, to import
the Network service account standard setting. When installing ADAM on a domain controller,
click on This account instead and then select a domain user account as an ADAM service
account.

Note: You can change the ADAM service account after installing ADAM with the command
line program dsmgmt. When installing ADAM on a domain controller, you must select a
domain user account as an ADAM service account.

On the ADAM administrators page, select a user or a group as a standard administrator for the
ADAM instance. The selected user or selected group has full administrator functionality for the
ADAM instance. As standard, the current registered user is given by the Active Directory
Application Mode Setup Assistant. You can change this selection in each local account or
domain account or in each group in the network. Click on Current registered user and then click
on Next.

You can import two LDF files with user class object definitions into the ADAM scheme on the
import LOIF fle PAGE. IMporting user class object definitions is optional.
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12.

13.

14.

a) Clickon Import selected LDIF file for this ADAM instance-

b) Click 0N msinetorgrerson..or @and then on Add.

¢) Click on ms-user.or and then on Add.

d) Click on ms-userproxy..or,0N Add and then on Next.

On the geady for installation P2ge, You can verify the selected installation options. If you click on Next,
the Active Directory Application Mode Setup Assistant starts by copying the files and installing
ADAM on the computer.

If the Active Directory Application Setup Assistant has successfully finished installing ADAM, the
following message is shown: "The Active Directory Application Setup Assistant mode was
concluded successfully." If the Finish assistant page is displayed, click on Finish to close the
assistant.

Note: If the Active Directory Application Setup Assistant is not successfully concluded, the
reason for the error is displayed on the summary page.

If an error occurs in the Active Directory Application Assistant, before the Summary is opened,
you can verify the error message displayed. Furthermore, you can click on Start and then on
Execute and enter one of the following file names:

%windir%\Debug\Adamsetup.log

%windir%\Debug\Adamsetup_loader.log

The files %windir%\Debug\Adamsetup.log and %windir%\Debug\Adamsetup_loader.log contain
useful information about dealing with problems in the event of ADAM setup errors.

5.3.2 Input AD scheme

This is how you use the Active Directory/ADAM synchronization program for the first time

4

4
4
4

click on Start,

Open All Programs,

Click on ADAM and

then on ADAM administration programs:

A command window in the ADAM directory opens.

To extend the ADAM schema to the standard schema objects of Windows Server in Active Directory:

»

Enter the following command on one line of the command prompt:

Idifde -i -s localhost -c CN=Configuration,DC=X #ConfigurationNamingContext -f
MS-AdamSchemaW2k8.Idf

Press the Return key.
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5.3.3 Configure ADAM scheme snap-in

CONFIGURING THE ADAM SCHEME SNAP-IN ADMINISTRATION PROGRAM.

You can administer the ADAM scheme with another ADAM administration program, the ADAM scheme
snap-in. If you have already used the Active Directory scheme snap-in, you should be familiar with the
ADAM scheme. Before you can use the ADAM scheme snap-in, you must create an MMC file for it, as
described in this process.

» Click on start, then on Execute, enter mmc /a and then click on OK.
» Inthe file menu, click on Add/remove snap-in and then click on Add.

» Click on the independent snap-ins available in the ADAM scheme, on Add, on Close and then
click on OK.

P To save this console, click on Save in the File menu.

»  Enter the following filename and then click on Save:
%owindir%\system32\adamschmmgmt.msc

» Create a connection to the ADAM instance using the ADAM scheme snap-in. To do this, right
click on ADAM scheme in the console structure and click on change ADAM server. Enter
localhost at ADAM server and 389 at Port.

» Click on OK. The ADAM scheme snap-in now looks as follows. You can search through and
display the classes and attributes of the ADAM scheme.

» To create a link for the ADAM scheme snap-in start menu, carry out the following actions:

» Right click on Start, click on Open — all users, double-click on the folder programs, and
double-click on the ADAM folder.

P  Move to New in the file menu, and then click on link.

» Inthe assistant to create links, enter adamschmmgmt.msc as the save location for the
element and then click on Next.

»  On the select program description page, enter the name for the link and the name of the
ADAM scheme, and then click on Finish.

6 Administering Active Directory users from zenon
Runtime

You can access the Windows Active Directory in the Runtime with an Active Directory user administration
screen. You can create, delete and edit organization units, users and user groups and assign them rights
in zenon.
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¥ |nformation

Active Directory and AD LDS, as well as ADAM (for Windows XP), are not
available under Windows CE.

DOMAIN IN THE RUNTIME

In the Runtime, the domain of the user who started Runtime for the Active Directory login is used. Only
the users who belong to this domain can log in.

USER AUTHORIZATION

A Attention

Rights that are issued in zenon are applicable for the respective project or the
workspace. Permissions that are issued in the Active Directory are applicable
globally.

If rights have been issued to users or user groups of the Active Directory, then
the rights for these users are applicable in all zenon projects!

DISPLAY OF DELETED USERS

AD users who are deleted during ongoing operation can no longer be displayed in lists with their
complete user names. If a user is not found in either the zenon user list or in the AD, the following
applies:
» From now on, Runtime no longer attempts to read the complete user name of the domain
controller. Another read only takes place if the cache is deleted. This happens is a user log on
or Runtime is restarted.

» The user identification is shown in the AML, CEL and report viewer lists for these entries in the
Complete User Name column.

Recommendation: Do not delete any AD user in the Runtime, simply deactivate the user.

6.1 Creating an Active Directory user administration screen

ENGINEERING

Two procedures are available to create a screen:
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» The use of the screen creation dialog

» The creation of a screen using the properties

Steps to create the screen using the properties if the screen creation dialog has been deactivated in the
menu bar under Tools, Settings and Use assistant:

1. Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

2. Change the properties of the screen:
a) Name the screen in the Name property.
b) Select Active Directory user administration in the Screen type property.
C) Select the desired frame in the Frame property.
3. Configure the content of the screen:
a) Select the Elements (screen type) menu item from the menu bar.

b) Select Insert template in the drop-down list.
The dialog to select pre-defined layouts is opened. Certain control elements are inserted
into the screen at predefined positions.

C) Remove elements that are not required from the screen.

d) If necessary, select additional elements in the Elements drop-down list. Place these at the
desired position in the screen.

4. Create a screen switch function.
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ACTIVE DIRECTORY USER ADMINISTRATION SCREEN

Domain name Active Directory window
Typ: STATIC

Domain name 1D: 53509

Tvo: EDIT

User name

User name
Tvo: EDIT

Password
Password
Tvp: EDIT

sating an organization u aating an organization u Objekt edit...
ST TS [ CesmgUser ' Deeteoect
Delete argantzalional unil. [ Creamguseroow. |

CONTROL ELEMENTS

Insert template Opens the dialog for selecting a template for the screen
type.

Templates are shipped together with zenon and can also
be created by the user.

Templates add pre-defined control elements to
pre-defined position in the screen. Elements that are not
necessary can also be removed individually once they
have been created. Additional elements are selected from
the drop-down list and placed in the zenon screen.
Elements can be moved on the screen and arranged
individually.

ACTIVE DIRECTORY WINDOW

Control elements for the display and administration of the Active Directory.
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Contains the Active Directory detail view: Window in which the structure of the Active Directory is
displayed.

Active Directory Explorer

Create new organization unit (tree) Opens the dialog to create a new organization unit in the
tree.

Edit organisation unit

Delete organization unit... (Tree) Deletes the organization unit selected in the tree after
requesting confirmation.

One level up Navigates to one level higher in the structure.

Create new organization unit Creates a new organization unit below the element
selected in the tree. The corresponding dialog is opened:

Create new user Opens the dialog to create a new user.
Create new user group Opens the dialog to create a new user group.
Edit object Opens the dialog to edit the selected object.
Delete object Deletes the selected object.

LOGIN

Control elements for logging into the Active Directory.

Domain name Entry and display of the domain name.

Note: Element of the type Dynamic text. Functionality is
assigned using the Screen type specific action property.

User name Entry and display of the AD user name.

Note: Element of the type Dynamic text. Functionality is
assigned using the Screen type specific action property.

Password Entry of the password.

Note: Element of the type Dynamic text. Functionality is
assigned using the Screen type specific action property.

Login Clicking logs the user into the AD.
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Logout Clicking logs the user out.

COMPATIBLE ELEMENTS

Control elements that are replaced or removed by newer versions and continue to be available for
compatibility reasons. These elements are not taken into account with automatic insertion of templates.

Domain name Static Win32 control element. Was replaced by a dynamic
text field. For the description, see current element.

User name Static Win32 control element. Was replaced by a dynamic
text field. For the description, see current element.

Password Static Win32 control element. Was replaced by a dynamic
text field. For the description, see current element.

6.2 Screen switching to Active Directory user administration

To use the Active Directory user administration screen in the Runtime, configure screen switching. In
doing so, you can set pre-settings for the organization units to be displayed. This is how you can control
the organization units that respective users can select.

Configuring screen switching:
1. Create a screen switch to an Active Directory user administration screen function.

2. lIssue a domain name, in order to open the AD of a certain domain in the Runtime.
You can also leave the name empty. Then the domain name must be entered in the Runtime
when logging in.

3. Configure the organization units to be displayed.
You can have them all displayed, or select specific ones.

4. Close the dialog by clicking on OK and link the function with a button in the screen.
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FILTER DIALOG

Filter...
Active Directory source
Domain name
o) Cancel
Organization units Help

@Al
() spedific

Domain name Entry of the domain for which the Active Directory is to be
loaded when screen switching.

Organization units Selection of the organization units to be displayed. Selection
by means of radio buttons:

» All: All nodes of the AD structure organization of the
domains are displayed in the Runtime.

» Specific: Allows the selection of certain organization
units. Clicking on the ... button in the input field opens
the dialog to select the organization units.

OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.
Help Opens online help.

SELECT ORGANIZATION UNITS

If you select specific organization units in the filter dialog, the dialog to enter the login files is opened
first, then the dialog to select the organization units.
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LOGIN

Active Directory login

(®) User currently logged in

() Explicit login
Domain
User identification
Password
Cancel
User currently logged in Active: The user who is currently logged into the computer is
logged in to the AD to select the organization units.
Explicit login Active: A certain user who is logged in to the AD to select the
organization units.
» Domain: Entry of the domains whose structure is to
be displayed.
» Username: User. Can remain empty if reading of the
data only is sufficient.
» Password:
OK Applies settings and opens the Select organization units
dialog.
Cancel Discards all changes and closes the dialog.
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ORGANIZATION UNITS

Select organization unit

: -{2) Computers_Added
Microsoft Exchange Security Groups
=) Domain Controllers

Cancel
List of organization units Display of all organization units of the selected domain.

Selection from the folder tree.
OK Applies settings and closes the dialog.

Cancel Discards all changes and closes the dialog.

6.3 Administer Active Directory users in the Runtime.

Organization units, user groups and users of the active directory can be administered from zenon
Runtime with an Active Directory user administration screen.

A Attention

Rights that are issued in zenon are applicable for the respective project or the
workspace. Permissions that are issued in the Active Directory are applicable
globally.

If rights have been issued to users or user groups of the Active Directory, then
the rights for these users are applicable in all zenon projects!
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ACTIVE DIRECTORY USER ADMINISTRATION SCREEN

The screen is empty, when the screen switch function is executed.

To administer users in the AD:

1. Enter the domain name (can already be defined in the screen switching), user name and
password

2. Click on Login

3. The connection is created.
If errors (on page 191) occur, check the configuration in the Active Directory (on page 133) and
in zenon.

4. The domain data is read and displayed in the window.
5. Edit the desired elements. Available actions:
» Creating and deleting organization units (on page 210)
» Creating, editing and deleting users (on page 211)
» Creating, editing and deleting  user groups (on page 219)
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Note: The user who is logged on must have the corresponding rights in the domain.

Domain name 0

User identification 9

Password
| Login | | Logout
Active Directory structure Mame # | Type -
4 WDS_Computers
—' SD R CSLocationAdmini...  User group
—' C|sa et J:.ddsd CsPersistentChat.. | User group
—' rll_ompu;:;—'h € . CSResponseGrou...  User group
—' E)mros.o z xct a|r|1ge ecu CSResponseGrou...  User group
s"ql' omain Lontroflers CSServerAdministr..  User group
a8 .AII users CSUserAdministra...  User group
""" Al usergroups CSViewOnlyAdmin...  User group
CSVoiceAdministr..  User group
D User
Denied RODC Pas... User group
DHCP Administrat..  User group
DHCF Users User group
Disabled Objects Organizational unit
Distributed COM U...  User group
DnsAdmins User group
DnsUpdateProxy User group
Domain Admins User group
Domain Computers  User group
< » || Domain Controllers | User group A
| Create new organization unit... | | Move up |
| Edit organiZation| ot | | Create new organization unit... |
| Defete node; | | New user... |
| Mew group... |
| Objekt edit... |
| Delete object.. |

ACTIVE DIRECTORY WINDOW
Control elements for the display and administration of the Active Directory.

Contains the Active Directory detail view: Window in which the structure of the Active Directory is
displayed.

Active Directory Explorer

Create new organization unit (tree) ~ Opens the dialog to create a new organization unit in the
tree.

Edit organisation unit

Delete organization unit... (Tree) Deletes the organization unit selected in the tree after
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requesting confirmation.
One level up Navigates to one level higher in the structure.

Create new organization unit Creates a new organization unit below the element
selected in the tree. The corresponding dialog is opened:

Create new user Opens the dialog to create a new user.
Create new user group Opens the dialog to create a new user group.
Edit object Opens the dialog to edit the selected object.
Delete object Deletes the selected object.

LOGIN

Control elements for logging into the Active Directory.

Domain name Entry and display of the domain name.

Note: Element of the type Dynamic text. Functionality is
assigned using the Screen type specific action property.

User name Entry and display of the AD user name.

Note: Element of the type Dynamic text. Functionality is
assigned using the Screen type specific action property.

Password Entry of the password.

Note: Element of the type Dynamic text. Functionality is
assigned using the Screen type specific action property.

Login Clicking logs the user into the AD.

Logout Clicking logs the user out.

COMPATIBLE ELEMENTS

Control elements that are replaced or removed by newer versions and continue to be available for
compatibility reasons. These elements are not taken into account with automatic insertion of templates.

Domain name Static Win32 control element. Was replaced by a dynamic
text field. For the description, see current element.
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User name Static Win32 control element. Was replaced by a dynamic
text field. For the description, see current element.

Password Static Win32 control element. Was replaced by a dynamic
text field. For the description, see current element.

TREE CONTEXT MENU

Depending on the element selected, the context menu in the tree (left window) provides the following

commands:

Create new organization unit

Create new user

TOOLBAR AND CONTEXT MENU

Creates a new organization unit below the element
selected in the tree. The corresponding dialog is
opened:

Deletes the organization unit selected in the tree after
requesting confirmation.

DETAIL VIEW

Depending on the element selected, the context menu and the toolbar in the detail view (right window)

provide the following commands:

2 |58 @A

One level up

Create new organization unit

Create new user
Create new user group
Edit selected object

Delete selected object

Navigates to one level higher in the structure.

Creates a new organization unit below the element
selected in the tree. The corresponding dialog is
opened:

Opens the dialog to create a new user.
Opens the dialog to create a new user group.
Opens the dialog to edit the selected object.

Deletes the selected object.
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6.3.1 Manage organization unit

You can create and delete AD organization units in the tree and in the detail view.

CREATING AN ORGANIZATION UNIT

To create a new organization unit:

1. Click in the screen on the button or select  Create new organization unit in the context menu
of a highlighted element.

2. The dialog to configure an organization unit is opened

Mew organizational unit “

Name

| | | Cancel

Properties of the organizational unit

3. Giveitaname.
Maximum length: 64 characters

4. Click on OK.

EDIT ORGANISATION UNIT
The name of the organization unit can be changed.

Attention: When changing the name, links to users and user groups that are used in the Message
Control module are destroyed.
To edit an organization unit in the tree:

1. Select the desired organization unit and click on the corresponding button or command in the
context menu. In the detail view, click on the Edit object or the Edit selected object command in
the context menu.

2. The dialog editing is opened.
3. Edit the object.
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4. If you click on the OK button, you are asked how linking should be handled:

zenon Energy Edition “

Caution!

This operation can destroy the Runtime linking of subordinate users
and groups in the context of the 'Message Control' module!

- Select 'Yes' to attempt to restore the references (this will take some
time).

- Select ‘Mo’ to carry out the changes withour restoring the links
(quicker).

Yes Mo Cancel

5. Select the desired option:

»  Yes: The renaming is carried out.
An attempt is made to restore linking to users and user groups that are used in the
Message Control module.
This process can take some time.

» No: The change is made immediately.
Attention: Linking to users and user groups that are used in the Message Control module
can be destroyed!

» Cancel: The renaming is not applied and the dialog is closed.

DELETE ORGANIZATION UNIT

To delete an organization unit in the tree, select the desired organization unit and click on the
corresponding button or command in the context menu. In the detail view, click on the Delete object
button or the Delete selected object command in the context menu.

Note: An organization unit can only be deleted if it no longer contains any objects.

6.3.2 Managing users
New users can be created and existing users can be edited and deleted. Users with the same visual
name in the list can be distinguished by the information in the tool tip.

» Create new user: Click on the corresponding button, or the command in the toolbar or the
context menu.

»  Edit user: Double-click a user entry or click on the corresponding button or on the Edit selected
object command in the context menu.

» Delete user: Highlight the desired user and press the Del key, click on the corresponding button
or on the Delete selected object command in the context menu.

When creating and editing, a dialog is opened, in which you can configure the user.
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DIALOG TO CREATE OR EDIT AN USER

The dialog consists of three tabs. You ca
the Editor (0n page 8)/Creation of a user

USER PROPERTIES

n also find notes on the options in the Project configuration in
(on page 11) chapter.

New user [ x |
User properties | Groups of the user | Runtime settings
User Password
User identification | Set password Cancel

Password

Complete name

Password confirmation

E-mail
Telephone

G5M

Actions
Deactivate user

Unblock user

USER

Parameter

User

User name
Complete name
Email

Telephone

User must change password on next login

Passwort does not expire

Settings for user data.

Unique name of the user for the login.
Displayed name of the user.

E-mail address of the user

Number of the voice-compatible telephone device of the
user. Used for text to speech.

Enter numbers. In addition, the following are permitted:

» The prefix + as an abbreviation for 00 of the
international area code is permitted.

The following separators are also permitted in AD user
administration: Minus (-), slash (/) and space
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Note: When communicating between AD and Message
Control, separators are ignored as soon as the data from
the AD is mapped to a zenon object.

GSM Cellphone number of the user. Used for messages via
GSM and SMS (text messages).

Enter numbers. In addition, the following are permitted:

» The prefix + as an abbreviation for 00 of the
international area code is permitted.

The following separators are also permitted in AD user
administration: Minus (-), slash (/) and space

Note: When communicating between AD and Message
Control, separators are ignored as soon as the data from
the AD is mapped to a zenon object.

PASSWORD

Password Settings for the password.

Set password Active: The password is set again.

Password Enter new password. Input is automatically hidden.
For projects with multiple languages, note that it must be
possible to enter the characters with the respective
keyboard in the Runtime.

Password confirmation Repeat the password. Input is automatically hidden.

User must change password on Active: The user must, as soon as they log in to the

next login system, change their password.

Password does not expire Active: Password never needs to be changed
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A Attention

Note when changing passwords for AD users:

The requirements of zenon for a minimum and maximum length of password
take priority.

Example of minimum length: AD requires a minimum length of 4
characters. In zenon, a minimum length of 8 characters has been configured
using the Minimum password length property. If a password with fewer than 8
characters is entered, this leads to an error message. The password can be valid
for AD, but is rejected by zenon.

Note on maximum length: Different maximum password lengths are
permitted in zenon Runtime:

P Local user: maximum of 20 characters

P AD user: maximum of 255 characters

If the AD password is longer than 20 characters, an AD can use it to sign into
zenon. The password can also be changed in zenon however.

ACTIONS
Actions Configuration of actions for the account.
Deactivate user Active: The user is deactivated and can no longer log in.
Unblock user Active: The blocked user is unblocked and can log in in
the Runtime again.
OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.

USER GROUPS OF THE USER
1. Select, in the Existing user groups window, the desired user groups from the existing ones.

2. Add the selected groups to the list of selected user groups with the arrow key ->.
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3. You can also select user groups that have already been allocated and remove them again with
the arrow key <-.

User properties | Groups of the user | Runtime settings

Existing user groups

MNew user

Selected user groups

Name

WS5_Admins
WINS Users

Users

UM Management
Trados User

SP-TS Members
SP-Training Members

SP-5ales Members
SP-PM Members
£

Windows Authorization ...
View-Only Organization ...

UserGroup {1f38ae86-al...

Terminal Server License ...
Support Permissions Gr...
SQLServer20055QLBrow...
SQLServer20055QLBrow...
SOLAccessGroup {1f38a...

SP-Service Alliance Me...

Account name

WS5_Admins
WINS Users

Windows Authorization .

View-Only Organization .

Users

UserGroup {1f38ae86-a1.,

UM Management
Trados User

Terminal Server License .
Support Permissions Gr..,
SOLServer200550LBrow..
SOLServer200550LBrow..
50LAccessGroup {1f38a..

SP-TS Members
SP-Training Members
SP-Service Alliance Me...
SP-5ales Members
SP-PM Members

Name

Account name

Existing user groups List of configured user groups.

Selected user groups List of the user groups selected for the user.

Arrow keys Clicking moves the highlighted groups to the
corresponding list.

OK Applies all changes in all tabs and closes the
dialog.

Cancel Discards all changes in all tabs and closes the

dialog.
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RUNTIME SETTINGS

User properties | Groups of the user | Runtime settings
General
[ Administrator
Login profile
Do not load profile

Lock code for command

GENERAL

New user
Message Control

["]Message Control user Cancel

PIN code NA code

Substitute person

General

Administrator

Login profile

General settings.

Active: The user takes on the role of a zenon
administrator. Only an administrator can unblock
zenon user accounts that have been blocked.

Note: If a user is stipulated as an administrator,
then this role is also applicable for all zenon
projects!

Selection of the Runtime profile that is used for
login from a drop-down list:

» None
» Default
» Last
Lock code for Command Processing Four-digit PIN code.

This code is used by the user in the command
processing to block areas or to unlock them.
Only available if zenon Energy Edition has been
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licensed.

MESSAGE CONTROL

Message Control Settings for Message Control.

Message Control user Active: The user is used by the module Message
Control.

PIN code PIN code with which the user confirms the receipt

of the message.
The code consists of a four-digit number between
0000 and 9999.

NA code PIN code with which the user rejects the receipt of
the message (not available). The message is then
sent to the next user in the list.

If there is no other user entered in the list, the
message is entered as "not successfully
acknowledged". The function assigned to this is
executed. In addition, a "rejected by" CEL entry is
created in each case.

The code consists of a four-digit number between
0000 and 9999.

Note: You can find further information on the
assignment of functions in the Confirmation of
receipt - confirmation of receipt settings chapter.

SUBSTITUTE PERSON

Substitute person If a user has not been reached or they do not
accept the message, a substitute person can be
given. Click the ... button and the dialog (on page
25) opens to select an user. Only users who have
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been activated as Message Control users are
offered for selection.

OK Applies all changes in all tabs and closes the
dialog.

Cancel Discards all changes in all tabs and closes the
dialog.

SUBSTITUTE PERSON DIALOG

If a substitute person is to be selected for the Message Control module, a click on the button opens a
dialog with previously-configured users.

User selection

Mame Type ~

P User

k User

B User

F. User

R User

G User

D User

L User

C User

u User

¥ User

G User

C User

R User

3 Llser o

Mone selected OK,
Parameter Description
List of persons List of users available.
No selection A user who is already defined in the dialog is deleted.
OK Applies settings and closes the dialog.
Cancel Discards all changes and closes the dialog.

Select the desired user and click on OK.

To remove a substitute person who has already been configured, click on None and then on OK.
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6.3.3 Managing user groups

New user groups can be created and existing user groups can be edited and deleted.

» Creating a new user group: Click on the corresponding button, or the command in the toolbar
or the context menu.

» Editing user groups: Double-click an user group entry or click on the corresponding button or
on the Edit selected object command in the context menu.

» Deleting user groups: Highlight the desired user group and press the Del key, click on the
corresponding button or on the Delete selected object command in the context menu.

When creating and editing, a dialog is opened, in which you can configure the user.

DIALOG FOR CREATING AND MODIFYING USER GROUPS

The dialog consists of three tabs. You can also find notes on configuration in the Project configuration in
the Editor (on page 8)/Creation of a user (on page 20) chapter.

PROPERTIES OF THE USER GROUP

New user group

Properties of the user group | Users in this user group | Runtime settings

| Cancel

MName

Name Entry of a unique, valid name for the database backup.

OK Applies all changes in all tabs and closes the dialog.
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Cancel Discards all changes in all tabs and closes the dialog.

USERS IN THIS USER GROUP
1. Select, in the Existing users window, the desired users from the existing users.
2. Add the selected users with the arrow key -> to the list of selected users.

3. You can also select users who have already been allocated and remove them again with the

arrow key <-.
New user group
Properties of the user group | Users in this user group | Runtime settings
_OK
Existing users Selected users
Name Account name 2 Name Account name wr=
W

£ > £ >
Parameter Description
List of existing users List of configured users.
List of selected users List of the users selected for this group.
Arrow keys Clicking on an arrow key moves the selected user to the

corresponding group.

oK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.
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RUNTIME SETTINGS

ol
&) Vicoshqfiéf dokui Dobu_PictureBase\T115P0\ Germent\screan AD-L 0 = ¢ cdsbigifdaku Dok Pic
Neig Benutzengruppe “
Exgarehalton i B bwrge | Beruitnr i v Barutrigrugpa Aurine Enstebungen :
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Hessage Control
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GENERAL
Parameter Description
General General settings. Configuration of the authorization
levels.
List of existing authorization levels List of the authorization levels configured in zenon.
List of selected authorization levels List of authorization levels that are allocated to this
group.
Arrow keys Clicking on an arrow key moves the authorization
levels to the corresponding group.
MESSAGE CONTROL
Parameter Description
Message Control Configuration for zenon Message Control.
Group call active Active: All members of the user group are
messaged when messaging via Message Control.
Sequence of messaging List of all available users. Sequencing is carried out
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using the arrow keys.

OK Applies all changes in all tabs and closes the
dialog.

Cancel Discards all changes in all tabs and closes the
dialog.

7 about AD/AD LDS properties used in zenon

ENCRYPTION

NTLM/Kerberos encryption is used to log in a zenon AD/ADAM user. No explicit encryption is envisaged
for ADSI (MS APIs for AD) for the exchange of data other than passwords in the session that is already
logged on.

LIST OF THE PROPERTIES IN AD/ AD LDS USED BY ZENON

DOMAIN

General form Remark

defaultNamingContext

distinguishedName From containers.
name From containers.
objectClass From containers.
maxPwdAge

lockoutDuration

USER GROUP

General form Remark

distinguishedName

name

222 | 224



General form

sAMAccountName
member
description

groupMembershipSAM

groupType

objectClass

USERS

General form

distinguishedName
sAMAccountName
displayName
memberOf

mail
telephoneNumber
Mobile

pwdLastSet
userAccountControl

groupMembershipSAM

userPrincipalName
objectClass
objectCategory

ZenOnUserlLevell

ZenOnUserLevel2

Possible amendment of the value necessary in AD/AD LDS.

Is set when editing in zenon in the Active Directory user
administration screen.

Possible amendment of the value necessary in AD/AD LDS.

Is set when editing in zenon in the Active Directory user
administration screen.

Possible amendment of the value necessary in AD/AD LDS.

Not a default property of AD/AD LDS. Is not normally
needed. Only present for compatibility reasons.

Not a default property of AD/AD LDS. Is not normally
needed. Only present for compatibility reasons.
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General form Remark

ZenOnUserLevel3 Not a default property of AD/AD LDS. Is not normally
needed. Only present for compatibility reasons.
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